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Preface

iNotes Web Access is a next-generation Web client that allows you to use many of the 
messaging and collaboration features of Domino through a Web browser. You can work with 
mail, calendar, to do lists, or a journal-like notebook from any client with Web browser access 
– without requiring a Lotus Notes client. You also have the option to work offline, without a 
permanent connection to the Domino server, or to work online seamlessly.

iNotes Web Access on the IBM ~ iSeries server is not a platform-specific 
implementation. At the time when this IBM Redbook was written, only the redbook iNotes 
Web Access Deployment and Administration, SG24-6518, which is based on general platform 
information, was available. This IBM Redbook extends the topics written in that redbook from 
an iSeries server platform perspective. It also includes other general iNotes Web Access 
topics such as single sign-on, using LDAP for authentication, and URL redirection. 

You can download the redbook, iNotes Web Access Deployment and Administration, 
SG24-6518, from the IBM Redbooks Web site (http://www.redbooks.ibm.com). You should 
also refer to the Lotus white paper, iNotes Web Access Deployment Guide 5.0.9, which is 
available for download from the Web site (http://notes.net). We strongly recommend that 
you use these materials, along with this redbook, for a complete guideline on how to deploy 
and implement iNotes Web Access on the iSeries server.

The team that wrote this redbook
This redbook was produced by a team of specialists from around the world working at the 
International Technical Support Organization (ITSO), Rochester Center.

Deb Landon is an IT Specialist in the ITSO, Rochester Center, focusing 
on Domino for iSeries. Before joining the ITSO in November of 2000, she 
was a member of the PartnerWorld for Developers, iSeries team 
supporting business partners in the area of Domino for iSeries. She was a 
member of the original team who created the highly successful Domino 
Days event that has since been replicated many times worldwide.

Linda Defreyne is a Principal Lotus Certified Lotus Professional (CLP) in 
Administration and Development and a Certified Lotus Instructor in 
Brugge, Belgium. She works as a free-lance instructor and consultant. 
She has 13 years of experience on the AS/400 and iSeries server and five 
years with Lotus Domino. Linda holds a degree in educational sciences 
from the University of Leuven in Belgium. She has been teaching classes 
for IBM and other companies since 1986, starting with System/36 and 
System/38. She also provides customer support on the iSeries server and 
on Lotus Domino and specializes in Domino for iSeries. 
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Notice
This publication is intended to help the Domino administrator to deploy iNotes Web Access on 
the iSeries server. It is assumed that you have a good knowledge of using Lotus Notes and 
administrating Domino servers and some knowledge of using the IBM iSeries server. 

Comments welcome
Your comments are important to us!

We want our Redbooks to be as helpful as possible. Send us your comments about this or 
other Redbooks in one of the following ways:

� Use the online Contact us review redbook form found at:

ibm.com/redbooks

� Send your comments in an Internet note to:

redbook@us.ibm.com

� Mail your comments to the address on page ii.
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Chapter 1. Overview

This chapter provides an overview of the Lotus client strategy, as well as what iNotes Web 
Access is and how it fits into this strategy. It also discusses the features of iNotes Web 
Access and the concept of working offline.

This chapter covers the following topics:

� What is iNotes
� iNotes Web Access
� Lotus Domino clients available
� Basic features and functions of iNotes Web Access

1
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1.1  What is iNotes
To explain what iNotes is, we have to position the iNotes client in the Lotus client strategy. 
The Lotus client strategy consists of:

� Lotus Notes 

An integrated, collaborative client environment that provides users with quicker access to, 
and better management of, many types of information. This may include Domino and 
Internet-based e-mail, a calendar of appointments, personal contacts and to dos, as well 
as Web pages, discussions, collaboration, and intranet applications.

� Mobile Notes via the Mobile Services for Domino server 

Provides secure anytime, anywhere interactive access to Notes mail, calendar, and 
corporate directory from Web-enabled devices, including cell phones, pagers, and 
personal digital assistants (PDAs). Plus, Mobile Notes also takes advantage of Mobile 
Services for Domino push technology for paging and short messaging services.

� iNotes 

Delivers powerful Domino messaging, collaboration, and e-business capabilities to Web 
browser, POP3, IMAP, and Outlook 98/2000 clients.

Regardless of what client you use for messaging, the underlying technology is the same – a 
Lotus Notes/Domino database.

iNotes is the name for a family of products that provides Domino messaging, collaboration, 
and e-business capabilities to Web browser and Microsoft Outlook users. The iNotes family 
consists of three products:

� iNotes Web Access
� iNotes Access for Microsoft Outlook
� Lotus iNotes Sync Manager

1.2  iNotes Web Access
iNotes Web Access is a Web client that allows users to access different Domino services 
using a Web browser. iNotes Web Access provides the Web browser user the majority of 
features that were previously only available for users with non-Web browser clients, such as 
Lotus Notes. These features are in the areas of messaging, calendar and scheduling, task 
management, and personal journal. Users can also work offline to manage e-mail messages, 
contacts, calendars, to-do items, and so forth from the user interface that iNotes Web Access 
provides.

iNotes Web Access can be used independently or together with the Lotus Notes client. Users 
can use the Lotus Notes client while they are in their office environment. Or they can use 
iNotes Web Access while they are remote, with the possibility to use only a Web browser, 
such as in an Internet Cafe, another user’s PC, or the user’s home PC. When using both 
clients in different situations, users still use the same mail file and the information is always 
up-to-date.

For administrators, iNotes Web Access provides a simple client that is easy and cost-effective 
to manage and deploy. This is all from within the same Domino infrastructure that they 
already manage. The thin-client and server-based deployment model, as well as no training 
requirements, allow companies to get users up and running quickly.
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You might have a Domino installation in your organization, and your users have been using 
Notes clients to access Domino services for a while. So, what’s the big difference with iNotes 
Web Access compared to earlier releases of the Domino server? 

Starting with Domino Release 5.0.8, iNotes Web Access is shipped with the Domino server. 
iNotes Web Access uses mostly files that reside on a Domino server. In addition to a Web 
browser, only a few things have to be installed on the user’s workstation and only when users 
need to access their mail files offline. In case some other files are needed locally, they are 
also loaded from the Domino server. The files that are related to iNotes Web Access on the 
Domino server include:

� iNotes5.ntf: The actual template used to create or upgrade mail files for users

� forms5.nsf: Contains most of the elements used to build the iNotes Web Access user 
interface

1.3  Lotus Domino clients available
There is a wide range of clients available to access services provided by a Domino server. 
This section briefly explains the following clients and provides suggestions of when you might 
use each of these clients:

� Lotus Notes
� iNotes Web Access
� iNotes Access for Outlook
� Domino WebMail
� POP3 and IMAP

The selection of the client is based more on the requirements of your particular environment, 
rather than the specific features of a certain client.

1.3.1  Lotus Notes
Lotus Notes is an integrated e-mail and e-business software for the Internet and corporate 
intranets. Notes integrates information sources, including e-mail, calendaring, group 
scheduling, to-do list, and more. Notes users can exchange messages via the Internet, work 
with any Web application, read and post topics to Internet news groups, search Web 
directories, and use X.509 certificates for security. Notes users have access to their e-mail 
and other applications while they are offline, giving them the option to synchronize their work 
later.

Integration with the Lotus Domino R5 server makes Lotus Notes R5 available as an 
e-business client, with high functionality, security, and customization options. There are 
built-in collaborative applications, like discussions and document libraries, as well as 
third-party Domino-based e-business solutions. A sample of the Lotus Notes client is shown 
in Figure 1-1.
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Figure 1-1   Lotus Notes client

When to use the Lotus Notes client
Your users may need more than just a mail client, for example, to integrate mail, calendar, 
address book, and to-do list, into workflow, Web, and e-business applications. The client to 
use in such case is the Lotus Notes client.

1.3.2  iNotes Web Access
iNotes Web Access combines Domino messaging, collaboration, and e-business capabilities 
and provides them for users using Web browsers. iNotes provides centralized management 
and deployment and a no-touch installation to the user’s desktop. It delivers messaging, 
calendaring, and collaboration functions to Web browsers through an easy to use user 
interface, both online and offline. An example of the iNotes Web Access client is shown in 
Figure 1-2.

Note: It is important to understand that today, iNotes Web Access only supports the Win32 
Internet Explorer Web browser 5.01 Service Pack 1 or above. Netscape Navigator is not 
supported at this time.
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Figure 1-2   iNotes Web Access client

When to use the iNotes Web Access client
You may want to choose iNotes Web Access for your client in situations where you are 
upgrading from a traditional mail system to a Web browser-based mail or when you are 
installing your first mail system.

Consider using iNotes Web Access if your users don’t have a designated workstation or if 
your users have to connect their mail files from computers with only a Web browser installed 
or from outside your organization’s network.

iNotes Web Access is a wise choice also for organizations using Lotus Notes mail. It does not 
have to be the exclusive decision between Lotus Notes or iNotes Web Access, because you 
can use both iNotes Web Access and Lotus Notes to access your mail file in different 
situations.

If your organization has Domino WebMail users, you may want to provide them better 
functionality by upgrading to iNotes Web Access.

1.3.3  iNotes Access for Microsoft Outlook
iNotes Access for Microsoft Outlook brings reliable, scalable Domino messaging to Microsoft 
Outlook 98/2000 users.

The Microsoft Outlook user experience is unchanged with iNotes Access for Microsoft 
Outlook; users simply work with their mail, calendar, and task data on Domino instead of 
Microsoft Exchange. Familiar Microsoft Outlook features are supported, including rich text, 
folders, and integration with Microsoft Office applications.
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iNotes Access for Microsoft Outlook also gives Microsoft Outlook users the additional benefits 
of Domino messaging features that are not available with Exchange. This includes full 
text-search capabilities for their mailbox, superior mobile capabilities, and native support for 
Internet standards (SMTP/MIME and HTML). Figure 1-3 shows an example of Microsoft 
Outlook running iNotes Access for Microsoft Outlook.

Figure 1-3   Microsoft Outlook client running iNotes Access for Microsoft Outlook

For additional information on iNotes Access for Microsoft Outlook, please refer to Exchange 
Migration and iNotes Implementation on the IBM ~ iSeries server, SG24-6230.

When to use the iNotes Access for Microsoft Outlook client
You may want to improve the reliability and scalability of an existing messaging infrastructure 
and add e-collaboration, by upgrading from Microsoft Exchange to Domino, without changing 
clients. In this case, iNotes Access for Microsoft Outlook is the correct choice for the client.

1.3.4  Domino WebMail
Domino WebMail gives users the ability to access the Notes mail file from a Web browser, 
with basic functionality and user experience. For the current version of iNotes Web Access, 
Web Mail is the interface that Netscape browser users will see when opening their mail file. 
Figure 1-4 shows an example of the Domino WebMail client.
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Figure 1-4   Domino WebMail client

When to use Domino WebMail
Domino WebMail is still a valid option for users who use such platforms as UNIX, Linux, or 
OS/2. You can also use it if your organization is using another Web browser other than 
Internet Explorer, such as Netscape Navigator.

1.3.5  POP3/IMAP
The Lotus Domino server provides access for POP3 and IMAP clients such as Outlook 
Express, Netscape Messenger (Figure 1-5), and Eudora.
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Figure 1-5   POP3 client

When to use a POP3/IMAP client
Some organizations have already deployed users with standard mail clients. Regardless of 
what the current underlying technology is for their mail server, this can be replaced by a 
Domino server, without further changes on the user side. This avoids retraining the user 
because they are already using a familiar interface.

1.4  Basic features and functions of iNotes Web Access
This section describes some of the basic features and functionality that iNotes Web Access 
provides.

To access a Domino mail database from the Internet Explorer Web browser, you access the 
URL to the mail database, in either of the following forms:

http://server.domain.com/mail/user.nsf 
http://server.domain.com/mail/user.nsf?OpenDatabase

Using this URL automatically redirects the Netscape user to the WebMail interface or opens 
the iNotes Web Access interface to the Internet Explorer user.

Tip: For additional details of basic iNotes Web Access features and functions, please refer 
to iNotes Web Access Deployment and Administration, SG24-6518.
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1.4.1  Mail
You can create anew message from virtually anywhere in the iNotes Web Access interface. 
Clicking the New button creates a new message when you are in the Inbox, Folder, Sent, or 
Drafts views. If you are elsewhere in iNotes Web Access, such as the Calendar, To-Do, or 
Notebook views, clicking New -> Message also creates a new mail message (Figure 1-6).

Figure 1-6   Drop-down menu in iNotes Web Access to create a new document

This brings up the New Message window where you fill out, as with any other mail client, the 
TO:, cc:, bcc:, and Subject: fields (Figure 1-7).

Figure 1-7   iNotes Web Access new message window

You also have a body field, where you have limited use of rich text functionality including: 
three different fonts, tabs, bold, italic, bullets, numbering, headline format, as well as different 
colors.

Spell-checking is also available. To select the language, click the last icon on the right (looks 
like a book icon), and the window shown in Figure 1-8 appears.
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Figure 1-8   Choosing a dictionary for spell-checking

All the spelling dictionaries installed on the Domino server are available for use by the iNotes 
Web Access user, with no additional configuration required.

You can also attach as many files to the message as you want.

e-mail notification
If e-mail is enabled on the Domino server’s configuration document, you will receive a pop-up 
window that notifies you when new mail has arrived.

1.4.2  Calendar
There are eight different views in the calendar, as listed in Figure 1-9.

Figure 1-9   iNotes Web Access calendar views

There are five different types of calendar entries:

� Meeting: A meeting creates an entry in the originator’s calendar, with a predefined start 
and end. Like a mail message, a meeting is sent to the people designated in the To:, cc:, 
and bcc: fields, and if accepted, is added to their respective calendars.

� Appointment: An appointment is an entry with predefined start and end times, as well as 
a date.

� All Day Event: An all-day event has only a predefined date with no start or end times, 
marking the entire time on that day as busy.

� Anniversary: An anniversary is like an all-day event, without booking the entire day as 
busy.

� Reminder: A reminder is an entry in the calendar at a very specific time; it does not have 
a duration.
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Alarms
For any of these calendar entries, you can specify an alarm. When an alarm is activated, a 
pop-up window (Figure 1-10) appears to notify the user.

Figure 1-10   Calendar alarm notification

Alarms can be enabled or disabled globally by the administrator in the Domino server 
configuration document.

1.4.3  To Do list
With iNotes Web Access, you can also manage personal pending tasks, similar to what is 
done in the Lotus Notes client. However, Lotus iNotes Web Access differs on two aspects. 
First, there is no support for group to dos, and second, it adds a Gantt chart view to the 
traditional list view (Figure 1-11).

Figure 1-11   iNotes Web Access To Do list: Gantt chart view

When you create a new to do item, you can add an alarm to alert you in advance of the due 
date, as well as set a repeat interval for periodical tasks.

1.4.4  Contacts
When working with iNotes Web Access, you can work with a contact list containing both 
individual and group entries. While the contact information is stored in a separate file 
(names.nsf) for Notes client users, all contact and group information is stored on the same file 
as the mail and calendar information for iNotes Web Access users.
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If a user accesses their mail file both from the iNotes Web Access client and from the Lotus 
Notes client, the iNotes template provides a way to synchronize the contacts between the 
personal address book in the Notes client and the contact list in iNotes Web Access 
(Figure 1-12).

Figure 1-12   Synchronizing contacts in personal address book with contact list in iNotes Web Access

1.4.5  Notebook
iNotes Web Access also provides a section to register all-purpose information, such as notes 
or a file repository. The notebook section provides the ability to create simple documents with 
a formatted text body and file attachments.

Like the contacts section, if the user uses both the Lotus Notes client and the iNotes Web 
Access client, the notebook section can also be synchronized with the journal.nsf file on the 
Notes client (Figure 1-13).

Figure 1-13   iNotes Web Access notebook

To synchronize the notebook with the journal file on the Lotus Notes client, from the Notes 
workstation, open the mail file, and select the pull-down menu options Actions-> iNotes Web 
Access-> Synchronize Journal.

1.4.6  Sametime enabled chat
iNotes Web Access provides integration with Sametime offering a chat client that can be 
launched from the iNotes Web Access user interface allowing you to start chat sessions with 
one or more users. To use this function, you click the Chat icon from the upper right corner of 
the iNotes Web Access client. Figure 1-14 shows an example of the chat client available in 
iNotes Web Access.
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Figure 1-14   iNotes Web Access chat client

This chat client does not have the same capabilities as the Sametime connect client for Web 
browsers. Basically this chat client only allows chat sessions and not application sharing or 
audio/video sessions.

1.4.7  Working offline
iNotes Web access adds the ability to work offline using the same familiar Web browser 
interface, while at the same time providing the features of replication.

To work offline with iNotes Web Access, you need the Lotus iNotes Sync Manager (that can 
be downloaded from the Domino server). Then create a subscription to your mail database. 
This subscription is the local replica of the mail file that will be used when working offline 
(Figure 1-15).

Note: To use the chat client in iNotes Web Access, Sametime must be already configured 
and running. Also, the Sametime server name must be in each Person document.
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Figure 1-15   Installing an offline subscription

The first time the offline function is used, the offline subscription is installed along with the 
Lotus iNotes Sync Manager software. Depending on how the Domino Off-Line Security 
(DOLS) document has been configured, you may be prompted for your Notes ID password. 
The ID will be retrieved from the Domino Directory, or a new one will be created 
automatically.

Once installed, the Lotus iNotes Sync Manager application synchronizes the subscription 
periodically with almost the same functionality as the Replicator page of the Lotus Notes 
client (Figure 1-16).

Figure 1-16   iNotes Sync Manager

Note: You can find more details on setting up DOLS and offline support for iNotes Web 
Access users in Chapter 2, “Setup and deployment” on page 17.
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Synchronization settings
You can set options as to how the subscription is going to be synchronized (Figure 1-17).

Figure 1-17   Lotus iNotes Sync Manager subscription properties

Some of the synchronization options you can set include:

� Subscription size: You can limit the subscription size to a maximum. We do not 
recommend setting the limit under 5 MB, because the template itself is 5 MB.

� Automatically download any new optional sections on server: If this option is 
enabled, any new optional section that is made available on the server is added to the 
local subscription.

� Send pending emails before shutdown: If enabled, any e-mails that are still created 
locally, but still not synchronized, are sent to the server.

� Synchronize new or modified documents before shutdown: If enabled, this option 
runs synchronization before shutting down the Lotus iNotes Sync Manager.

� Notify when synchronization is completed: When enabled, a pop-up window appears 
when the synchronization process is complete.

How it all works together
Figure 1-18 and the following series of steps explain the offline synchronization process and 
how it differs from accessing the database online when working with the iNotes Web Access 
client:

1. The mail file must have the iNotes5.ntf template.

2. This template enables the user to access the iNotes Web Access client interface using the 
Web browser.

3. When the user chooses to go offline, they download the Lotus iNotes Sync Manager, and 
a subscription is created. A subscription is actually a replica copy of the mail database. 
When updating the subscription (replicating), the Lotus iNotes Sync Manager behave like 
a Notes client, using the Notes Remote Procedure Call (NRPC) protocol to access the 
database on the Domino server.
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4. When working offline, the user is using the Web browser to access the local mail file (a 
Domino database).

Figure 1-18   Working online and offline with iNotes Web Access

Note: For the Domino server, there is no difference between users that synchronize 
using the Lotus iNotes Sync Manager and those that replicate using the Lotus Notes 
client.

Note: When the user accesses the local subscription using a Web browser, an 
instance of a Domino server is run locally with only the HTTP task running. This 
instance of a Domino server uses port 89 to locally listen to the HTTP requests from the 
Web browser. 
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Chapter 2.  Setup and deployment

This chapter contains the hardware and software requirements for the end-user workstations 
and the Domino servers deploying iNotes Web Access on the iSeries server. It also covers 
how to prepare and setup iNotes Web Access on the iSeries server.

This chapter discusses the following topics:

� End-user workstation requirements
� Administrator workstation requirements
� iSeries server requirements
� Setting up iNotes Web Access on the Domino server
� Deploying and setting up clients
� Other considerations when deploying in certain environments
� National language support
� Performance and sizing considerations

2

Note: Throughout this redbook, we assume that you have basic skills on Domino and 
iSeries administration.
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2.1  End-user workstation requirements
The following sections describe the hardware and software requirements for the end-user 
workstation.

2.1.1  Hardware requirements
Workstation requirements depend on several factors such as the operating system and 
characteristics of how each user utilizes the client. Most users not only use mail and calendar 
on their workstation, but they also use office applications or other productivity applications.

Based on the Lotus iNotes Web Access R5.0.9 white paper (http://notes.net), the general 
recommended hardware configuration for the enduser workstation is:

� 500 MHz processor

� 256 MB main memory

� (Optional for offline usage only) 200 MB of disk space for offline usage; 75 MB for program 
code; the rest of the space for user’s mail and full-text index. If the user has a larger mail 
file, more disk space is required.

2.1.2  Software requirements
The iNotes Web Access end-user workstation requires the following software:

� Windows 32-bit operating system: Windows 95, Windows 98, Windows NT 4.0, or 
Windows 2000

� Internet Explorer 5.01 with Service Pack 1 or Internet Explorer 5.5

� (optional) Adobe Acrobat Reader Version 4.0 or above is required for calendar previewing 
and printing

� (optional) Other applications, such as office products, are required for opening documents 
directly from attached files.

Note: There are several sources from Lotus and IBM that discuss the minimum client 
requirements, and there are some discrepancies. From customer feedback and from our 
test environment, generally the Pentium II 400 MHz with 128 MB memory is enough to 
achieve a reasonable response time and performance.

Note: Even though Internet Explorer (IE) 6 may work with iNotes Web Access, if you 
upgrade from IE5.01 or IE5.5 or if you install the optional feature of Microsoft virtual 
machine, it is not officially supported by Lotus in the initial releases of iNotes Web Access. 
Windows XP also comes with Internet Explorer 6, so it also is not officially supported by 
Lotus.

Accessing iNotes Web Access using other Web browsers, such as Netscape 4.x, Internet 
Explorer on Mac and UNIX platforms, Smartphone, and PDAs, are not supported by the 
current releases of Domino R5.0.8 and later R5.0.x.
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2.2  Administrator workstation requirements
There is no special iNotes administrator client. The administrator uses the Lotus Domino 
Administrator client to setup and manage iNotes Web Access. They may also install the 
software for the end user on the workstation to test the functionality before deploying to them. 
Therefore, the administrator can use an existing Domino R5 Administrator workstation to set 
up and manage both iNotes Web Access and Lotus Notes users.

2.2.1  Additional software requirements for administration
iNotes Web Access administration requires the following software in addition to the software 
requirements listed in 2.1.2, “Software requirements” on page 18:

� Lotus Domino Administrator client R5.0.8 or later (the client version should match the 
Domino server version)

� IBM Client Access Express for Windows, Operations Navigator with the Domino plug-in for 
installed

2.3  iSeries server requirements
The iSeries server requires the following hardware and software to be installed.

2.3.1  Hardware requirements
Following is the minimum iSeries server hardware requirements:

� iSeries server, such as Model 270, 820, 830, 840, or IBM AS/400e with PowerPC (RISC) 
processor; traditional server or Domino Dedicated Server (DSD) model

� Minimum 256 MB of memory, 512 MB or more recommended

� Minimum 750 MB disk space, 1 GB or more recommended

For more accurate information about processor requirements, number of disk arms 
recommended, etc., refer to 2.8, “Performance and sizing considerations” on page 58.

2.3.2  Software requirements
The minimum iSeries server software requirements include:

� OS/400 V4R5 or higher (also depends on your iSeries server model)
� TCP/IP Connectivity Utilities for AS/400
� Lotus Domino Server for iSeries R5.0.8 or later

� (optional) OS/400 Option 12, Host Servers: For easier management of Domino and 
iSeries server in a graphical user interface using Operations Navigator

Note: Although Domino will run on any RISC-based iSeries or AS/400 server with the 
supported operating system and have the available capacity to support, there are 
price/performance and response time advantages in using the newest iSeries models.

Important: The incremental installer from pre-R5.0.8 does not include iNotes Web 
Access. You must install or upgrade from Domino 5.0.8 full installation media. See 
2.6.1, “Upgrading from a pre-R5.0.8 Domino server” on page 52.
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� (optional) Client Access Express for Windows: For easier management of Domino and the 
iSeries server in a graphical user interface using Operations Navigator

� Prerequisite PTFs for the specific OS/400 version:

– V4R5

• Make sure the latest cumulative PTF package is installed.
• For Domino R5.0.9, at least cumulative PTF C0294450 and the group PTFs listed in 

Table 2-1, if using other Domino functions, are required.

Table 2-1   Additional OS/400 V4R5 PTFs required if using other Domino functions

– V5R1

• In addition to the latest V5R1 cumulative PTF package, you need the additional 
PTFs listed in Table 2-2.

Table 2-2   Additional PTFs required for OS/400 V5R1

• Additional PTFs are required for other Domino functions listed in Table 2-3.

Table 2-3   Additional V5R1 PTFs required if using other Domino functions

� Additional PTFs as specified in Lotus Domino Server release notes

More up-to-date information about prerequisite PTFs is listed on the Domino for iSeries 
home page at: http://www.ibm.com/servers/eserver/iseries/domino/support

� From a license perspective, you also need iNotes Client Access License (CAL) or a Notes 
client license

Additional group PTFs Other Domino functions

Latest DB2 group PTF SF99105 Moving data between Domino and DB2 UDB for 
iSeries

Latest Java group PTF SF99068 All Java related features, such as Sametime 
integration

Latest BRMS group PTF SF99077 Using Backup Recovery and Media Service for 
iSeries, for example, use BRMS for online 
Domino backup

Product
ID

PTF 
number

Description Available on 
cumulative PTF 
package

5722-999 MF27185 LIC - COMM SOCKETS DOMINO SERVER NOT 
RESPONDING
Err EWOULDBLOCK is received by the application 
after ADDLEISVR command.

N/A

5722-SS1 SI02083 Cumulative fixes to QYPPRT370 *SRVPGM, 
including: C2M1212 message after C++ exception.

N/A

Additional PTFs Other Domino functions

Client Access Service Pack2 SI01907 (comes 
with the latest cumulative PTF)

EZ Setup and Client Access Express for 
Windows

Latest BRMS group PTF SF99078 Using Backup Recovery and Media Service for 
iSeries, for example, use BRMS for online 
Domino backup and incremental Domino 
database backup
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2.4  Setting up iNotes Web Access on the Domino server
iNotes Web Access comes standard as a part of the Lotus Domino Server R5.0.8 or later. You 
do not need to install it separately. The following list gives an overview of the steps required to 
set up iNotes Web Access:

1. Enable HTTP and Domino Off-Line Services (DOLS).

2. Update the Domino server document for HTTP and DOLS configurations.

3. Register new users or upgrade existing users’ mail databases using the iNotes Web 
Access mail template.

4. If you plan to provide offline access to the users, you need to configure Domino Off-line 
Services for offline support and for synchronizing between offline databases on the local 
workstation and online databases on the Domino server.

5. Set up the iNotes Web Access Domino server configuration document to specify other 
functions for the end users.

Some customers will use a newly dedicated Domino partitioned server for their iNotes Web 
Access clients, while other customers will deploy iNotes Web Access clients on their existing 
Domino servers. For information on sizing a new iSeries server or an existing server, see 2.8, 
“Performance and sizing considerations” on page 58.

2.4.1  Enabling HTTP and Domino Off-Line Services
To configure a new Domino server or change an existing Domino server on the iSeries server 
to support iNotes Web Access, you may use one of the following methods:

� From Operations Navigator or Web-based configuration
� From a 5250 emulation screen using an OS/400 CL command

For more details about configuring a new Domino server, please refer to Lotus Domino for 
AS/400 R5: Implementation, SG24-5592.

Configuring a new Domino server for iNotes Web Access
To configure a new Domino server to support iNotes Web Access, you have to enable an 
HTTP service on the Domino server. If you plan to deploy offline support for the end users, 
you also need to enable Domino Off-Line Services.

Configuring a new Domino server using a graphical user interface
Perform the following steps to configure a new Domino server using Operations Navigator:

1. From Operations Navigator, expand your iSeries server on the left pane under Network -> 
Servers.

2. Right-click Domino and select New Domino Server (Figure 2-1). A Web-based server 
configuration window appears that allows you to configure a new Domino server.

Note: You need to have the Domino plug-in for Operations Navigator installed in order to 
use Operations Navigator to manage Domino servers. Please refer to Lotus Domino for 
AS/400 R5: Implementation, SG24-5592, for information on how to install the Domino 
plug-in for Operations Navigator.
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Figure 2-1   Configuring a new Domino server using Operations Navigator

3. Enable HTTP and DOLS as shown in Figure 2-2.

Figure 2-2   Enabling HTTP service and DOLS using a Web-based configuration

Configuring a new Domino server using the CFGDOMSVR CL command
Perform the following steps to configure a new Domino server using the OS/400 Configure 
Domino Server (CFGDOMSVR) CL command.

1. From a 5250 session, type the CFGDOMSVR command and press F4 for prompting. Specify 
*HTTP in the Web browser field (Figure 2-3).

(ASM06)

ASM06
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Figure 2-3   Enabling the HTTP service using the CFGDOMSVR command

2. Press F10 for additional parameters. Then page down to the bottom of the page, and 
change the Allow Domino Off Line Services field to *YES (Figure 2-4).

Figure 2-4   Enabling DOLS using CFGDOMSVR command

Changing an existing Domino server to support iNotes Web Access
For an existing Domino server, you must change the Domino server configuration to enable 
HTTP service and DOLS by either using Operations Navigator or the Change Domino Server 
(CHGDOMSVR) CL command.

Changing an existing Domino server using a graphical user interface
Perform the following steps to change an existing Domino server using Operations Navigator:

1. From Operations Navigator, expand your iSeries server on the left pane under Network -> 
Servers-> Domino.

2. Right-click the Domino server to be used for iNotes Web Access, and select Properties. 
The properties display appears as shown in Figure 2-5. 

Configure Domino Server (CFGDOMSVR)                      
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Administrator:                                                                 
   Last name  . . . . . . . . . . > Admin                                       
   First name . . . . . . . . . . > iNotes 
   Middle initial . . . . . . . .                 Name, *GEN                    
   Password . . . . . . . . . . .                                               
   Minimum password length  . . .   8             0-31                          
   Internet password  . . . . . .   *NONE                                       
 Time zone  . . . . . . . . . . . > CST           GMT,EST,CST,MST,PST,CET ...   
 Daylight savings time  . . . . .   *YES          *YES, *NO                     
 Web browsers . . . . . . . . . . > *HTTP         Name, *NONE, *ALL, *HTTP...   
                                                                                
 Internet mail packages . . . . .   *NONE         *NONE,*ALL,*IMAP,*POP3 ...    
                + for more values                                               
 SMTP services  . . . . . . . . .   *DOMINO       *DOMINO, *MSF                 
                                                                                
                                                                        More... 
 F3=Exit   F4=Prompt   F5=Refresh   F10=Additional parameters   F12=Cancel      
 F13=How to use this display        F24=More keys 

Configure Domino Server (CFGDOMSVR)                      
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Allow Domino Off Line Services   > *YES          *YES, *NO                     
                                                                                
                                                                                
F24=More keys 
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Figure 2-5   Changing the existing Domino server properties

3. Click the Internet tab, and enable Web browser access. We selected the Hypertext 
Transfer protocol (HTTP) option in our example. Then click the Services tab and select 
Domino Off-Line Services (Figure 2-6).

Figure 2-6   Enabling HTTP service and DOLS using Operations Navigator

Changing an existing Domino server using CHGDOMSVR
Perform the following steps to change an existing Domino server using the OS/400 Change 
Domino Server (CHGDOMSVR) CL command:

1. From a 5250 session, type the CHGDOMSVR command and press F4 for prompting. Change 
the Web Browsers field to *HTTP (Figure 2-7).

ASM06

(ASM06)

ASM06

ASM06

ASM06
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Figure 2-7   Enabling the HTTP service using the CHGDOMSVR command

2. Press F10 for additional parameters. Then page down to the bottom of the page and 
change the Allow Domino Off Line Services field to *YES (Figure 2-8).

Figure 2-8   Enabling DOLS using the CHGDOMSVR command

2.4.2  Domino server configuration
Configuring the Domino server on iSeries to enable iNotes Web Access is similar to doing the 
same task on other platforms. For more information, please refer to Chapter 3, “Deployment”, 
in iNotes Web Access Deployment and Administration, SG24-6518, for more information.

This section describes the configuration requirements on the Domino server. 

Verifying the Domino Off-Line Services setting
You must perform this step if you plan to provide offline access to your end users.

Since DOLS is tied to the Domino HTTP server task as a Domino server HTTP API extension, 
there is no separate DOLS task in the Domino server. For example, you cannot issue a load 
DOLS command to start DOLS or execute a show tasks command from the Domino server 
console to see if DOLS is running. It will be loaded or ended with the Domino HTTP task.

 Change Domino Server (CHGDOMSVR)                        
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Server name  . . . . . . . . . . > INOTES01                                    

                                                                                
 Additional server ID:                                                          
   ID file's password . . . . . .   *NONE                                       
 Time zone  . . . . . . . . . . .   CST           *SAME, GMT, EST, CST, MST ... 
 Daylight savings time  . . . . .   *YES          *SAME, *YES, *NO              
 Web browsers . . . . . . . . . .   *HTTP         Name, *SAME, *NONE, *ALL...   
                                                                                
 Internet mail packages . . . . .   *NONE         *SAME,*NONE,*ALL,*IMAP ...    
                + for more values                                               
 SMTP services  . . . . . . . . .   *SAME         *SAME, *DOMINO, *MSF          
 Directory services . . . . . . .   *NONE         *SAME, *NONE, *ALL, *LDAP...  
                                                                                
 News readers . . . . . . . . . .   *NONE         *SAME, *NONE, *NNTP           
                                                                        More... 
 F3=Exit   F4=Prompt   F5=Refresh   F10=Additional parameters   F12=Cancel      
 F13=How to use this display        F24=More keys 

 Change Domino Server (CHGDOMSVR)                        
                                                                                
 Type choices, press Enter.                                                     
                                                                                
                                                                                
                            Additional Parameters                               
                                                                                
 Start when TCP/IP started  . . .   *NO           *SAME, *YES, *NO              
 Allow Domino Off Line Services     *YES          *SAME, *YES, *NO 
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On the iSeries server, using the CFGDOMSVR DOLS(*YES) or CHGDOMSVR DOLS(*YES) 
CL commands when creating or changing a Domino server configures DOLS automatically. 
There are two checks to verify that DOLS is configured and running on the Domino server:

1. Verify the Domino server document has been updated with the DSAPI filter of 
LIBDOLEXTN.SRVPGM (Figure 2-9).

Figure 2-9   DOLS DSAPI filter in the Domino server document

2. Check the messages on the Domino server console when the HTTP server task starts to 
make sure the DOLS extension is loaded (Figure 2-10).

Note: The DOLS DSAPI filter must be listed first. If there are other DSAPI filters already 
being used, such as WebSphere Application server, they must be listed after the DOLS 
DSAPI filter. 

By default, the CHGDOMSVR appends the filter to the end of the list. If other filters are 
already loaded, you must manually move LIBDOLEXTN.SRVPGM to be the first one. 
Otherwise, DOLS will not load properly.
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Figure 2-10   DOLS HTTP extension loaded message

Configuring the Domino HTTP server 
iNotes Web Access clients use the HTTP Internet protocol versus the Notes Remote 
Procedure Call (NRPC) used by the Lotus Notes client. You can either use the OS/400 HTTP 
server (original version) or the Domino HTTP server to serve the iNotes Web Access clients. 
This section explains how to configure the Domino HTTP server to serve iNotes Web Access 
clients. 

Enabling an HTTP service, as well as SSL for iNotes Web Access, is similar to enabling 
HTTP for other Domino Web-based mail and applications. You can use the Domino 
Administrator client and go to the Configuration tab to configure the Domino server document 
of iNotes Web Access server. For more information on SSL, refer to Chapter 3, “Security” on 
page 75.

For basic configuration of iNotes Web Access, you must consider the following fields in the 
Domino server document in Domino Directory:

� Fully qualified Internet host name: Specify the fully qualified Internet host name of the 
Domino server instead of the Internet short name or Domino server name. The iSeries 
server must be able to resolve this host name to its TCP/IP address as well (Figure 2-11).

                           Display Domino Console                               
                                                                                
 Previous subcommands and messages:                                             
   11/20/2001 11:28:41 PM  Agent Manager started                                
   11/20/2001 11:28:42 PM  AMgr: Executive '2' started                          
   11/20/2001 11:28:42 PM  AMgr: Executive '1' started                          
   11/20/2001 11:28:46 PM  inotesml01/Inotes is the Administration Server of    
   the Domino Directory.                                                        
   11/20/2001 11:28:46 PM  Administration Process started                       
   11/20/2001 11:28:51 PM  Schedule Manager started                             
   11/20/2001 11:28:52 PM  SchedMgr: Validating Schedule Database               
   11/20/2001 11:28:53 PM  SchedMgr: Done validating Schedule Database          
   11/20/2001 11:28:56 PM  Calendar Connector started                           
   11/20/2001 11:29:02 PM  Event Monitor started                                
   11/20/2001 11:29:08 PM  JVM: Java Virtual Machine initialized.               
   11/20/2001 11:29:08 PM  Java Servlet Manager initialized                     
                                                                                
   11/20/2001 11:29:08 PM  Domino Off-Line Services HTTP extension (iNotes Relea
   se 1.05) loaded.                                                             
   11/20/2001 11:29:09 PM  HTTP Web Server started                              
                                                                                
 F3=Exit   F5=Refresh   F6=Print                                                
 F17=Top   F18=Bottom   F21=Command line                                        
                                                                                

Attention: If you plan to use the offline support (Domino Off-Line Services) for your iNotes 
Web Access users, you must use the Domino HTTP server. DOLS is only supported by the 
Domino HTTP server. The OS/400 HTTP server does not support DOLS.
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Figure 2-11   Specifying the fully qualified Internet host name

� HTTP port number: If you have multiple HTTP servers sharing the same IP address on 
the iSeries server, you must specify a different port number for each of the HTTP servers. 
Also make sure that you enable the TCP/IP port for HTTP here (Figure 2-12).

Figure 2-12   Specifying the TCP/IP port number for HTTP or SSL

� Bind to hostname: It is very likely for the iSeries server to have multiple Domino 
partitioned servers running on the same system. If you run multiple Domino servers or 
enable the OS/400 HTTP server, make sure that you bind each Domino server to its own 
IP address (Figure 2-13).
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Figure 2-13   Specifying Bind to host name as enabled

� Session authentication: In the current releases of the Domino server, R5.0.8 and R5.0.9, 
DOLS does not support multi-server session authentication for domain-wide Web single 
sign-on (Web SSO). If you plan to deploy offline access, you must set session 
authentication to either disable (default value) for basic name-and-password 
authentication or Single Server for session-based name-and-password authentication 
(Figure 2-14).
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Figure 2-14   Specifying session authentication

You can start, stop, and manage the Domino HTTP server by using the Domino server 
console commands. Table 2-4 shows some frequently used Domino server console 
commands including some of the new commands from the newer Domino releases. For 
additional information regarding HTTP settings for the Domino HTTP or Web server, please 
refer to the Domino R5 Administration Help database (help5_admin.nsf).

Table 2-4   Domino R5 server console HTTP commands

Restriction: In the current releases of Domino, R5.0.8 and R5.0.9, DOLS does not 
support multi-server session authentication. You need to plan accordingly if you intend 
to deploy WebSphere and Domino single sign-on or Domino multi-server domain-wide 
authentication.

Domino HTTP console command Description

Load HTTP Manually start the Domino HTTP server task.

Tell HTTP QUIT Manually stop the Domino HTTP server task.
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Assigning Internet passwords for each iNotes Web Access user
To access a mail database, the iNotes Web Access user must first authenticate with the 
Domino server. There are different options available; the most common being basic name 
and password authentication or session-based authentication. These require a Person 
document in the Domino Directory or a secondary directory configured using Directory 
Assistance (DA). Each Person document must contain the user name and Internet password. 
To set the Internet password of a Person document, perform the following steps:

1. From a Lotus Notes client, open the Domino Directory or Domino server address book.

2. Select the People view from the left navigation panel.

3. Locate the Person document that you want to update.

4. Click the Edit Person button. On the Basics tab, verify the value in the Internet password 
field. In order for a user to authenticate from a Web browser, the value cannot be blank 
(Figure 2-15).

5. If the Internet password field is blank, type a password and click Save and Close. You 
may notice that the password is then translated into an encrypted format.

Tell HTTP Restart This command results in the HTTP task shutting 
down, reloading, and refreshing certain Web 
server settings. It is the equivalent to issuing “Tell 
HTTP Quit” followed by “Load HTTP”. However, 
the downtime for the HTTP server is much 
shorter because it does not completely reload all 
HTTP memory. This command deletes the 
in-memory page and user-authentication caches.

Tell HTTP Show Thread State Gathers information about the status of each 
worker thread. 

Tell HTTP Show Users Displays authenticated users. This command can 
be used only if the Domino server is configured to 
use session-based tracking for the Web. This 
command shows the user name, IP address, and 
the time of expiration, which is 30 minutes by 
default. The results display only users who are 
authenticated; anonymous users cannot be 
tracked.

Tell HTTP Show File Access Displays information about file system protection 
on the machine and each virtual server if 
configured.

Tell HTTP Show Security Displays the current status on the use of SSL for 
the server and each virtual server or virtual host. 

Tell HTTP Show Virtual Servers Displays a list of all configured virtual servers or 
virtual hosts running on the server.

Note: Opening a Person document in the read mode does not show the Internet 
password. You must open it in edit mode.

Domino HTTP console command Description
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Figure 2-15   Setting the Internet password field of a Person document

By default, each user will own their mail database file and be granted Manager access, in the 
access control list (ACL) of that database, and Editor access, in the Maximum Internet name 
& password field. This is sufficient for most functions. However, creating a database full-text 
index, enabling Out of Office agent, and changing the Internet password functions require 
Designer access in the Maximum Internet name & password field.

The ACL level required for each of these functions is shown in Table 2-5.

Table 2-5   Access levels to a user’s mail database

Perform the following steps to change the value of the Maximum Internet name & password 
access control:

1. Start the Lotus Notes client and locate your mail database icon.

2. Right-click the mail database icon and select Database-> Access Control.

3. Click the Advanced button on the left navigation panel.

4. Change the value of the Maximum Internet name & password to Designer by making a 
selection from the drop-down list (Figure 2-16).

5. Click OK.

ACL access level Maximum Internet 
name & password

Change Internet 
password available?

Out of Office agent 
available?

Editor Editor No No

Editor Designer No No

Designer Editor Yes No

Designer Designer Yes Yes

Note: The Change Internet Password option is only available for the mail database owner.
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Figure 2-16   Changing the value of Maximum Internet name & password field

2.4.3  Registering new users with the new iNotes mail template
By default, Domino uses the R5 standard mail template Mail (R5.0) or StdR5Mail (mail50.ntf) 
when you register a new user. To register a new user with iNotes Web Access capabilities, 
you must use the iNotes Mail C&S template (iNotes5.ntf) instead.

Perform the following steps to register a new user and create their mail file using the iNotes 
Web Access template:

1. Start the Domino Administrator client, and login using the Domino server’s administrator 
ID.

2. If you have multiple Domino partitioned servers in a Domino domain, make sure that you 
connect to the correct Domino server to be used for iNotes Web Access.

3. Click the People & Groups tab.

4. Select Tools-> People-> Register from the right navigation panel (Figure 2-17).

Figure 2-17   Registering a new person

5. The system then prompts you for the certifier password. Type the password and click OK.

6. In the Register Person -- New entry window, type the user information.
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7. You need to select the Set Internet password check box. iNotes Web Access uses the 
Internet password in online and offline authentication with the Domino server. The 
password specified should be eight characters or longer.

8. Click the Advanced check box.

9. Click the Mail button.

10.Select the Domino iNotes Web Access server as the Mail Server.

11.Select iNotes Mail and C&S (iNotes5.ntf) from the scroll-down Mail file template menu 
(Figure 2-18).

Figure 2-18   Selecting the iNotes Web Access template when registering a new user

12.Complete or verify the other fields as necessary.

13.Click the Add Person button. The new user will be listed in the Registration queue (lower) 
panel.

14.Click the Register button.

Important: We recommend that you set the Internet password with at least eight 
characters in length. If a user changes their password in offline usage and if the 
password is less than eight characters, an invalid password error would always appear. 
This happens even though the user types the password correctly because DOLS 
requires a password with at least eight characters. This is implemented for Internet 
security reasons to make it harder for an intruder to guess the user’s password.
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15.After the Domino server registers the new person and creates a new mail database, a 
pop-up window asking if you want to register another person appears. Click Yes if you 
want to register another person. Otherwise, click No to end the registration process.

Registering a new user with Operations Navigator
The Domino plug-in for the Operations Navigator enables you to register new Domino users 
as well. The registration can be done as a part of creating a new OS/400 user or changing an 
existing OS/400 user. The benefit of using this method is that you can create an OS/400 user 
profile, create their entry in OS/400 Directory Entry, and create a Domino user ID for this user 
all at the same time. However, you cannot specify an Internet Password or iNotes Web 
Access mail template there. If you use Operations Navigator to register a new Domino user, 
you have to set the Internet Password and convert the mail template for that user’s mail 
database later.

Perform the following steps to register a new OS/400 user and a new Domino user:

1. Start Operations Navigator and sign on with a security officer or security administrator 
user ID with an entry in OS/400 Directory Entry.

2. Expand your iSeries server on the left pane to Users and Group. Then right-click and 
select New User (Figure 2-19).

Figure 2-19   Registering a new user using Operations Navigator

Note: Before you register a new Domino user using Operations Navigator, you need to 
have the Domino Administrator client installed and configured with the proper Domino 
server administrator ID available on the workstation.
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3. On the New User window, enter the required information for the OS/400 user and click the 
Networks button (Figure 2-20).

Figure 2-20   Entering the required OS/400 user ID information

4. Select the Domino Registration tab and a pop-up window appears that asks for a 
password for the Domino Administrator ID. Type the password here, and select the 
Domino server to register a new Domino user into. Then click Add.

5. Type the required information for the new Domino user and click OK (Figure 2-21).

Figure 2-21   Entering the required Domino user information

6. A new OS/400 user ID is created and a new user is registered on the Domino server with 
the standard R5 mail template and no Internet password. You will need to add the Internet 
password and replace or convert the mail template design later.
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2.4.4  Migrating existing users’ mail databases
Migrating existing Domino users means replacing the design of the users’ mail databases 
with the new iNotes Web Access template. The iNotes Web Access mail template description 
is iNotes Mail C&S, with a filename of iNotes5.ntf. This mail template is the superset of the 
previous standard R5 mail template and R5 WebMail template, which means the users can 
also access their mail file from a Lotus Notes client or a WebMail client.

When you upgrade existing users’ mail databases to the iNotes5.ntf template, you can 
upgrade one mail database at a time or use the mail conversion utility to automate upgrading 
the design.

We recommend upgrading users’ mail files when they are not accessing them, for example, in 
the early mornings or over a weekend. You may plan a schedule downtime for upgrading 
users’ mail template and notify users that their mail files will be unavailable during the 
upgrade.

Mail template design replace considerations
Check the following considerations before you upgrade users’ database mail template.

A mix of pre-R5.0.9 Notes clients and iNotes Web Access
When deploying iNotes Web Access clients on the Domino R5.0.9 server, Notes clients with 
different R5 releases can access the Domino R5.0.9 server. Both the iNotes Web Access 
client and the Lotus Notes client can use the same mail database with the iNotes5.ntf 
template. 

A mix of pre-R5.0.8 Notes clients and iNotes Web Access clients is supported by the Domino 
R5.0.9 server. The iNotes Web Access template is compatible with earlier releases of the 
Notes client. In an environment that uses the iNotes Web Access template, Notes client users 
will continue to see the standard Notes client user interface. When using the iNotes Web 
Access client, users will see the iNotes Web Access user interface.

Upgrading mail templates from pre-R5.0.8 to iNotes Web Access
If you plan to upgrade a mail database template that is pre-R5.0.8, you need to upgrade the 
database template to the standard R5 mail template (mail50.ntf) of release 5.0.8 or later first. 
You must do this before you upgrade the mail database template design again to the iNotes 
Web Access template (iNotes5.ntf).

Replica of iNotes5.ntf on multiple Domino servers
If you have a mail database on a Domino R5.0.9 server with an iNotes5.ntf template and a 
replica of that mail database on another pre-R5.0.8 Domino server, you must ensure that the 
design of that mail database is set not to replicate. A mail file with an R5.0.9 design on a 
pre-R5.0.8 server does not work properly. You need to ensure that the older pre-R5.0.8 
design does not overwrite the R5.0.9 design on the R5.0.9 server.

To prevent the mail templates of the two replicas from replicating, perform the following steps 
for each mail database:

1. Open the replica mail database.

2. Select File-> Replication-> Settings.

3. Click the Advanced tab.

Important: Upgrading a pre-R5.0.8 R5 mail database to iNotes5.ntf directly may corrupt 
the mail database.
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4. Under “Replicate incoming,” deselect Forms, views, etc. and Agents.

5. Click OK.

Make sure you do this for each replica. This procedure does not work for clustered servers 
and databases; cluster replication ignores selective replication.

Upgrading the mail template
Perform the following steps to upgrade the mail template:

1. If users have customized their mail files, instruct them to back up these customizations. 
For example, users can make a new copy of their mail file that includes only the database 
design. This allows users to reapply changes they made to their Notes R5 mail database 
to the new iNotes Web Access mail template (Figure 2-22).

Figure 2-22   Creating a backup copy of the design mail database

2. Make sure that you have started the Domino server on which you want to upgrade the mail 
database, and go to the Domino server console.

You can access the Domino server console on the iSeries server by using:

– Work with Domino Servers (WRKDOMSVR) CL command, and selecting option 8

– Work with Domino Console (WRKDOMCSL Dominoservername) CL command to access to 
the Domino console of that server directly

– A Web browser or the Domino Administrator client

3. To prevent Domino from routing mail files, and therefore, accessing or making any 
changes to mail databases while they are being upgraded, shut down the router task by 
typing the following command in the Domino server console:

tell router quit

The pending mail is stored in MAIL.BOX while you upgrade the mail databases. Once you 
upgrade the mail databases and load the router task again, the router processes and 
delivers the mail in MAIL.BOX.

4. Load the mail conversion utility. Type:

load convert [arguments]

You may use the mail conversion utility (convert) from the Domino server console or use 
the replace design utility from the Notes client to replace the mail template. However, 
Lotus recommends that you use the mail conversion utility from the Domino server 
console instead of using replace design.

The mail conversion utility command uses arguments to specify options. It has the form:

load convert [-r] mailfilepath existingtemplatename newtemplatefilename
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Here -r converts mail files to subdirectories of the specified directory. Refer to the section 
“Upgrading user’s mail files”, in the Domino documentation Moving to Notes and Domino 
Release 5 for more information.

The following examples show various ways that you can use the mail conversion utility 
from the Domino server console:

– Example 1: Convert only a mail database, user.nsf, from the standard R5 mail 
template to the iNotes Web Access mail template. “StdR50Mail” is the design name of 
standard R5 mail.

load convert mail/user.nsf StdR50Mail iNotes5.ntf

– Example 2: Convert all databases in the mail/testgroup directory with any database 
template to iNotes Web Access mail template:

load convert mail/testgroup/*.nsf * iNotes5.ntf

– Example 3: Convert all databases under the mail directory and all of its sub-directories 
with any database template to the iNotes Web Access mail template. The “-r” switch 
means recursively replace all files in the subdirectories.

load convert -r mail/*.nsf * iNotes5.ntf

See Figure 2-23.

Figure 2-23   Converting a mail database to use the iNotes Web Access template

5. Once you finish upgrading mail databases to the iNotes Web Access template on the 
Domino server, load the router task. Type:

load router

6. Notify users that you upgraded their mail databases to the iNotes Web Access design.

Replacing the design from Lotus Notes client
Replacing the mail database template design can also be done individually from the Lotus 
Notes client. However, it must be done from a Notes client release 5.0.8 or later.

 > load convert mail/nattapong.nsf * iNotes5.ntf 
                                                                                
                                                                                
   11/19/2001 01:08:02 PM  Mail Conversion Utility starting                     
   11/19/2001 01:08:02 PM  Mail Convert: Started replacing design template '*'  
   with 'iNotes5' in 'mail/nattapong.nsf' 
   11/19/2001 01:08:02 PM  Deleting '(openinotesAgent)' from database 'Nattapong

Mongkolprasit'                                                       
                                                                                
   11/19/2001 01:08:02 PM  Mail Convert: Finished replacing design template in  
   'mail/nattapong.nsf' 
   11/19/2001 01:08:03 PM  Mail Conversion Utility shutdown 

Note: The iNotes Web Access mail template, iNotes5.ntf, also supports accessing from 
WebMail and Lotus Notes clients for the same user. Refer to 2.6.6, “Users accessing their 
mail database from different types of clients” on page 53, for details.

Important: Replacing a design using pre-R5.0.8 Notes clients may result in corrupted mail 
databases because they do not set all the necessary database flags.
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2.4.5  Configuring Domino Off-Line Services
You only need Domino Off-Line Services if you plan to provide offline access to users. If you 
plan to deploy only to have online access to iNotes Web Access, you do not need to install or 
setup DOLS on your Domino server. 

Domino Off-Line Services is an extension of the Domino Web (HTTP) server. It provides 
users with mobility to use mail and calendaring, as well as other Domino Web applications 
offline while disconnected from the Internet or intranet. It provides the installation method for 
clients and synchronization between the client and Domino server for disconnected use.

The DOLS administration database (dolsadmin.nsf) allows a Domino administrator to define 
the scope of security by an Organizational Unit – not the domain – and to define a User ID 
deployment policy for client downloads of the Lotus iNotes Sync Manager application. To 
configure DOLS, the Domino Administrator client can be used to configure the DOLS security 
policy document. The DOLS administration database (dolsadmin.nsf) is created as a part of 
the configuration of a new Domino server or when changing an existing DOMINO server with 
the DOLS(*YES) parameter.

Perform the following the steps to configure DOLS:

1. Start your Domino Administrator client, and select the Configuration tab.

2. On the left pane, expand the Offline Services folder and select Security.

3. Click the New Security Policy button as shown in Figure 2-24.

Important: DOLS must be configured before iNotes Web Access client installation for 
offline access.

Note: You will see Offline Services only if you have authority specified in the ACL of the 
dolsadmin.nsf database. You may also perform these functions by opening the 
dolsadmin.nsf database directly from the Domino Administrator client or the Lotus 
Notes client.
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Figure 2-24   Creating a new Offline Security Policy document through the Domino Administrator client

4. On the panel as shown in Figure 2-25, specify the scope of security in the Security domain 
field, and choose one from the options listed in the ID deployment policy field.

Figure 2-25   Offline Security Policy document

Note: The Security domain specified here has nothing to do with Internet domain or 
Domino domain. It refers to the organization unit that this policy will effect. For example, 
you can have a less secure policy such as “Automatically generate user IDs” for 
/extranet/Mycompany, and have another more secure policy such as “Prompt for ID 
during download” for /intranet/Mycompany for a different group of users.
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5. Press Esc and click Yes to save the document.

6. Check for the logging of the Offline database user with the Administrator client. First click 
the Configuration tab and then select Offline Services -> Users from the left navigation 
panel (Figure 2-26). This view contains a log of the synchronization of subscriptions done 
by each user in the past.

Figure 2-26   Offline subscription log users view through Domino Administrator client

2.4.6  Enabling other functions in iNotes Web Access
You may want to enable or disable some functions for iNotes Web Access that are available to 
users to control or manage disk space, security, or performance. For example, you can save 
disk space by disabling archiving or full-text indexing on the Domino server. You can improve 
performance by specifying a long alarm polling time. You can also set the minimum time 
interval that must lapse before users can poll for new mail. To control the opening view, you 
can specify a Welcome page URL for all users.

To do this, you can use a configuration document to specify these values:

1. From the Domino Administrator client, click the Configuration tab and expand the 
Messaging section.

2. Click Configurations.

3. Select the Configuration Settings document for the iNotes Web Access Domino servers, 
and click Edit Configuration. If this is the new configuration, click Add Configuration. In 
case you have multiple iNotes Web Access Domino servers in your domain, you may 
create a domain wide or specify the group of Domino servers that this configuration will 
affect (Figure 2-27).
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Figure 2-27   Specifying the group or Domino server names in the Configuration settings document

4. Click the iNotes Web Access tab. A list of parameters with default values is displayed as 
shown in Figure 2-28.

Note: The configuration settings for iNotes Web Access displayed in Figure 2-28 are 
from a R5.0.9 Domino server. You do not see all of these configuration settings on a 
Domino R5.0.8 server.
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Figure 2-28   iNotes Web Access parameters in the Configuration document

5. Change any of these settings as necessary. For example, specify a customized corporate 
Welcome page for the users. Here are considerations about some of these configuration 
options:

– Archiving on server:

Because iNotes Web Access cannot archive on the client, a server archive is provided. 
There is another iNotes_WA_DisableArchive keyword in notes.ini that overrides this 
parameter. Specifying iNotes_WA_DisableArchive=0 means to allow archiving while 
iNotes_WA_DisableArchive=1 means to disable archiving.

– Full-text indexing:

This option allow users to create and maintain a full-text index on the Domino server 
when they are accessing online. Unlike full-text indexing created from a Notes client, it 
will not perform full-text indexing on attachment files.

6. Click Save and Close.

7. Restart the Domino server for the changes to take effect.

Important: Some options such as Archiving on server or Full-text indexing may 
consume more resources such as disk space, disk I/O, and processor on the Domino 
server.
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2.5  Deploying and setting up clients
One of the benefits of iNotes Web Access is less administration on the client side. If you plan 
to deploy online access only, iNotes Web Access offers a simple deployment with no-touch 
desktop installation. If you plan to deploy offline capability to the users for disconnected or 
mobile access, the users need to install Lotus iNotes Sync Manager as well as the 
subscriptions to the databases they want to take offline on their workstations.

2.5.1  Online clients
After upgrading existing users or registering new users, you need to provide three items of 
information to the users: user ID, Internet password, and a URL to access their mail file.

� User ID: To log on, the user may use the fully qualified username with organization or full 
name or user ID or shortname as specified in the Domino Directory. (For more information, 
please refer to Domino R5 Administration Help database (help5_admin.nsf) and reference 
the Security topic).

� Internet password: This is the password that you specify in the Internet Password field of 
the Person document in the Domino Directory. This password may be different from the 
user’s Notes ID password.

� URL: Users can access their mail file from iNotes Web Access by specifying a URL in the 
following format:

http://<fully-qualified-Dominoservername>/mail/<user-mail-file>.nsf

By default, this displays the Welcome Page. But you may provide other URLs to initially 
display the Inbox, Calendar, To Do list, and so on. Table 2-6 shows the URLs to directly 
access these views.

Table 2-6    URLs and the initial display views

For the Standard R5 mail template (mail50.ntf) and Extended R5 mail template 
(mail50ex.ntf), the default URL provides the WebMail interface. If the user still needs to 
access WebMail because of an unsupported Web browser, they can explicitly specify a 
URL for each interface as shown in Table 2-7.

Table 2-7   Specific URL for WebMail and iNotes Web Access for iNotes5.ntf template

Note: Make sure to specify the fully qualified Internet name, such as 
http://inotes.itso.ibm.com, instead of just the Domino server name.

To display URL

Welcome Page servername.com/mail/username.nsf

Contact List servername.com/mail/username.nsf/inotes/contacts/?OpenDocument&ui=inotes

To Do List servername.com/mail/username.nsf/inotes/todo/?OpenDocument&ui=inotes

Calendar servername.com/mail/username.nsf/inotes/calendar/?OpenDocument&ui=inotes

Mail Inbox servername.com/mail/username.nsf/inotes/mail/?OpenDocument&ui=inotes

User interface Explicitly specified URL

iNotes Web Access user interface http://www.acme.com/mail/
jsmith.nsf?OpenDatabase&ui=inotes

Domino WebMail user interface http://www.acme.com/mail/
jsmith.nsf?OpenDatabase&ui=webmail
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2.5.2  Offline clients with Lotus iNotes Sync Manager
Lotus iNotes Sync Manager is the component application that enables end users to set 
application replication for DOLS-enabled databases. Each database that you add in the 
synchronization list is referred as a subscription. You may have several subscriptions for your 
mail, directory catalog, or other DOLS-enabled applications. To install the Lotus iNotes Sync 
Manager, you can either install it directly from the Domino server or from the separate CD for 
low-bandwidth or dial-up users.

Before a user can go offline, the mail database’s owner must be set to be their own ID. In 
Domino R5.0.8, if a user tries to click Go Offline before the database’s owner is not set, an 
error occurs with an instruction on how to set the mail owner in Preferences. In this case, the 
user can to go the Preferences menu, under Mail tab, and assign themself has the mail 
owner. On the contrary, in Domino R5.0.9, the first time that a user logs on to iNotes Web 
Access, the Preferences window pops-up automatically to let the user assign themself as the 
owner of their mail database as shown in Figure 2-29.

Figure 2-29   Preferences window in R5.0.9 allowing user to assign themself as the mail owner

Users can install and enable Lotus iNotes Sync Manager for offline access to iNotes Web 
Access by themselves with an easy three-click installation. The administrator may provide the 
instructions in the following steps. These steps show you how to enable clients for offline 
access to iNotes Web Access from the Domino server:

Tip: You can use the WebMail redirection tool to provide a single URL to log on for all 
users. For more information, refer to Chapter 4, “Enhancing iNotes Web Access” on 
page 113.
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1. Start your Web browser and login to your mail file. For example, use the following URL as 
shown in Figure 2-30:

http://<Dominoservername>/mail/<user-mail-database>.nsf

Figure 2-30   Logging into mail to go offline through iNotes Web Access

2. Click Go Offline-> Install Subscription as shown in Figure 2-31.

Figure 2-31   Installing a subscription for iNotes Sync Manager

3. Click Yes to install the iNotes Sync Manager (Figure 2-32).
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Figure 2-32   Downloading the subscription software and Lotus iNotes Sync Manager

4. Select the user ID for the DOLS-enabled database (Figure 2-33).

Figure 2-33   Selecting the Notes ID for the DOLS-enabled database (in this case for the mail database)

5. The Lotus iNotes Sync Manager window appears. Wait until you see a completion 
message pop-up window. Notice that the synchronization status is idle now (Figure 2-34).

Note: You must have ActiveX enabled on the Web browser. The Lotus iNotes Sync 
Manager is implemented using ActiveX/Plug-in files that are rendered at the iNotes 
workstation level.
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Figure 2-34   Lotus iNotes Sync Manager

What is installed for offline installation in the client
By default, the Lotus iNotes Sync Manager is installed in the C:\Program Files directory. The 
files shown in Table 2-8 are installed.

Table 2-8   Location and files installed as a part of Lotus iNotes Sync Manager installation

Behind the scenes: What happens during offline installation
Besides installing a number of program files on the client, DOLS also installs what is 
essentially an “offline Domino server environment”. It consists of a Domino Directory, 
dolsnames.nsf, with Person documents for each user who has taken an application offline.

DOLS actually creates a local instance of a Domino server, running only with the necessary 
services and ports (Figure 2-35).

Note: A subscription is considered to be any DOLS-enabled database that has been 
taken offline.

Local directories Files stored in directories

C:\Program Files\Lotus iNotes Lotus iNotes Sync Manager program files

C:\Program Files\Lotus iNotes\Data DOLS configuration, dolsnames.nsf, mail.box, 
log.nsf

C:\Program Files\Lotus 
iNotes\Data\<Subscription Name>\...

Contains databases associated with that 
subscription including mail file and directory 
catalog, full-text index of all databases, and a 
user ID file

Note: iNotes Web Access offline access does not use dolsnames.nsf to keep personal 
contacts and groups as in iNotes Access for Microsoft Outlook, but rather, uses the 
Contacts folder that is a part of the mail database. This gives users the benefit of having a 
synchronized contact list at all times that they can integrate into their mail databases, 
regardless of whether they are working online or offline.
Chapter 2. Setup and deployment 49



Figure 2-35   DOLS Domino Directory (dolnames.nsf)

This instance of the Domino server uses port 89 to listen for local Web browser connections. 
However, the Web browser is not actually using the network interface to connect to the 
Domino server, but rather the internal loopback interface of 127.0.0.1. An external user 
cannot access this local PC using the workstation IP address and this port from a Web 
browser or any other client.

This is why the same port is used offline regardless of whether the online mail database uses 
SSL. If encryption is needed when the database is taken offline, it would be via modifying the 
user preferences and enabling encryption (Figure 2-36).
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Figure 2-36   User preferences: Local encryption when working offline

Enabling local mail encryption
iNotes Web Access in Domino R5.0.9 supports the local encryption of a mail database. If you 
already have a subscription that is not encrypted and now want to enable the encryption, you 
have to enable encryption as well as resubscribe your mail files by perform the following 
steps:

1. Open your Lotus iNotes Sync Manager. Delete your current subscription by clicking the 
Delete button.

2. From a Web browser, login to your mail database.

3. Click Preferences.

4. Click the Other tab.

5. Under the Offline section, select the Encrypt mail file locally check box (Figure 2-36).

6. Click one of the radio buttons that specify the level of encryption.

7. Click Save and Close. You see the animation window indicating that your new 
preferences are being saved.

8. Click Go Offline and continue with the subscription installation as described in 2.5.2, 
“Offline clients with Lotus iNotes Sync Manager” on page 46.

Important: Make sure that your Notes ID password (the one that comes with the ID file) 
and Internet password match. Otherwise, you cannot open your locally encrypted mail 
database and will receive an HTTP error code of 500.
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2.6  Other considerations
This section discusses some considerations for deploying iNotes Web Access in certain 
environments. 

2.6.1  Upgrading from a pre-R5.0.8 Domino server
Upgrading from a pre-R5.0.8 release using the incremental installer does not contain the 
iNotes Web Access mail template. If you plan to upgrade the Domino server on iSeries from a 
release prior to R5.0.8, we recommend that you upgrade using the full-version installation 
media of Domino R5.0.8 or newer releases. For more information, please refer to the Lotus 
Domino incremental installers Web page: 
http://www.ibm.com/servers/eserver/iseries/domino/incinst.htm

You can also refer to the Lotus Notes/Domino R5.0.8 MR/MU Web page at: 
http://www.notes.net/r5fixlist.nsf/Progress/5.0.8?OpenDocument

2.6.2  Upgrading from a customized mail template
Domino mail and application template customization is common among customers. However, 
the current version of the iNotes Web Access Version 1.0 mail template that comes with 
Domino R5.0.8 or R5.0.9 is not designed for, and not recommended by, Lotus to be 
customized until the future releases. At that time, proper designer tools for customizing iNotes 
Web Access will be provided.

You may continue to use a company’s customized mail template for some users in Domino 
R5.0.9 while using a iNotes Web Access template for users who plan to use iNotes Web 
Access on the same iSeries server. For customization of the iNotes Web Access template, 
please refer to Chapter 4, “Enhancing iNotes Web Access” on page 113.

2.6.3  Multiple releases of Domino servers
Running multiple releases of Domino servers in a single logical partitioning (LPAR) on iSeries 
server is currently not supported. If you have other applications that require pre-R5.0.8, you 
may need to run in a separate LPAR on the same iSeries server or on a separate iSeries 
server.

2.6.4  iNotes Web Access, Sametime, and QuickPlace on the same system
iNotes Web Access, Sametime, and QuickPlace can be installed in the same iSeries server. 
However, there is a consideration about the version compatibilities between QuickPlace and 
Domino.

Normally, QuickPlace for iSeries Release 2 can be installed as a standalone server or with an 
existing Domino server. However if you plan to install QuickPlace with an existing Domino 
server, you have to use the compatible version/release of QuickPlace that corresponds to 
Domino server version/release as denoted in Table 2-9.

With Domino R5.0.8, if you plan to run iNotes Web Access, as well as Sametime and 
QuickPlace on Domino R5.0.8, you need to upgrade Domino from R5.0.8 to R5.0.8.01 as well 
as QuickPlace 2.0.8 to 2.0.8.01. The patches are provided as Maintenance Updates (MUs) 
and are available on the Domino for iSeries service/support incremental installer Web site at: 
http://www.ibm.com/servers/eserver/iseries/domino/incinst.htm
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Table 2-9   QuickPlace and Domino compatibility releases

2.6.5  Multiple mail clients on the same Domino server
You can have Lotus Notes users, iNotes Access for Microsoft Outlook users, iNotes Web 
Access users, WebMail, or other POP3/IMAP clients accessing their mail from the same 
Domino server. In the initial release of iNotes Web Access, it supports only Internet 
Explorer 5 on a Win32 platform. Other Web clients may continue to use WebMail to access 
their mail from a Web browser.

2.6.6  Users accessing their mail database from different types of clients
Currently with Domino R5.0.8 or later, three types of R5 mail database templates are 
available as shown in Table 2-10. You may ask: “There are so many templates, which one 
should I use?”. The answer is that each template is designed to be used for different types of 
clients that access the Domino server. You may have users using different templates in the 
same system.

Table 2-10   Available R5 mail database templates for Domino R5.0.8 or later

� Mail (R5.0) is the standard R5 mail that contains forms, frames, fields views, etc. for the 
Notes client as well as the WebMail client. It provides the smallest mail database size. If 
the users use only the Notes client or WebMail or other Internet mail clients (POP3/IMAP) 
to access their mail, this template should be used.

Important: There is currently no plan for the availability of a QuickPlace release to work 
with Domino R5.0.9. For Domino customers who currently have QuickPlace 2.0.8 and 
Domino 5.0.8 installed, please be advised that an upgrade to Domino 5.0.9 will make your 
existing QuickPlace installation inoperable.

You should plan accordingly if you intend to deploy QuickPlace in the future on the same 
system running Domino R5.0.9.

QuickPlace release Domino release

N/A 5.0.9

2.0.8 5.0.8

2.0.7 5.0.7 or 5.0.7a

2.0.6a 5.0.6a

2.0.5 5.0.5

2.0 5.0.4

Template name Template description Template file name

StdR50Mail Mail (R5.0) mail50.ntf

ExtR50Mail Extended Mail (R5.0) mail50ex.ntf

iNotes5 iNotes Mail and C&S inotes5.ntf

Tip: To check which mail template is being used for each database, you can check in the 
Database Catalog (catalog.nsf) located in the Domino server’s data directory.
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� Extended Mail (R5.0) is a superset of the Mail (R5.0) template and supports all the clients 
in Mail (R5.0), plus the Microsoft Outlook client (using iNotes Access for Microsoft Outlook 
support). It was first shipped in Domino R5.0.5. It provides Microsoft Outlook users offline 
access using DOLS/Lotus iNotes Sync Manager to the client. The footprint of Lotus iNotes 
Sync Manager program, plus the template, is around 20 MB. This template should be 
used for the users who access their mail from Microsoft Outlook, Notes client, WebMail or 
Internet mail clients – in any combination.

� iNotes Mail and C&S is the iNotes Web Access template providing access to mail, 
calendar and scheduling to users via a Web browser. First shipped in R5.0.8, iNotes Web 
Access is the superset of Mail (R5.0) and Extended Mail (R5.0) plus iNotes Web Access 
and DOLS/Lotus iNotes Web Access for both online and offline access. This template 
should be used for the users who access their mail from iNotes Web Access, Microsoft 
Outlook, Notes client, WebMail, or Internet mail clients – in any combination.

2.7  National language support
iNotes Web Access client language support is based on the international language version of 
the Domino server installed. From the international version of Domino server in product 
development point of view, the language is translated based on the normal Lotus Domino 
translation process. Note that all languages may not be available on the iSeries platform. 
Here are the lists of current Domino server languages:

� Group 1: Available within 14 days of Global English – Brazilian Portuguese, French, 
Italian, German, Spanish, Simplified Chinese, Traditional Chinese, Korean, Japanese, and 
Thai

� Group 2: Available within 60 days of Global English – Iberian Portuguese, Danish, Dutch, 
Swedish, Norwegian, Finnish, Czech, Hungarian, Polish, Russian, Greek, and Turkish

Multiple language client support in the same server
Due to iNotes Web Access in R5.0.8 and R5.0.9 being based on a shared inotes5.ntf 
template and a shared forms5.nsf database, currently they do not support a multiple 
language environment on the same Domino server. This feature may be supported in future 
releases.

The HTML help for iNotes Web Access is not implemented in an NSF file, but in loose HTML 
files located in the Domino server’s data directory under the /domino/html/inotes5/help 
directory. The help text is also translated according to the language version of the Domino 
server installed. You cannot have multiple help languages on the same Domino server.

Installing other language dictionaries for spell-checking
The language dictionary files are used for spell-checking within Notes and Domino. The 
iNotes Web Access client also share the spell-checking capability and dictionary files with the 
Notes client. 

Different language versions of Domino for iSeries R5 may install different dictionaries, 
depending on the language. The Global English national language version of Domino for 
iSeries R5.0.8 (and later) installs the following language dictionary files:

� French (Canada): canadien.dic
� English (United Kingdom): uk.dic
� English (United States): us.dic
� Medical (American): wpdic.dic
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Domino for iSeries installs these files in the product directory 
/QIBM/ProdData/Lotus/Notes/shared/<dict-name>.dic, along with symbolic links to these 
dictionary files in each Domino server’s data directory.

Additional dictionary files are contained in the dictions.exe or dictionaries.exe file that may be 
obtained from one of the following sources:

� Notes.net: Download the iNotes Web Access dictionaries Win95/98/NT, OS/2, Mac 
English (dictions.exe file)

� \APPS\DICTIONARIES directory: On the Notes or Notes/Domino Designer CD

If you want to use one of the dictionary files listed in Table 2-11 and find that it has not been 
installed automatically by Domino, decompress the contents of the self extracting file to a 
temporary directory on your PC’s hard drive. End your Domino servers and then transfer the 
dictionary files using FTP (or another file transfer method) to your Domino server's data 
directory. The owner of the file should be changed to QNOTES with the following command: 

CHGOWN OBJ('<domino-server-data-directory-path>'/<dict-name>.dic') NEWOWN(QNOTES)

Add the symbolic link, to that dictionary file, to the data directory of each Domino server that 
should have access to the dictionary. Then restart your Domino servers. The symbolic link 
can be created using the Add Link (ADDLNK) command, for example:

ADDLNK OBJ(‘/QIBM/ProdData/Lotus/Notes/shared/<dic-name>.dic’) 
NEWLNK(‘<domino-server-data-directory-path>’) LNKTYPE(*SYMBOLIC)

As always, if you add dictionary files to customize your Domino installation, we recommend 
that you backup your Domino servers after the dictionary files are added.

Figure 2-37 shows the iNotes Web Access client choosing a language dictionary for 
spell-checking.

Important: Ensure you have the appropriate language dictionaries in either the product 
directory (with a SYMBOLIC link in your Domino server’s data directory for dictionaries 
installed by Domino) or each Domino server's data directory (for dictionaries installed 
manually). 
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Figure 2-37   Language dictionaries available to iNotes Web Access

Table 2-11 shows the various language dictionaries available and their associated file names.

Table 2-11   Language dictionaries and their associated file names

Language File name

Afrikaans AFRIKAAN.DIC

Catalan CATALA.DIC

Czech CZECH.DIC

Danish DANSK.DIC

Dutch
Dutch Belgian

NEDERLND.DIC

Dutch Preferred NEDPLUS.DIC

English (Australia) AUS.DIC

English (Canada)
English (Caribbean)
English (Jamaica)
English (New Zealand)
English (United States)

US.DIC

English (Ireland)
English (South Africa)
English (United Kingdom)

UK.DIC

Finnish SUOMI.DIC
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French (Belgium)
French (Luxembourg)
French (Standard)
French (Switzerland)

FRANCAIS.DIC

French (Canada) CANADIEN.DIC

German (Austria)
German (Liechtenstein)
German (Luxembourg)
German (Standard)

DEUTSCH.DIC

German (Reform) DEUTSCH2.DIC

German (Switzerland) DSCHWEIZ.DIC

Hungarian MAGYAR.DIC

Icelandic ISLENSK.DIC

Italian (Standard)
Italian (Switzerland)

ITALIANO.DIC

Medical (American)
Medical (British)
Medical (British IZE)

US.MED

Norwegian (Bokmal) NORBOK.DIC

Norwegian (Nynorsk) NORNYN.DIC

Polish POLSKA.DIC

Portuguese (Brazil) BRASIL.DIC

Portuguese (Standard) PORTUGAL.DIC

Spanish
Spanish (Argentina)
Spanish (Bolivia)
Spanish (Chile)
Spanish (Colombia)
Spanish (Costa Rica)
Spanish (Dominican Republic)
Spanish (Ecuador)
Spanish (Guatemala)
Spanish (Mexico)
Spanish (Modern Sort)
Spanish (Panama)
Spanish (Paraguay)
Spanish (Peru)
Spanish (Uruguay)
Spanish (Venezuela)

ESPANA.DIC

Swedish SVENSK.DIC

Thai SPELLT.GRA

Turkish TURKIYE.DIC

Language File name
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2.8  Performance and sizing considerations
iNotes Web Access is considered to be a type of Domino Web application. In our test 
environment that we document here in this section, we found that compared to WebMail, the 
iNotes Web Access client is over 30% lighter on CPU utilization and three times better in 
response time.

Although iNotes Web Access contains very fancy HTML, XML, DOM2 and JavaScript coding, 
it is still a Web application and must be sized as such. And as with any Notes or Web 
application, the performance is based on what the users really do, whether they be power 
users or light-weight mail readers.

2.8.1  Client recommendation
There are no special tuning parameters for the client or for Internet Explorer that will increase 
performance. However, make sure that client’s Web browser allows for caching. By default, 
the Internet Explorer caches Web pages.

2.8.2  Server recommendation
We recommend that you use the latest model of iSeries server with the latest processor 
technology for better response time. You should also configure a minimum of six disk drives 
with 10k RPM or better for systems running Domino.

For iNotes Web Access users on iSeries, a minimum of 1 GB of memory is a good rule of 
thumb. We strongly recommend that you use the iSeries Workload Estimator to determine an 
appropriate memory size based on the anticipated workload.

The IBM Workload Estimator for iSeries provides sizing recommendations for an iSeries or an 
AS/400e running one or more workloads associated with e-business or collaboration, such as 
Domino, Java, or WebSphere. You can use the Workload Estimator to size a new iSeries or 
AS/400e with all new workloads, or to size the upgrade of an existing system (with the original 
workload set or any additions).

The Workload Estimator provides sizing support for Domino applications and currently 
supports mail sizing with Notes, WebMail, POP3, IMAP, iNotes Access for Microsoft Outlook, 
and iNotes Web Access. You can access the Workload Estimator at: 
http://www.ibm.com/eserver/iseries/support/estimator

A sample result of the Workload Estimator is shown in Figure 2-38.
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Figure 2-38   IBM Workload Estimator for iSeries

2.8.3  Performance testing
In writing this redbook, we became closely integrated with the iSeries Domino Performance 
team. Together we developed our own set of scripts to drive workload for testing. The 
workload we used is shown in Table 2-12.

The configurations we tested included: 

� WebMail
� iNotes Web Access with Domino HTTP
� iNotes Web Access with Domino HTTP with SSL
� iNotes Web Access with OS/400 HTTP
� iNotes Web Access with OS/400 HTTP with SSL
� iNotes Web Access with OS/400 HTTP with SSL and the Cryptographic Coprocessor

For SSL testing, the Domino servers were set to redirect HTTP port 80 to SSL port 443. 
Server keyring files were 1024-bit CA with SSL v3 used. Each configuration used four 
iterations of our script and completed the same number of scripted transactions with 500 
users.

Another very important performance aspect of using SSL on Domino servers is Web browser 
settings. A default Web browser will not cache anything from SSL sites, including GIFs, so 
they must be reloaded each time, adding significant overhead. This is shown in Table 2-15 on 
page 62. 
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To enable Web browser caching for encrytped pages, perform the following steps:

1. From your Internet Explorer 5 Web browser, select Tools -> Internet Options from the 
pull-down menu.

2. From the Internet Options window, select the Advanced tab.

3. Scroll down in the Settings list to the Security section, and deselect the Do not save 
encrypted pages to disk (Figure 2-39) option. Click OK.

Figure 2-39   Caching encrypted pages on the Internet Explorer Web browser

The purpose of these performance tests was to look at various options that are available on 
the iSeries platform and analyze the performance implications while providing a realistic 
workload. The components used in our tests are summarized in Table 2-12.

Table 2-12   Workload components used in our performance test environment

Workload component Description Scripted 
transactions 
for iterations

Authenticate Login to the user’s mail file 2000

Open Inbox and read five 
messages

Open and scroll through five messages (13K 
each)

10000

File two documents File documents in a folder. 4000

View folder Open folder to see documents were moved 4000

Send two messages Send 13K message to three recipients each 
time

4000

Delete four messages from the 
Inbox

Scroll to bottom of the Inbox and click Delete; 
then go to Trash folder and Empty Trash to 
complete actual deletion of a document

8000

                                                                                                                                                            Total: 32000
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Performance rationale
It is important that you understand and can interpret our performance data so you can 
correlate the results to your Domino environment. Table 2-12 describes what our performance 
tool calls a transaction. For every performance analysis, we ran four iterations of our script 
that correlates to the 32,000 scripted transactions listed in Table 2-12. The results indicated 
that the total number of Domino requests equals approximately three times the total scripted 
transactions (32000) for iNotes Web Access. To start your total Domino requests on your 
Domino server, issue the sh stat domino command from the Domino server console. 
Figure 2-40 shows the results of this command.

Figure 2-40   Total of Domino requests per hour

The measurements were collected on an iSeries Model 820-2438 running OS/400 V5R1. 
This system has the equivalent performance as the Dedicated Server for Domino (DSD) 
Model 820-2458. The system was configured with 43 9 GB disk drives and RAID5 protection. 
Table 2-13 shows more specifications of our test system.

Table 2-13   Performance test system specifications

Performance results
The results in Table 2-14 show that iNotes Web Access accomplished its goals by reducing 
CPU utilization over 30% compared to WebMail and improving response time significantly.

Using the OS/400 HTTP server does not yield performance benefits unless used with SSL or 
the Cryptographic Coprocessor, compared to Domino HTTP with SSL. The reason for this is 
the Domino R5 server’s HTTP code does not support persistent connections. There would be 
a worthwhile gain if you needed to run WebSphere and Domino together and they needed to 
share the same HTTP stack and peacefully coexist.

Table 2-14   Results of our performance tests 

                            Display Domino Console                              
                                                         Server: INOTESML01     
 Previous subcommands and messages:                                             

Domino.Requests.Total = 94,336 
     Domino.ThreadPool.average = 136619  
     Domino.ThreadPool.max = 262144 
     Domino.Threads.Active.Peak = 43 

F3=Exit   F5=Refresh   F6=Print                                                
 F17=Top   F18=Bottom   F21=Command line                                        

Model number Number of CPUs
(600 Mhz each)

Memory pool size Number of users

820-2438 4 11GB 500

Configurations for 
performance tests

Number 
of users

Average 
response time 
in seconds

Average CPU 
utilization 
(%)

Total 
Domino 
requests

Average 
com util 
(%)

WebMail 500 2.2 58.7% 70097 16.3

iNotes Web Access 
Domino HTTP

500 .8 46.1% 92507 13.4
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Performance and security considerations
Typically the benefits of enabling security far outweigh the costs to deploy it. In general, 
enabling SSL may degrade server performance by at least 20%. But in our performance 
testing, we saw CPU utilization increase an average of only about 10% with SSL. The main 
idea is to plan accordingly when scaling your server.

Another alternative is to offload the SSL process to another hardware device. The iSeries 
server provides an integrated solution by using the new IBM PCI Cryptographic Coprocessor 
#4758 to offload SSL asymmetric key-pair negotiations between the Web browser client and 
the Domino iNotes Web Access server. For more information about Cryptographic 
Coprocessor and SSL configuration, refer to 3.2.4, “Configuring the Cryptographic 
Coprocessor” on page 83.

In 2.8.3, “Performance testing” on page 59, we talked about the importance of the Web 
browser caching from SSL sites. Table 2-15 shows the effects of caching encrypted pages.

Table 2-15   Effects of allowing caching from SSL sites

iNotes Web Access 
Domino HTTP with SSL

500 1.4 48.1% 92507 14.8

iNotes Web Access 
OS/400 HTTP

500 1.0 54.0% 92507 13.5

iNotes Web Access 
OS/400 HTTP with SSL

500 1.0 54.4% 92507 14.7

iNotes Web Access 
OS/400 HTTP with 
SSL/Cryptographic

500 1.0 54.3% 92507 14.7

Configurations for 
performance tests

Number 
of users

Average 
response time 
in seconds

Average CPU 
utilization 
(%)

Total 
Domino 
requests

Average 
com util 
(%)

Note: Please be aware that the Average response time in seconds is an average of 
“scripted” transactions that are shown in Table 2-12 on page 60. Total Domino requests on 
iNotes Web Access are greater than WebMail because HTML, XML, DOM2, and 
JavaScript coding is used. The CPU utilization and response time are significantly better 
with iNotes Web Access.

Configurations for 
performance tests

Number 
of users

Average 
response time 
in seconds

Average CPU 
utilization (%)

Total 
Domino 
requests

Average 
com util 
(%)

iNotes Web Access
Domino HTTP + SSL 
(allow caching)

500 1.4 48.1 92507 14.8

iNotes Web Access
Domino HTTP + SSL
(no caching)

500 3.0 54.3 92507 35.4

iNotes Web Access
OS/400 HTTP
(allow caching)

500 1.0 54.4 92507 14.7
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2.8.4  Domino server tuning
Domino is simply an application suite that has its own work and memory management 
functions and is designed on the iSeries server to run in its own dedicated subsystem. Tuning 
Lotus Domino for iSeries and tuning the iSeries server, therefore, must go together.

Notes.ini configuration
We recommend that you specify the NSF_BUFFER_POOL_SIZE_MB setting in the notes.ini 
file. This is because the Domino servers run out of their own storage pool that the 
auto-performance adjuster (WRKSYSVAL QPFRADJ) typically changes dynamically.

If you do not specify a value for NSF_BUFFER_POOL_SIZE_MB, by default, Domino will 
calculate a value to use based on the total memory of your iSeries server, not on its share of 
the storage pool. For most servers, 300 MB may work fine, but use the following procedure to 
determine a more precise value:

1. Determine which storage pool the Domino server is using. You can determine this by 
using the Work with Active Jobs (WRKACTJOB) command and then pressing F11. By 
default, the storage pool is 2 (Figure 2-41).

Figure 2-41   Determining which storage pool the Domino server is using with WRKACTJOB

iNotes Web Access
OS/400 HTTP 
(no caching)

500 2.3 60.5 92507 35.2

Configurations for 
performance tests

Number 
of users

Average 
response time 
in seconds

Average CPU 
utilization (%)

Total 
Domino 
requests

Average 
com util 
(%)

 Work with Active Jobs                     AS06    
                                                             11/29/01  17:24:34
 CPU %:    6.4     Elapsed time:   00:00:43     Active jobs:   266             
                                                                               
 Type options, press Enter.                                                    
   2=Change   3=Hold   4=End   5=Work with   6=Release   7=Display message     
   8=Work with spooled files   13=Disconnect ...                               
                                               --------Elapsed---------        
 Opt  Subsystem/Job  Type  Pool  Pty      CPU  Int    Rsp  AuxIO  CPU %        
      INOTESML01     SBS     2    0        .0                  0     .0        
        ADMINP       BCI     2   20      99.2                  0     .0        
        AMGR         BCI     2   20      23.9                  0     .0        
        AMGR         BCI     2   20      12.3                  0     .0        
        CALCONN      BCI     2   20       6.4                  0     .0        
        CLREPL       BCI     2   20     233.0                  0     .1        
        DIRCAT       BCI     2   20       5.8                  0     .0        
        EVENT        BCI     2   20     710.8                  0     .4        
        HTTP         BCI     2   20+    134.8                  0     .0        
                                                                        More...
 Parameters or command                                                         
 ===>                                                                          
 F3=Exit   F5=Refresh      F7=Find      F10=Restart statistics                 
 F11=Display thread data   F12=Cancel   F23=More options   F24=More keys       
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You may also determine the storage pool by using Operations Navigator in OS/400 V5R1. 
To do this, look under the category Work Management-> Subsystems. Then look under 
the Memory Pool column as shown in Figure 2-42.

Figure 2-42   Determining which storage pool the Domino server is using with Operations Navigator

2. Find the size of the storage pool while your system is running at a steady state (that is, 
when QPFRADJ is not changing the pool sizes). You can see this with the Work with 
System Status (WRKSYSSTS) command as shown in Figure 2-43.

Figure 2-43   Determining the size of the storage pool using WRKSYSSTS

You may also determine the size of the storage pool by using Operations Navigator in 
OS/400 V5R1. As shown in Figure 2-44, look under Work Management-> Memory 
Pools.

                            Work with System Status                    AS06     
                                                             11/29/01  17:56:47 
 % CPU used . . . . . . . :        5.9    System ASP . . . . . . . :    87.74 G 
 % DB capability  . . . . :         .0    % system ASP used  . . . :    38.2486 
 Elapsed time . . . . . . :   00:00:01    Total aux stg  . . . . . :    87.74 G 
 Jobs in system . . . . . :        891    Current unprotect used . :     3630 M 
 % perm addresses . . . . :       .013    Maximum unprotect  . . . :     4233 M 
 % temp addresses . . . . :       .010                                          
                                                                                
 Sys      Pool   Reserved    Max                                      Paging    
 Pool    Size M   Size M     Act  Pool        Subsystem   Library     Option    
   1     319.35    193.29  +++++  *MACHINE                            *FIXED    
   2    3530.88      3.05    319  *BASE                               *CALC     
   3     204.79       .00     79  *INTERACT                           *CALC     
   4      40.95       .00      5  *SPOOL                              *FIXED    

(ASM06)

ASM06
64 iNotes Web Access on iSeries Server



Figure 2-44   Determining the size of the storage pool using Operations Navigator

3. If you have multiple partitioned Domino servers using that storage pool, divide the pool 
size by the number of servers using the pool (excluding the *HTTPSETUP server, which is 
for configuring Domino servers only) and multiply by 3/8. Set the 
NSF_BUFFER_POOL_SIZE_MB in notes.ini to this number.

MAIL.BOX configuration
For optimal messaging throughput, enable two MAIL.BOX files. Keep in mind that MAIL.BOX 
files grow as a messages queue and that this growth can potentially impact disk I/O 
operations. Therefore, monitor MAIL.BOX statistics on the Domino server. Check statistics 
such as Mail.Waiting and Mail.MaximumDeliverTime. If either or both statistics increase over 
time, increase the number of active MAIL.BOX files and continue to monitor the statistics.

HTTP thread configuration
HTTP clients use non-persistent connections to the Domino server. Web browser requests 
are handled by HTTP threads running on the Domino server. By default, Domino allocates 40 
HTTP threads to service HTTP requests from Web browsers. After the Domino server honors 
a Web browser request, that HTTP thread is free to service the next request. The number of 
requests that can be completed per second determines how many users can be supported by 
the system. We recommend that you use the default number of 40 HTTP threads on iSeries.

A single HTTP request from a Web browser client requires one file descriptor for the network 
connection and one for the item being requested. This requirement increases if authentication 
is enabled. Figure 2-45 shows the Minimum HTTP active thread setting and the Run Web 
agents concurrently setting in the Domino server document.

(ASM06)

ASM06
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Figure 2-45   Number of HTTP active threads and enabling running Web agents concurrently

Verifying HTTP thread activity
When the HTTP server task initializes on the Domino server, the defined threads are created 
and occupy approximately 20 to 40 KB of memory each. These threads are fixed in number 
until you change the value in the Domino server document as shown in Figure 2-45. Once 
you change the number of active HTTP threads, you must restart the HTTP task. Use the 
Work with Active Jobs (WRKACTJOB) command to confirm the HTTP job has started the 
defined amount of threads as shown in Figure 2-46.
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Figure 2-46   Work with Active Jobs to verify number of HTTP threads

Measuring thread activity
The statistics in Figure 2-47 regarding threads can be measured using the Domino server 
console. Issue the following command from the Domino server console: 

show stat domino

Figure 2-47   The show stat domino command for threads

If Domino.Threads.Active.Peak is equal to Domino.Threads.Total, HTTP requests may be 
waiting for the HTTP server to make an active thread idle before handling the request. If this is 
the case, increase the number of active threads in the HTTP section of the Domino server 
document (as shown in Figure 2-45) until Domino.Threads.Active.Peak is less than 
Domino.Threads.Total.

                             Work with Active Jobs                     AS06     
                                                             12/06/01  15:27:43 
 CPU %:   19.9     Elapsed time:   00:00:02     Active jobs:   304              
                                                                                
 Type options, press Enter.                                                     
   2=Change   3=Hold   4=End   5=Work with   6=Release   7=Display message      
   8=Work with spooled files   13=Disconnect ...                                
                                                                                
 Opt  Subsystem/Job  User        Number  Type  CPU %  Threads                   
        HTTP         QNOTES      028101  BCI      .0       49                   
        QNNINSTS     QNOTES      026616  BCH      .0        1                   
        REPLICA      QNOTES      028091  BCI      .0        1                   
        ROUTER       QNOTES      028092  BCI      .0        1                   
        SCHED        QNOTES      028098  BCI      .0        1                   
        SERVER       QNOTES      026617  BCI      .1       59                   
        SMTP         QNOTES      028105  BCI      .0        2                   
        STATS        QNOTES      028094  BCI      .0        1                   
        UPDATE       QNOTES      028093  BCI      .0        1                   
                                                                         Bottom 
 Parameters or command                                                          
 ===>                                                                           
 F3=Exit   F5=Refresh   F7=Find   F10=Restart statistics   F11=Display status   
 F12=Cancel   F17=Top   F18=Bottom   F23=More options      F24=More keys        

                          Work with Domino Console                              
                                                           Server: INOTES01     
 Previous subcommands and messages: 

Domino.Config.ActiveThreads.Max = 40
  Domino.Config.ActiveThreads.Min = 20
  Domino.Threads.Active.Peak = 2
  Domino.Threads.Peak.Time = 12/06/01 14:32:06
  Domino.Threads.Peak.Total = 40
Enter a Domino subcommand.                                                     
 ===>                                                                           
F3=Exit   F5=Refresh   F6=Print   F9=Retrieve                                  

 F17=Top   F18=Bottom   F21=Command line                                        
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To ensure optimal performance, increase or decrease the number of active threads in jumps 
of five so that Domino.Threads.Total is close to five threads greater than 
Domino.Threads.Active.Peak. This minimizes the iSeries resources used and provides the 
greatest user responsiveness.

By having the number of active threads five above the peak active, it also allows for the 
increased use of your Web site in the future. To ensure that there are sufficient threads in the 
future, it is important that you review Domino.Threads.Active.Peak on a regular basis.

Maximum cache design settings
iNotes Web Access is an example of a database that stores design elements in main storage. 
The cached design parameter converts Notes database design elements to HTML and stores 
them in main storage while the Domino server is operational. The number of design elements 
within a database determines the number of design cache maximum required to optimize the 
design cache.

To measure the required maximum cached design elements, issue the following command 
from the Domino server console (Figure 2-48): 

sh stat domino

Figure 2-48   The show stat domino command for cache design

To optimize the performance of your Domino HTTP design cache, ensure that 
Domino.Cache.Design.Count is slightly less than Domino.Cache.Design.MaxSize. If these 
statistics are equal, increase the maximum cached design parameter in the HTTP section of 
the Domino server document by five until Domino.Cache.Design.Count is less than 
Domino.Cache.Design.MaxSize. This provides optimal performance for design caching on your 
Domino HTTP Web site.

Defining cache settings
You can update the cache settings in the Domino server document. Simply click the Internet 
Protocols tab. Then click the Domino Web Engine subtab, and go to Memory Caches as 
shown in Figure 2-49.

Note: For more information on best practices for Domino HTTP, refer to the redbook Lotus 
Domino for iSeries: Sizing and Performance Tuning, SG24-5162.

                          Work with Domino Console                              
                                                          Server: INOTESML01    
 Previous subcommands and messages:                                             
                                                                                

Domino.Cache.Design.Count = 256
     Domino.Cache.Design.DisplaceRate = 20.7669407913497
     Domino.Cache.Design.HitRate = 79.0870621514035 
     Domino.Cache.Design.MaxSize = 256 
Enter a Domino subcommand.                                                     
 ===>                                                                           
F3=Exit   F5=Refresh   F6=Print   F9=Retrieve                                  
 F17=Top   F18=Bottom   F21=Command line                                        
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Figure 2-49   Domino server document: Memory Caches

Utilizing HTTP logging
The level of logging that can be achieved within a Domino HTTP server can be extremely 
detailed if required. Figure 2-50 shows the logging portion of the HTTP section within a 
Domino server document in the Domino Directory. Click the Internet Protocols tab and then 
click the HTTP subtab. Go to Enable Logging To.

Figure 2-50   Domino server document: Enable Logging To

Other Domino server setting recommendations
You should also consider the following Domino server settings:

� Under the Internet Protocols tab and the HTTP subtab in the Domino server document, 
set “Run Web agents concurrently” to Enable. This also should be set for most Web 
applications.

� Under the Basics tab, set “Optimize HTTP performance based on the following primary 
activity” to Both Mail and Applications.

2.8.5  iSeries server tuning
You can alter Domino job priorities permanently on iSeries servers by creating a new class 
object for that job. You cannot change the priority of the SERVER job itself. See the Domino 
for the iSeries Administrator’s Guide for further information.

Note: If logging is not required by your organization, it should not be used except for 
troubleshooting. This optimizes the performance of the HTTP server and should be only 
used temporarily.
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You can find further iSeries Domino performance information on the Web at: 
http://www.iseries.ibm.com/developer/domino/perform/index.html

2.8.6  Network bandwidth requirements
Network bandwidth use by the iNotes Web Access client can vary considerably. During 
testing, we observed bandwidth use as low as 2.7 Kbps per user with short mail messages on 
a small private 100 Mb network. In diverse, enterprise networks, however, bandwidth use may 
be as high as 6 to 8 Kbps per user. Estimating the proportion of active users/connections to 
registered users and understanding server workload is a very important step in calculating 
requirements for network bandwidth. After your Domino server is configured and running, you 
can monitor actual utilization by using a network sniffer tools.

For network sizing, you cannot assume the total network data rate for available bandwidth 
because there is also overhead in networking protocol in various network topologies 
(LAN/MAN/WAN). For example, in a T1 WAN connection (1.5 Mbps), allowing overhead for 
network protocol at 50%, the expected practical utilization bandwidth is:

1,500 Kbps X 50% = 750 Kbps
750 Kbps / 6Kbps per user = 125 concurrent users

It includes a dedicated 100 Mbps LAN environment that allows for the overhead of networking 
protocol at 60%. The expected practical utilization bandwidth is:

100 Mbps X 60% = 60,000 Kbps
60,000 Kbps / 6 Kbps per user = 10,000 concurrent users

However, 10,000 concurrent users in a single 100 Mbps would saturate this network segment. 
We recommend that you use other alternatives such as Gigabit Ethernet adapters or multiple 
100 Mbps Ethernet adapters connected to multiple network segments to the clients.

2.8.7  Sizing examples
This section describes some sizing scenarios for the iSeries platform. All of these examples 
have been generated using the IBM Workload Estimator tool.

The IBM Workload Estimator for iSeries provides sizing recommendations for an iSeries 
server or an AS/400e running one or more workloads associated with e-business or 
collaboration, such as Domino, Java, or WebSphere. You can use the Workload Estimator to 
size a brand new iSeries server or AS/400e with all new workloads, or to size the upgrade of 
an existing system (with the original workload set or any additions) to a new system.

The Workload Estimator recommends the model, processor, interactive feature, memory, and 
DASD necessary for a mixed set of workloads. To use the Workload Estimator, you select one 
or more workloads and answer a few questions about each workload. Based on your 
answers, the Workload Estimator generates a recommendation and shows the predicted CPU 
utilization of the recommended system in graphical format. You can then print the final results. 
Advanced users have the option to provide more specific information for particular workloads, 
thereby resulting in a more accurate estimate.

Note: The percent of concurrent users, characteristic of iNotes Web Access, is different 
from the Notes client. 40% to 60% concurrent users in a Notes client may reflect to 10 to 
15% concurrent in iNotes Web Access. Offline access with lower frequency of 
synchronization also decreases the network bandwidth utilization dramatically.
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We created some examples of sizing configurations, according to the following assumptions:

� 1000, 2000, 3000, 5000 and 10,000 iNotes Web Access user scenarios

We ran several scenarios using these numbers of iNotes Web Access users, which are 
shown at the end of this chapter:

– Figure 2-51 shows the results of a 1,000 iNotes Web Access user scenario.

– Figure 2-52 shows the results of a 2,000 iNotes Web Access user scenario.

– Figure 2-53 on page 73 shows the results of a 3,000 iNotes Web Access user 
scenario.

– Figure 2-54 on page 73 shows the results of a 5,000 iNotes Web Access user 
scenario.

– Figure 2-55 on page 74 shows the results of a 10,000 iNotes Web Access user 
scenario.

� All scenarios assume three user types:

– 10% of casual mail users: A casual mail user uses e-mail only, without using the 
calendar and scheduling features. The casual user rarely, if ever, sends or receives 
e-mail attachments. In our experience, even if users start as “casual”, they quickly 
learn more about the product and advance to becoming moderate users very quickly.

For correct sizing, we encourage you not to overestimate the number of casual users 
you will have. A simple mail user for performance estimating purposes has the 
following characteristics: 

In a 15 minute period, they read five documents, update two documents, delete two 
documents, view one document and scroll through it, open and close one database, 
open and close one view, send a mail message to an average of three people no 
more frequently than every 90 minutes.

– 70% moderate mail users: This type of user uses e-mail more heavily with the 
addition of the calendar and scheduling features. They also perform the same script as 
a casual user in about half of the time.

– 20% heavy mail users: What distinguishes a heavy user from a moderate user is both 
the complexity of tasks performed and the level of dependence on Notes/Domino. 
Think of a heavy user as someone who uses Notes/Domino constantly for core job 
functions. For example, a heavy user might be a secretary who manages several 
calendars and often uses free time search to schedule meetings, a technical expert 
who constantly monitors and updates discussion databases, or a manager who 
receives many “workflow” requests for approval. For mail users with databases larger 
than 200 MB, it may be appropriate to use the heavy mail user type. Typically, a larger 
mail database size is indicative of more complex mail processing.

� 50% of all registered users accessing concurrently.

� 75 Mb average size of mail file.

All sizing examples also provide a solution that considers 50% growth.

Note: This is a commonly used measurement for comparing Domino capacity across 
different Domino server platforms. A typical rule of thumb when equating simple mail 
users to “real world” or typical mail users is to divide by three.
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Scenario 1: 1,000 iNotes Web Access users

Figure 2-51   Sizing for 1,000 iNotes Web Access users

Scenario 2: 2,000 iNotes Web Access users

Figure 2-52   Sizing for 2,000 iNotes Web Access users
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Scenario 3: 3,000 iNotes Web Access users

Figure 2-53   Sizing for 3,000 iNotes Web Access users

Scenario 4: 5,000 iNotes Web Access users

Figure 2-54   Sizing for 5,000 iNotes Web Access users
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Scenario 5: 10,000 iNotes Web Access users

Figure 2-55   Sizing for 10,000 iNotes Web Access users
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Chapter 3. Security

This chapter discusses some security issues that are important to consider when setting up 
iNotes Web Access. It also covers some platform-specific considerations and features for the 
iSeries server.

The topics in this chapter include:

� General security considerations
� Cryptographic adapter
� Web single sign-on
� Firewall considerations
� Using LDAP for authentication

3
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3.1  General security considerations
This section discusses topics related to security setup and administration for iNotes Web 
Access running on Domino for iSeries.

3.1.1  Security on iSeries server
iSeries security features protect the Integrated File System (IFS). Security features, such as 
user profiles and group profiles, control access to the iSeries server. Special authorization is 
given to access specific resources such as libraries, programs, and files.

iSeries security concepts are similar to Domino security concepts. These security concepts 
complement each other. The iSeries security system protects Domino databases from any 
access outside of Domino. Domino security controls access within Domino for iSeries.

To install Domino for iSeries, you need a user profile with the special authorities of *ALLOBJ 
(access to all objects) and *SECADM (security administration). To configure a Domino 
server, you also need the special authorities of *JOBCTL (job control) and *IOSYSCFG 
(device and communications configuration).

3.1.2  Authentication
One of the first decisions that you need to make regarding security is about the method you 
are you going to use to authenticate iNotes Web Access users who access the Domino 
server. Domino offers two different methods:

� Name and password authentication
� Session-based name and password authentication

Both methods offer the ability authenticate users using either the Domino Directory, a 
secondary Domino directory, or an LDAP directory.

Name and password authentication
Also known as basic password authentication, name and password authentication uses a 
basic challenge/response protocol to ask users for their names and passwords. It then 
verifies the accuracy of the passwords by checking them against those stored in Person 
documents in the Domino Directory or any other secondary directories.

This method uses the access control lists (ACLs) of each database to allow or deny access to 
it and can be customized using the Domino Web Server Application Programming Interface 
(DSAPI).

How it works
When a user attempts to access the Domino server, the server is checked to see whether 
anonymous users can access it. If the Domino server allows anonymous access, the 
database is opened. If it doesn’t, the user is prompted for a user name and password.

This user name and password is looked up in the Domino Directory or any other secondary 
directory configured with Directory Assistance. If the user name and password are found, 
they are authenticated as that user in Domino.

Next the access control list of the database is checked, and the user name previously 
provided is compared to the list. If access is allowed (either via groups or individual entry) or if 
anonymous or default access is allowed, the user is granted access to the database. 
Otherwise, they are prompted for a user name and password again (Figure 3-1).
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Figure 3-1   Name and password authentication

For detailed information, please refer to the Domino Administration guide.

Session-based name and password authentication
Another commonly used method for authentication is to use session-based name and 
password.

A session is a period on which the user is actively logged to the Domino server. 
Session-based name and password authentication includes additional functionality that is not 
available with basic name and password authentication. Additional settings can be used to 
control session-based authentication, such as an idle session time-out (a time after which an 
inactive user's session will be discarded, therefore forced to log in again). You can also set 
the number of maximum active sessions on the Domino server.

The Domino Configuration database already has a sample login form, but it can be 
customized to have additional information or a different look. This customization is done 
easily using the Domino Designer.

For more information, please refer to the Domino Administration guide.

3.1.3  Access control lists
Access control lists define who can access, and to what extent they can access, a Domino 
database. In the case of iNotes Web Access, they define what users can compose or read 
e-mail or perform delegated calendaring tasks.

In most cases, it is most common to grant Manager access to the owner of the mail database, 
while using the Lotus Notes client. But regardless of the settings for the owner that were 
chosen on the Basics tab within the ACL, access to a mail database using a Web browser is 
Editor by default.

User tries to access
a database on the

Domino server

User accesses the
database

User is challenged
with name and

password

Yes

Yes

Yes

No

Yes

No

No

Is
anonymous

access
allowed?

Is the user
listed in the
DB's ACL?

Is the user
listed in the

Domino
Directory?

Is the
password
correct?
Chapter 3. Security 77



This is based on the Maximum Internet name & password field in the Advanced access 
control list settings (Figure 3-2).

Figure 3-2   Advanced section of the Access Control List

This is enough for most functions. But for other functions, like creating a full-text index, 
enabling the out of office agent or changing the Internet password, the user needs at least 
Designer access.

Although only users with Manager access can modify the access control list of a database, 
the iNotes Web Access user can change the delegation profile of a database even if they are 
not the Manager of it. These changes are performed by the Domino server using the 
administrative process. An administrative request is issued and logged in the admin4.nsf 
database, and later on, the administrative process executes it.

For details, refer to the iNotes Web Access Deployment Guide for Domino 5.0.9 white paper.

3.2  Cryptographic adapter
The IBM PCI Cryptographic Coprocessor technology is offered by IBM as an end product for 
use in personal computer machines and as features or RPQs in the pSeries (RS/6000), 
iSeries (AS/400), and zSeries (S/390) servers.

Highlights of the IBM 4758 PCI Cryptographic Coprocessor include:

� Tamper-responding design certified under FIPS PUB 140-1. Suitable for high-security 
processing and cryptographic operations. The 4758 provides a secure platform on which 
developers can build secure applications.

� Hardware to perform DES, triple-DES, SHA-1, random number generation, and modular 
math functions for RSA and similar public-key cryptographic algorithms.

� Secure code loading that enables updating of the software with the Cryptographic 
Coprocessor installed in application systems.

� IBM Common Cryptographic Architecture (CCA) and PKCS #11 (Cryptoki) 
implementations as well as custom software options.
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A secure coprocessor is a general-purpose computing environment that withstands physical 
attacks and logical attacks. The device must run the programs that it is supposed to, but they 
must be unaltered. You must be able to (remotely) distinguish between the real device and 
application, and a clever impersonator. The coprocessor must remain secure even if 
adversaries carry out destructive analysis of one or more devices.

Many servers operate in distributed environments where it is difficult or impossible to provide 
complete physical security for sensitive processing. And, in some applications, the motivated 
adversary is the end user. You need a device that you can trust even though you cannot 
control its environment.

Cryptography is an essential tool in secure processing. When your application must 
communicate with other distributed elements, or assert or ascertain the validity of data it is 
processing, you will find cryptography is an essential tool.

The cryptographic coprocessor module provides several mechanism classes, with SSL 
version 3 among them. You can use the cryptographic coprocessor PCI adapter to process 
an SSL request to the Domino Web server.

3.2.1  Prerequisites
The prerequisites for using the cryptographic adapter on the iSeries server are:

� The country using the cryptographic coprocessor is not on the list of embargoed countries.
� OS/400 option 34, Digital Certificate Manager (5722-SS1) is installed.
� OS/400 option 35, Cryptographic Service Provider (5722-SS1) is installed.
� TCP/IP Connectivity Utilities (5722-TC1) is installed.
� One of the following Cryptographic Access Provider products is installed:

– Cryptographic Access Provider 128-bit (5722-AC3)
– Cryptographic Access Provider 56-bit (5722-AC2)

� Feature to order: 4801 (customer installed) or 4802 (CE installed).
� IBM HTTP Server (5722-DG1) is installed.

� The OS/400 HTTP Admin instance should be started on port 2001 of the iSeries server 
that is required for setting up the cryptographic coprocessor. Note that:

– The HTTP Admin instance must be configured to use SSL.
– The OS/400 Digital Certificate Manager (DCM) must be used to create and assign a 

certificate to the Admin instance.

� The OS/400 user profile used for configuration must have the *SECADM and *IOSYSCFG 
special authorities.

� If the customer plans to also implement DOLS for offline support, a separate Domino 
HTTP server needs to be configured.

3.2.2  How the cryptographic adapter works
The 4758 Cryptographic Coprocessor provides a secure environment for processing 
encryption and decryption of data. You can use the Cryptographic Coprocessor with OS/400 
Digital Certificate Manager to provide secure private key storage, performance assist, and 
CPU offloading for SSL session establishment cryptographic operations.

Note: At the time this redbook was written, Domino for iSeries only supported the 
original OS/400 HTTP server, not the Apache server.
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3.2.3  Domino plug-in for the OS/400 HTTP server
The Domino plug-in for the OS/400 HTTP server (the original OS/400 HTTP server, not the 
Apache server) has been available since Domino R5.0.4. Additional setup instructions are in 
the Domino for AS/400 5.0.4 Release Notes (Readas4.NSF or Readas4.PDF, available from 
the Notes.Net Document Library at http://www.notes.net/notesua.nsf/).

Domino restrictions
When running Domino on the OS/400 HTTP server, keep in mind these restrictions:

� Domino administration via the WebAdmin application (WebAdmin.NSF) is not supported.

� Automatic Domino restart after a crash is not supported. You must restart the Domino 
server manually.

� You must end the OS/400 HTTP server before you end the associated Domino server.

� After a Domino server crash, you must end the associated OS/400 HTTP server before 
you attempt to restart the Domino server.

� Applications that generate URLs that reference a Domino databases by its Universal 
Notes ID (UNID) instead of its file name (for example, my_db.nsf) are not supported. 
Domino.Doc is an example of an application that generates URLs in this non-supported 
format.

� The Domino plug-in for OS/400 HTTP server is not supported with QuickPlace.

� Applications that use Domino Web Server API (DSAPI) filters are not supported. For 
example, Domino Off-Line Services (DOLS) is a key part of iNotes Web functionality and 
is not supported with the OS/400 HTTP server.

� The Domino Internet Cluster Manger (ICM) is not supported.

� Client authentication using SSL is not supported.

Reconfiguring the OS/400 HTTP server
You need to define a one-to-one relationship between an existing Domino server and an 
existing OS/400 HTTP server. Use Table 3-1 to determine your corresponding values.

Table 3-1   OS/400 HTTP and Domino server settings

Perform the following steps to reconfigure the OS/400 HTTP server with the Domino plug-in:

1. Start the OS/400 HTTP administration server using the following OS/400 CL command: 

STRTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN)

2. From a Web browser, access the OS/400 HTTP administration server on port 2001, for 
example:

http://<my system name>:2001

You are then prompted for your OS/400 user ID and password.

Example tag Description 

<my OS/400 HTTP server name> The name of the OS/400 HTTP server instance to be 
associated with the Domino server (for example, mywebsvr)

<my Domino server name> The name of the Domino server to be associated with the 
OS/400 HTTP server (for example, mydomsvr)

<my Domino server data directory>  The name of the Domino server's data directory (for example, 
/mydomsvr/domino/data)

<my system name>  The Internet host name of the iSeries server
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3. Select IBM HTTP Server for AS/400 from the AS/400 Tasks main menu.

4. Click the Configuration and Administration icon from the left pane.

5. Select your OS/400 HTTP server from the list on the left panel. Make sure the HTTP 
server type is Original (Figure 3-3).

Figure 3-3   Selecting an OS/400 HTTP server configuration

6. Click Request Processing-> Request Routing (Figure 3-4).

Figure 3-4   OS/400 HTTP server configuration

7. Add the three lines as shown in Table 3-2. This assumes your Domino server uses the 
default directories for its icons and Java applets.

Table 3-2   Request routing entries

Action URL
template

 Replacement file path CGI conversion mode 
(in/out) 

Service *.nsf* /QSYS.LIB/QNOTES.LIB/LIBHTTPX.SRVPGM:Service %%BINARY/MIXED%% 

Pass /icons/*  /<my Domino server data directory>/domino/icons/*

Pass /domjava/*  /<my Domino server data directory>/domino/JAVA/*
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8. Click Server API Application and add the two lines shown in Table 3-3.

Table 3-3   Server API Application entries

Reconfiguring the Domino server
Perform the following steps to reconfigure the Domino server to use the OS/400 HTTP 
server:

1. Update the Domino server so that it uses the OS/400 HTTP server instead of its own 
internal HTTP server. Use the Change Domino Server (CHGDOMSVR) command, for 
example:

CHGDOMSVR SERVER(<my Domino servername>) WEB(<my OS/400 HTTP server name>) 

See Figure 3-5.

Figure 3-5   CHGDOMSVR command

2. Restart your Domino server.

3. Start the OS/400 HTTP server using the Start TCP/IP Server (STRTCPSVR) command, 
for example:

STRTCPSVR SERVER(*HTTP) HTTPSVR(<my OS/400 HTTP server name>) 

You should now be able to access the Domino NSF files via the OS/400 HTTP server.

Step Application path and file name 

ServerInit  /QSYS.LIB/QNOTES.LIB/LIBHTTPX.SRVPGM:ServerInit 

ServerTerm  /QSYS.LIB/QNOTES.LIB/LIBHTTPX.SRVPGM:ServerTerm  

                        Change Domino Server (CHGDOMSVR)                        
                                                                                
Type choices, press Enter.                                                     

                                                                                
 Server name  . . . . . . . . . . > inotes01                                    
                                                                                
                                                                                
                                                                                
 Additional server ID:                                                          
   ID file's password . . . . . .   *NONE                                       
 Time zone  . . . . . . . . . . .   CST           *SAME, GMT, EST, CST, MST ... 
 Daylight savings time  . . . . .   *YES          *SAME, *YES, *NO              
 Web browsers . . . . . . . . . .   INOTES        Name, *SAME, *NONE, *ALL...   
                                                                                
 Internet mail packages . . . . .   *NONE         *SAME,*NONE,*ALL,*IMAP ...    
                + for more values                                               
 SMTP services  . . . . . . . . .   *SAME         *SAME, *DOMINO, *MSF          
 Directory services . . . . . . .   *NONE         *SAME, *NONE, *ALL, *LDAP...  
                                                                                
 News readers . . . . . . . . . .   *NONE         *SAME, *NONE, *NNTP           
                                                                        More... 
 F3=Exit   F4=Prompt   F5=Refresh   F10=Additional parameters   F12=Cancel      
 F13=How to use this display        F24=More keys                               
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3.2.4  Configuring the Cryptographic Coprocessor
In OS/400 V5R1, the configuration wizard allows you to perform all steps that are required to 
configure the 4758 PCI Cryptographic Coprocessor for iSeries for SSL use. To do this, 
perform the following steps:

1. From a Web browser, access the OS/400 HTTP administration server on the SSL port of 
2010, for example:

https://<my system name>:2010

You are then prompted for your OS/400 user ID and password.

Or go to the main Admin page to start a secure session by clicking the Start secure 
session button as shown in Figure 3-6.

Figure 3-6   4758 Cryptographic Coprocessor configuration page

2. Click Basic configuration wizard (Figure 3-7). This launches the configuration wizard.

Note: You should end the OS/400 HTTP server before you end the associated Domino 
server. In the event of an abnormal termination of the Domino server, you must end the 
associated OS/400 HTTP server before you attempt to restart the Domino server. 
Please refer to this Web site for more information: 
http://www.ibm.com/servers/eserver/iseries/domino/domhttp.htm

Note: For more information on enabling SSL for the Admin server, refer to Appendix C, 
“Enabling SSL for the ADMIN server instance” in the redbook IBM ~ iSeries 
Wired Network Security: OS/400 V5R1 DCM and Cryptographic Enhancements, 
SG24-6168.
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Figure 3-7   4758 Cryptographic Coprocessor basic configuration

3. The Welcome window is the first configuration window shown. It explains all the steps that 
the wizard guides you through (Figure 3-8). Click Continue.

Figure 3-8   4758 Cryptographic Coprocessor Welcome window

4. Select the Resource for which you want to create a new or additional device and click 
Continue (Figure 3-9). 
84 iNotes Web Access on iSeries Server



Figure 3-9   Allocate a device description

5. Enter the device description name and click Continue. In this case, we used the resource 
name CRP01, as shown in Figure 3-10.

Figure 3-10   Create device description to configure

6. Enter the name of the PKA file name and library that holds the PKA key store file 
(Figure 3-11).

Note: The device description will automatically be created.
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Figure 3-11   Create key store file

7. Depending on the number of IT people operating the Cryptographic Coprocessor, click 
Create Profile. Here we chose to create one profile (Figure 3-12).

Figure 3-12   Choose number of profiles to configure

8. Enter a pass phrase used to manage the device, for example: My dog’s name is Max 
(Figure 3-13). Make sure you store the pass phrase in a secure place.

Note: PKA key store files are used to store private keys, which are encrypted by the 
master key of the 4758 Cryptographic Coprocessor. Make sure the library already 
exists before you click Continue.
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Figure 3-13   Pass phrase

9. Set the unique Environment ID (EID) and click Continue. The EID operates like an iSeries 
system name (Figure 3-14).

Figure 3-14   Set environment identifier

10.Specify whether you want one person to take care of the master key parts or you want to 
divide the master key parts between three different people. In Figure 3-15, we chose one 
key part owner.
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Figure 3-15   Loading the master key

11.The Load all master key parts window shows all parts of the master key. After you write 
down the information, click Continue (Figure 3-16).

Figure 3-16   Load all master key parts

12.Verify the configuration information and then click Configure (Figure 3-17).

Note: Make sure to write down the master key for future reference and treat it as a 
security device that should not be compromised.
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Figure 3-17   Verify configuration information

13.Click OK to close the information message window. The wizard creates the profiles and 
sets configuration values (Figure 3-18).

Figure 3-18   Basic Cryptographic Coprocessor configuration complete

3.2.5  Configuring Digital Certificate Manager for SSL hardware cryptography
Using the 4758 Cryptographic Coprocessor for improving performance during SSL 
handshakes requires Digital Certificate Manager (DCM) to perform the necessary 
configuration of creating and assigning certificates applications. In this case, we used our 
OS/400 HTTP server instance for the Domino server.

The following steps guide you through the various DCM configuration steps that enable the 
4758 Cryptographic Coprocessor to perform parts of the SSL handshake:

1. Start the AS/400 Tasks page using a Web browser and entering the following URL:

http://<my system name>:2001

2. Click Digital Certificate Manager to start DCM.

Note: <my system name> represents your iSeries host name.
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3. From the navigation pane, click Select a certificate store.

4. Select *SYSTEM for the certificate store and then click Continue (Figure 3-19).

Figure 3-19   Select a Certificate Store

5. Enter the Certificate Store password and click Continue.

6. From the navigation pane on the left, click Create Certificate.

7. Select Server or client certificate and click Continue.

8. Select the type of Certificate Authority (CA) you are going to use, either Local or other, 
and click Continue. In our example here, we used Local as shown in Figure 3-20.

Figure 3-20   Select a Certificate Authority (CA)

Note: If you choose an Internet Certificate Authority, you have to import the signed 
certificate from the service provider.
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9. From the Select a Key Storage Location window, you choose where the private keys will 
be stored. To use the Cryptographic Coprocessor to perform SSL, you need to specify 
Hardware encrypted and click Continue (Figure 3-21).

Figure 3-21   Select a Key Storage Location

10.Select a Cryptographic Device Description that lets you specify which coprocessors will be 
used to generate the private key. In our example, we selected CRPO1. Click Continue 
(Figure 3-22).

Figure 3-22   Select a Cryptographic Device Description

Note: If you have multiple coprocessors installed in your system and they are grouped, 
you can specify any coprocessor in the group to create the private key.
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11.If you have multiple coprocessors, you can select to share the load between additional 
configured Cryptographic devices. Select CRP02 if more coprocessors are available, and 
click Continue (Figure 3-23).

Figure 3-23   Select Additional Cryptographic Device Descriptions

12.Fill out the certificate request data and click Continue (Figure 3-24).

Figure 3-24   Create Certificate
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13.Assign the new certificate to the OS/400 HTTP server that we are using for our Domino 
server. In Figure 3-25, we assigned the certificate to the OS/400 HTTP server. Click 
Continue.

Figure 3-25   Assigning a certificate to the application

This completes the configuration process of certificates in DCM that will be used by the 4758 
Cryptographic Coprocessor. For more information regarding configuring multiple 
coprocessors and updating certificates or updating devices, refer to Chapter 4, “Using 
hardware cryptography support for SSL/TLS,” in IBM ~ iSeries Wired Network 
Security: OS/400 V5R1 DCM and Cryptographic Enhancements, SG24-6168.

3.2.6  Verifying the cryptographic coprocessor
Once the certificate is assigned to the OS/400 HTTP server, you need to verify that the 
cryptography devices are active and assigned to your OS/400 HTTP server. To verify the 
devices, perform the following steps:

1. Restart your OS/400 HTTP server using the following OS/400 CL commands:

ENDTCPSVR SERVER(*HTTP) HTTPSVR(<my OS/400 HTTP server name>)
STRTCPSVR SERVER(*HTTP) HTTPSVR(<my OS/400 HTTP server name>)

2. To make sure the OS/400 HTTP server is running, enter the following OS/400 CL 
command:

WRKACTJOB SBS(QHTTPSVR) JOB(<my OS/400 HTTP server name>)

In Figure 3-26, our OS/400 HTTP server is named INOTES.
Chapter 3. Security 93



Figure 3-26   Work with Active Jobs display

3. Make sure that the SSL port is listening. From the command line (Figure 3-27), issue 
either of the following commands: 

WRKTCPSTS OPTION(*CNN)
NETSTAT OPTION(*CNN) 

Figure 3-27   Work with TCP/IP Connection Status display

4. Enter option 5 (Display details) next to https to confirm that SSL is bound to the same port 
that your Domino server is using (Figure 3-28).

                             Work with Active Jobs                     FROGGER 
                                                             12/04/01  14:31:49 
 CPU %:     .3     Elapsed time:   00:51:03     Active jobs:   192              
                                                                                
 Type options, press Enter.                                                     
   2=Change   3=Hold   4=End   5=Work with   6=Release   7=Display message      
   8=Work with spooled files   13=Disconnect ...                                
                                                                                
 Opt  Subsystem/Job  User        Type  CPU %  Function        Status            
        INOTES       QTMHHTTP    BCH      .0  PGM-QZHBHTTP     CNDW             
        INOTES       QTMHHTTP    BCI      .0  PGM-QZHBHJOB     TIMW             
        INOTES       QTMHHTTP    BCI      .0  PGM-QZHBHJOB     TIMW             
        INOTES       QTMHHTTP    BCI      .0  PGM-QZHBHJOB     TIMW             
        INOTES       QTMHHTTP    BCI      .0  PGM-QZHBHJOB     TIMW             
                                                                                
Parameters or command 
===>                                                                           
 F3=Exit   F5=Refresh       F7=Find      F10=Restart statistics                 
 F11=Display elapsed data   F12=Cancel   F23=More options   F24=More keys       

                       Work with TCP/IP Connection Status                       
                                                             System:   FROGGER  
 Type options, press Enter.                                                     
   3=Enable debug   4=End   5=Display details   6=Disable debug                 
   8=Display jobs                                                               
                                                                                
      Remote           Remote     Local                                         
 Opt  Address          Port       Port       Idle Time  State                   
      *                *          as-sign >  165:54:34  Listen                  
      *                *          www-http   000:17:59  Listen                  
      *                *          https      000:17:59  Listen                  
      *                *          1352       027:02:05  Listen                  
More... 
 F5=Refresh   F11=Display byte counts   F13=Sort by column                      
 F14=Display port numbers   F22=Display entire field   F24=More keys            
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Figure 3-28   Display TCP/IP Connection Status

5. Verify that the Cryptography Coprocessor devices are varied on and are associated with 
your OS/400 HTTP server application (Figure 3-29). To do this, enter the command:

WRKCFGSTS CFGTYPE(*DEV) CFGD(*CRP) 

Figure 3-29   Working with the status of cryptographic devices

                         Display TCP Connection Status                          
                                                             System:   FROGGER  
 Connection identification:                                                     
   Remote host name  . . . . . . . . . . . . . . :                              
     Remote internet address . . . . . . . . . . :     *                        
     Remote port . . . . . . . . . . . . . . . . :     *                        
   Local host name . . . . . . . . . . . . . . . :   INOTES01                   
     Local internet address  . . . . . . . . . . :     1.1.1.108                
     Local port  . . . . . . . . . . . . . . . . :     https                    
   Associated user profile . . . . . . . . . . . :   QTMHHTTP                   
 TCP programming interface information:                                         
   State . . . . . . . . . . . . . . . . . . . . :   Listen                     
   Connection open type  . . . . . . . . . . . . :   Passive                    
 Timing information:                                                            
   Idle time . . . . . . . . . . . . . . . . . . :   000:25:52.428              
     Last activity date/time . . . . . . . . . . :     12/04/01  14:22:39       
   Round-trip time . . . . . . . . . . . . . . . :   .000                       
   Round-trip variance . . . . . . . . . . . . . :   .075                       
                                                                                
                                                                        More... 
 Press Enter to continue.                                                       
 F3=Exit      F5=Refresh   F6=Print      F8=Display jobs   F9=Command line      
 F12=Cancel   F14=Display port numbers   F24=More keys                          

                         Work with Configuration Status                FROGGER 
                                                             12/04/01  14:59:58 
 Position to  . . . . .                Starting characters                      
                                                                                
 Type options, press Enter.                                                     
   1=Vary on   2=Vary off   5=Work with job   8=Work with description           
   9=Display mode status    13=Work with APPN status...                         
                                                                                
 Opt  Description       Status                -------------Job--------------    
      CRP01             ACTIVE                INOTES      QTMHHTTP    038367    
      CRP02             ACTIVE                INOTES      QTMHHTTP    038367    
                                                                                
                                                                                
Parameters or command                                                          
 ===>                                                                           
 F3=Exit   F4=Prompt   F12=Cancel   F23=More options   F24=More keys            
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3.3  Web single sign-on

Web single sign-on (SSO) allows a Web browser user to log on once to a Domino server and 
then access any other Domino servers in the same domain without logging in again. You can 
set up session-based authentication for multiple servers; this accomplishes single sign-on.

Users are challenged for username and password only once, even if they are redirected to 
different Domino servers in the same domain.

To enable single sign-on, perform the following steps:

1. Start the Domino Administrator client.

2. Click the Configuration tab.

3. You have to create a Web SSO configuration document. In the Actions menu bar, click the 
Web... option and then select Create Web SSO Configuration from the list (Figure 3-30).

Figure 3-30   Create Web SSO Configuration document

4. In the new Web SSO Configuration document, select Keys...-> Create Domino SSO Key 
from the pull-down menu (Figure 3-31).

Figure 3-31   Create Domino SSO Key

5. Specify the token expiration, in minutes, in the Expiration field.

6. In the Token Domain field, enter the DNS domain name, for example itso.ibm.com for 
which the tokens will be generated.

7. In the Server Names field, enter the name of the Domino servers that will be participating 
in the single sign-on environment.

8. Click Save and Close.

Attention: Web single sign-on (SSO) is not supported in the current release of DOLS. If 
SSO is enabled, users will not be able to synchronize any offline subscriptions.
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9. Now you have to edit your Domino server document. Locate your Domino server 
document, and click the Edit server button.

10.Click the Internet Protocols tab.

11.Click the Domino Web Engine subtab.

12.In the Session authentication field, specify Multi-server (Figure 3-32).

Figure 3-32   Session authentication field in the Domino server document

13.Click Save and Close.

14.Start or restart your Domino HTTP server.

15.While the Domino HTTP server is starting, you see the following message on the Domino 
console:

11/20/2001 03:13:52 PM HTTP: Successfully loaded Web SSO Configuration.

Here is an example of where you might use Web single sign-on: 

User A logs into the iNotes Web Access Domino server, where their welcome page 
includes the Sametime meeting center, on a different Domino server. They are prompted 
for their password once and are then authenticated to both servers.

3.4  Firewall considerations
When working with iNotes Web Access, you have two different scenarios when it comes to 
firewalls issues: 

� Online access to the mail database
� Offline access to the mail database

3.4.1  Online access
The considerations for accessing the mail database online are the same as for any other 
Domino Web application in your organization. The firewall administrator needs to open the 
HTTP port, which is generally port 80, or the HTTPS port if SSL is used, which is generally 
the 443 port.

If your users are going to access their mail files with other clients besides the Web browser 
(like POP3, IMAP, Notes, mobile devices), those other ports must also be opened. 

3.4.2  Offline access
When users access a database offline with iNotes Web Access, they must eventually 
synchronize their subscription with the Domino server. To do this, they use the Lotus iNotes 
Sync Manager. This software provides much of the functionality of the Notes client’s 
replicator page for Web browser users.
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The Lotus iNotes Sync Manager uses the NRPC port (usually port 1352) to communicate with 
the Domino server. This is the same for Notes clients to replicate or open databases on the 
Domino server.

3.4.3  Known issues with iNotes Web Access in a firewall environment
This section discusses some of the currently known issues pertaining to running iNotes Web 
Access in a firewall environment.

Notes.ini
The Tcpip_TCPIPADDRESS notes.ini parameter causes iNotes Web Access to send the 
local address in a URL redirection rather than the Domino server name. This can cause 
connection failures.

ActiveX
Given the recent propagation of viruses using malicious ActiveX code, some administrators 
have decided to restrict ActiveX controls at the firewall level.

iNotes Web Access uses ActiveX controls for the rich text fields when composing new 
documents, managing attachments, and performing offline installation. iNotes Web Access 
uses “signed” ActiveX to verify to the users that the code is originally from Lotus/IBM to 
ensure that these components can be trusted. However, in R5.0.8, if ActiveX controls are 
filtered at the firewall, these features will fail. In Domino R5.0.9 or newer, even though 
ActiveX controls are not allowed in the Web browser or firewall, HTML controls are used in 
place of ActiveX but with limited functionality.

One other possible workaround is to sign the ActiveX controls with an SSL certificate and give 
permissions on the user’s Web browsers to run controls with that certificate.

Internet Explorer 4.x
Internet Explorer 4.x SP2 does not support Domino Off-Line Services via a firewall. This is 
fixed in Internet Explorer 5.

3.5  Using LDAP for authentication
OS/400 provides a Lightweight Directory Access Protocol (LDAP) accessible directory server 
and the corresponding APIs that communicate with other LDAP directory servers. APIs are 
provided for both OS/400 and Windows applications written in Java, C, and C++. LDAP 
enabled applications, such as Internet mail clients, can access, update, and manage the 
iSeries directory.

Since OS/400 V4R3, LDAP has been included as a no-charge feature of OS/400 as part of 
the OS/400 Directory Services (option 32). The Directory Services includes an LDAP server 
and a complete set of LDAP clients and utilities.

The LDAP server uses DB2 UDB for iSeries to store the directory information and is 
configured using Operations Navigator.

Command line utilities are provided to access an LDAP server from Windows and OS/400. 
These utilities are compatible with LDAP utilities provided for other operating systems and 
allow you to search, add, modify, and delete directory information.
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You can use the LDAP services provided in OS/400 (or any other LDAP v3 compatible 
directory) to authenticate iNotes Web Access users. It is also possible to use any secondary 
Domino directory for this purpose.

An organization may want to set up Domino to allow authentication checking to secondary 
Domino or LDAP directories when they use an enterprise LDAP directory to verify client 
certificates, or when merging/migrating different mail systems or Domino domains.

Authentication using an LDAP or secondary Domino directory works like this (Figure 3-33): 

1. A user tries to authenticate to the Domino Directory.

2. The user is challenged with a name and password.

3. If an entry for the user is not found, then Directory Assistance is used, and the user is 
looked up in another directory, according to the rules established in the Directory 
Assistance database.

4. If the user is listed in the LDAP directory, and the password matches, they are 
authenticated, and control is passed to back to Domino where the ACL of the database is 
checked.

Figure 3-33   Using LDAP or a secondary directory for authentication

If an LDAP or secondary Domino directory is used, it is possible that some changes have to 
be done to the access control list of the mail database.

The administrator needs to add the full canonical x.500 username in the LDAP directory to 
the database ACL, in this format:

Cn=[common name]/Ou=[organizational unit name]/O=[organization name}/C=[two-character 
country code]

Note: To set up Domino to check additional directories for authentication, you set up the 
secondary Domino and LDAP directories as trusted domains in the Directory Assistance 
database. When you mark the domain as trusted, Domino searches the primary Domino 
Directory for the user and then searches the trusted secondary Domino and LDAP 
directories. When you set up Directory Assistance, you specify the order in which Domino 
searches the secondary directories.

LDAP/Secondary

Domino
HTTP server

1. Request is made to
the Domino server.

2. User is challenged with
a name and password.

4. If the user is listed in the
LDAP directory, and the
password matches, they are
authenticated, and control is
passed to Domino again.

3. User is looked up on the
Domino Directory. If not there,
Directory Assistance rules are
observed.
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3.5.1  Configuring Directory Assistance
Before you can enable authentication using an LDAP server, you have to create a Directory 
Assistance database or use an already existing one. Follow these steps to find out if a 
Directory Assistance database has already been created on your Domino server. You can 
also use these same steps to create a new Directory Assistance database and then update it:

1. From a Lotus Notes client, select from the pull-down menu File-> Database-> Open or 
press Ctrl-O.

2. On the Open Database window, enter the Domino server name. You then see a list of 
databases on that Domino server. If you see Directory Assistance in the list, the database 
has been created. Open this database and proceed with step 3. Otherwise, if the database 
does not exist, perform the following steps:

a. Create a new database by selecting, from the pull-down menu, File-> Database-> 
New or press Ctrl-N. Type the Domino server name, the title of the database, and the 
database name. We recommend that you name the database file DA.nsf.

b. Click the Template Server button, and specify the Domino server name in the 
Template Servers pop-up window.

c. Select Directory Assistance from the list (Figure 3-34).

Figure 3-34   Creating a new Directory Assistance database

d. Make sure you select the Inherit future design changes check box.

e. Click OK to create the Directory Assistance database.

3. You see the main view of the Directory Assistance database. Click the Add Directory 
Assistance button (Figure 3-35).

Figure 3-35   Adding a Directory Assistance document

4. A new Directory Assistance document opens and is positioned at the Basics tab. 
Complete the fields shown in Table 3-4.
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Table 3-4   Fields to complete in the Basics tab of the Directory Assistance document

Figure 3-36 shows an example of how the Basics tab in the Directory Assistance document 
should appear.

Figure 3-36   Basics tab of the Directory Assistance document

5. Click the Rules tab, and complete the fields listed in Table 3-5 for each rule you want to 
create.

Table 3-5   Fields to complete in the Rules tab of the Directory Assistance document

Figure 3-37 shows an example of how the Rules tab in the Directory Assistance document 
should appear.

Field Value

Domain Type Choose LDAP.

Domain Name A descriptive name that you choose.

Company Name The name of the company associated with this directory. Multiple Directory 
Assistance documents can use the same company name.

Search Order A number representing the order in which this directory is searched, relative 
to other directories in the Directory Assistance database. If this is the first 
document in your Directory Assistance database, type 1 in this field.

Enabled Choose Yes to enable Directory Assistance for this directory.

Field Value

Rule # Enter one or more naming rules to indicate the names in the directory 
that can be authenticated.

Enabled Choose Yes to enable the rule you defined above.

Trusted for credentials Choose Yes so that the Web user can authenticate.
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Figure 3-37   Rules tab of the Directory Assistance document

6. Click the LDAP tab and complete the fields shown in Table 3-6.

Table 3-6   Fields to complete in the LDAP tab of the Directory Assistance document

Field Value

Hostname The host name or IP address of your LDAP 
directory server.

Optional Authentication Credential A distinguished name in the Username field and 
a Password. Enter the distinguished name in 
LDAP format, for example: cn=LDUSER1.

The name and password must correspond to a 
valid name and password on the LDAP server.

If you do not enter a name and password, the 
Domino server attempts to connect to the LDAP 
directory server anonymously.

Base DN for search A search base, if the LDAP directory server 
requires one. For example:
ou=itso rochester center, o=IBM, c=US

Perform LDAP search for Choose Notes Clients/Web Authentication.

Channel encryption We strongly recommended that you choose SSL.

Port The port number you use to connect to the LDAP
directory server.

If you choose SSL in the Channel encryption 
field, the default port is 636.

If you choose None in the Channel encryption 
field, the default port is 389.

If the LDAP directory server does not use one of 
these default ports, enter the port number.

Timeout The maximum number of seconds allowed for a 
search of the LDAP directory. The default is 60 
seconds. If the LDAP directory server has a 
timeout setting, the lower value takes 
precedence.
102 iNotes Web Access on iSeries Server



7. Click Save and Close. You see a document has been created in your Directory 
Assistance database.

8. Go to the Domino Administrator client and verify that it is connected to your Domino 
server.

9. Click the Configuration tab, and select the All Server Documents view. Locate your 
Domino server.

10.Click Actions -> Set Directory Assistance Information from the pull-down menu.

11.Type DA.nsf (or the name of your Directory Assistance database) here.

12.Click OK.

13.Restart the Domino server for this change to take effect.

3.5.2  Verifying the connection from Domino to the LDAP server
Perform the following steps to verify the connection from your Domino server to the LDAP 
server:

1. Go to your Lotus Notes client and open your Local address book.

2. Select the pull-down menu option Create -> Account. You see a new window.

3. Specify the fields shown in Table 3-7.

Table 3-7   Fields for creating an account document

4. Click Save and Close.

5. From a Lotus Notes client, open your mail database.

Maximum number of entries returned The maximum number of names that the LDAP 
directory server returns for the name searched. 
The default is 100. If the LDAP directory server 
has a maximum setting, the lower value takes 
precedence. If the server’s maximum timeout is 
exceeded, it only returns the number of names 
found to that point.

Tip: If your Domino server fails to bind or connect to the LDAP server, try to change the 
LDAP server host name to its IP address.

Field Value

Tab Field Value

Basics Account name A descriptive name.

Account server name The DNS server name or IP address of 
your LDAP server.

Protocol LDAP

Protocol Configuration Search base The base of the directory tree from 
which to start a search, for example:
ou=itso rochester center, o=IBM, 
c=US

Advanced Port number The port to connect to your LDAP 
server. Default is 389.

Note: You can leave the other fields with their default values.
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6. Create a new memo.

7. Click the Address... button.

8. Select the Account name (the one that you just created) from the list.

9. Type a person name that is listed in the LDAP directory, and click Search. If the 
connection to the LDAP server is established, you will see a result (Figure 3-38).

Figure 3-38   Searching for a person in an LDAP directory

10.You may continue with sending an e-mail, or click Cancel to end the test.

3.5.3  Enabling authentication to a mail database for an LDAP user
To enable authentication to a mail database for an LDAP user, you must first create a Person 
document for the user in the Domino Directory and then create a mail database for this LDAP 
user.

Creating a Person document for an LDAP user
Perform the following steps to create a Person document for an LDAP user in the Domino 
Directory:

1. Create a Person document in the Domino Directory that represents the LDAP user.

2. In the Person document, specify a first and last name.

3. Specify the user name. This has to be in the format as defined in your LDAP server, for 
example: 

LDAP USER2/ITSO Rochester Center/IBM/US

4. Specify the short name. The value you enter in this field should match the common name 
defined for this person in the LDAP directory entry.

5. Click the Mail tab.

6. Select Notes as the mail system.

7. Type the name of your Domino mail server.

8. Type the mail file name for the LDAP user that you are registering in the Domino 
Directory. Write down this file name since you will use it later.

9. Click Save and Close.

At this point, you have created a Person document for the LDAP user. Continue with the next 
section to create a mail database for the LDAP user and set the ACL.
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Creating a mail database for an LDAP user
Perform the following steps to create a mail database for an LDAP user:

1. Create a mail database using the iNotes5 template (iNotes5.ntf) on your Domino server by 
using these steps:

a. From your Lotus Notes client, select the File pull-down menu and select Database -> 
New or press Ctrl-N.

b. From the New Database window, type or select the Domino server name.

c. Type the title and filename of the database you are creating. The filename is the one 
you specified when you created the Person document in the previous section. See 
Figure 3-39.

d. Click the Template Server button, and specify your Domino server name.

e. Select iNotes Mail and C&S from the list.

f. Make sure you select the Inherit future design changes check box.

g. Click OK to create the database.

Figure 3-39   Creating a mail database for an LDAP user

2. Locate the LDAP user mail database icon on your workstation and right-click it.

3. Select Database and then Access Control.

4. Click the Add button. Here, you do not select the person from the list. Instead, you type 
the distinguished name of the LDAP user as defined in the LDAP directory, for example:

cn=LDAP USER2/ou=ITSO Rochester Center/o=IBM/c=US

5. Click OK.

6. Select Person for the user type.

7. Select Manager for access.

8. Verify that the Delete documents option is selected. See Figure 3-40.
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Figure 3-40   Adding an LDAP user to the mail database ACL

9. Click OK.

3.5.4  DOLS-enabling an LDAP user’s mail database

Creating certifier ID files for LDAP organization and organizational unit
If the organization name where the LDAP users belong to is not the same as the organization 
name of your Domino server, you have to register it on your Domino server and cross certify 
with your Domino server’s certifier ID. We use ITSO Rochester Center/IBM/US as an example 
for creating the new certifier ID files. Perform the following steps:

1. Start your Domino Administrator client and connect to your Domino server.

2. Click the Configuration tab.

3. On the right most panel of the window, click Tools -> Registration, and select 
Organization... from the list (Figure 3-41).

Figure 3-41   Registering a new organization

4. On the Register Organization Certifier window, make sure the Registration server points 
to your Domino iNotes Web Access server.

Important: To perform the tasks described in this section, your Domino server certifier ID 
file must be available.
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5. Complete the fields as shown in Figure 3-42. Even though the country code is optional, it 
is normally good practice to put the country code here, for example US.

Figure 3-42   Completing the fields in the Register Organization Certifier window

6. Set the password quality scale to at least 8.

7. Click the Set ID File button to specify the name and location of the certifier ID file for your 
LDAP organization.

8. Click Register.

9. You see a message saying that the ID has been created. Click OK.

10.After you register the organization, register the organizational unit, which is ITSO 
Rochester Center in this case. Again from your Domino Administrator client, 
Configuration tab, click Tools -> Registration, and select Organizational Unit... from 
the list.

11.On the password prompt window, click Cancel.

12.From the Choose Certifier ID window (Figure 3-43), specify the certifier ID file that you just 
created, which is IBMcert.id in our example. 

Figure 3-43   Choosing a certifier ID file

13.Type the password and click OK.

14.Click Yes or No (depending on your customer policy) on the next pop-up window.
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15.Complete the fields as you did for Organization. See Figure 3-44.

Figure 3-44   Registering an LDAP organizational unit

16.Click Register.

Cross-certifying the LDAP certifier ID files
You now have to cross-certify the ITSOcert.id file that we just created. You need to do this so 
that the LDAP user can access the Domino server from the local DOLS environment.

1. From the right panel of your Domino Administrator client, click Certification-> Cross 
Certify...

2. Specify your Domino sever certifier ID file (usually cert.id) in the Choose Certifier ID 
window.

3. Type the password and click OK.

4. In the Choose ID to be Cross-Certified window, specify your LDAP organizational unit 
certifier ID file. In our example, this is ITSOcert.id.

5. On the Issue Cross Certificate window (Figure 3-45), verify that the Certifier and Server 
fields point to your Domino server.

6. Select your LDAP organizational unit in the Subject name field.

Attention: Make sure that your LDAP organization, not your Domino server organization, 
is listed next to the Certifier ID button.
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Figure 3-45   Cross-certifying an LDAP organizational unit

7. Click Cross Certify.

8. Click No on the pop-up window that is displayed since you are not going to cross-certify 
another ID file.

9. From the left panel of your Domino Administrator client, select the Miscellaneous-> 
Certificates view. Verify that the information under the Notes Cross Certificates twistie is 
correct (Figure 3-46).

Figure 3-46   Verifying cross certificates

Creating a security policy for LDAP users
LDAP users do not have a Notes ID file created for them on the Domino server. If they want to 
go offline, they must have an ID file that they will use locally. You may already have a DOLS 
security policy document created for regular Notes users, that specifies Prompt for ID file in 
the ID deployment policy field. For LDAP users, you need to create another security policy 
document that specifies that the ID files are to be generated automatically. To do this, 
perform the following these steps:

1. From the Lotus Notes client, open your Offline Services (doladmin.nsf) database.

2. Click New Security Policy.
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3. Type your LDAP security domain, for example /ITSO Rochester Center/IBM/US. Do not 
forget the leading forward slash.

4. Select Automatically generate user IDs in the ID Deployment Policy field.

5. Click the Automatic tab.

6. Attach the certifier ID file for your LDAP organization unit (the one that has been 
cross-certified by your Domino certifier ID). In our example, this was ITSOcert.id.

7. Specify the password and set the expiration date.

8. Press Esc and click Yes to save and close the document.

Figure 3-47 shows an example of a Domino Off-Line Services database that has security 
policy documents for regular Notes and LDAP users.

Figure 3-47   DOLS Security policy documents for Notes and LDAP users

3.5.5  Synchronizing LDAP and Domino directories
Most of the time, Directory Assistance is enough to perform the authentication process. 
However, in some organizations, it is necessary to have a tighter integration between the 
enterprise LDAP directory and the Domino Directory. In these circumstances, it could be 
necessary to synchronize between the entries in the LDAP directory and the documents in 
the Domino Directory, either in one direction or bidirectionally. 

This functionality is not native to Domino, but there is a tool available called LDAPSync to 
perform these operations. This tool was developed by Lotus Professional Services. The 
LDAPSync toolkit can provide a solution for consolidating different directory sources, as well 
as mapping different Domino directories to a single database. This solution is highly 
customizable and is standards-based.

Note: The password is not encrypted, so make sure that you properly set the ACL of 
the doladmin.nsf database.
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LDAPSync can work in different ways:

� Different source databases or directories to a single destination (summarization)
� A single source database or directory to different destination databases (broadcast)
� A single source document or entry to different destination documents or entries 

(consistency)

LDAPSync toolkit components
There are three key components in the LDAPSync toolkit:

� LDAPSync: Synchronizes directory entries between LDAP directories and Domino 
directories exchanged via the use of an LDIF file.

� SynchroNSF: Used for unidirectional replication between two Domino databases that do 
not share the same replica ID or design. SynchroNSF operates just like the Domino 
replicator, but without the constraint of the source and destination databases being 
replicas.

� RunAgent: Used for submitting an agent within a Domino database via a batch file. 
RunAgent lets organizations run an agent during the synchronization process instead of at 
an specific time via a schedule.

How it works
The process works as outlined here (Figure 3-48):

1. Once LDAPSync is activated, the transactions (additions, LDAP directory or the Domino 
databases) are downloaded and queued on a Domino database.

2. An agent is then triggered using a batch file to enable those transactions to be passed to 
another database.

3. The third component of the LDAPSync, SynchroNSF, then passes the transactions to the 
target Domino database.

Figure 3-48   LDAPSync processing

LDAPSync can be acquired from your Lotus Professional Services representative.

Note: This tool is not available for iSeries. It must be installed on a Window NT4 or higher 
server, but it can pull and push entries to any standard LDAP directory service, including 
the iSeries.
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Chapter 4. Enhancing iNotes Web Access

This chapter discusses how you can enhance iNotes Web Access. For example, you can 
customize the template design or use a Web Mail redirection tool to provide a common log on 
screen. Or you can create a light-weight directory subscription for offline users and integration 
with an awareness product such as the Lotus Sametime server to enhance collaboration.

This chapter covers the following topics:

� Customizing the Welcome page
� Customizing the iNotes Web Access mail template
� Providing a single URL with the Web Mail Redirect tool – a single sign-on URL for all users
� Enabling directory and address lookup for offline users
� Enabling other applications to be used offline
� Integration with Sametime 2.5 to enable instant messaging by adding chat capabilities to 

online users

4
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4.1  Customizing the Welcome page
You can customize the initial Welcome page for your users on a per-user level, group level, or 
even an organization-wide level. To deploy customized Welcome pages for groups or 
subgroups, each server will maintain a single uniquely customized Welcome page. The user 
can change this Welcome page later to fit their own requirements. 

For more information about customizing the Welcome page, refer to the redbook iNotes Web 
Access Deployment and Administration, SG24-6518.

4.2  Customizing the iNotes Web Access mail template
Some areas of iNotes Web Access were not designed in the Domino Designer. A lot of 
complex Java Script is coded in iNotes Web Access to provide the Web interface. Several 
elements, such as image resources, frames, comments, and meaningful text strings, are 
separated from each database itself and kept in the shared the forms5.nsf database. This 
helps to minimize the amount of code that needs to be passed to the client and increases the 
database cache hit for HTTP usage on the Domino server.

Therefore, it is possible that customizing these elements may produce unpredictable results 
instead of adding more functionality. Lotus recommends that customers do not attempt to 
customize the iNotes Web Access template until the proper guidelines are made available by 
Lotus or through the Lotus Professional Services organization.

The Customization Disclaimer from the Lotus Knowledge Base, Document #186361 - What is 
the Support Policy for Customization of the iNotes Web Access Mail template? informs users 
that customized templates are not certified or supported by Lotus. Therefore, Lotus Notes 
Support may refer you back to the stock template to troubleshoot any problems. If the problem 
is not in the stock template, you may have to remove the added function from the template 
and submit an enhancement request for it in the next release. You can find this document in 
the Lotus Knowledge Base, which is part of the Lotus Support Web. Simply go to the site at 
http://www.lotus.com/home.nsf/welcome/support and type 183631 in the keyword search 
box.

The disclaimer also includes customization of the forms5.nsf database as well, which keeps 
most of the design and interface elements of iNotes Web Access.

Nonetheless, customization in iNotes Web Access is not an “impossible” thing to do. Some 
customization can be done and should not affect the functionality of iNotes Web Access.

Attention: Any customization in iNotes Web Access Release 1.0 templates as provided in 
Lotus Domino server R5.0.8 or R5.0.9, including what is shown in this section, is not 
officially supported by Lotus or IBM. The customization that you do here may be replaced 
by the iNotes Web Access development toolkit in future releases.
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4.2.1  Customizing the Notes client part in iNotes Web Access
Most companies customize the standard R5 Notes mail template for their own use. The 
iNotes Web Access mail template also supports access from the Notes client. You can copy 
the customized forms, frames, and views that are used in your customized R5 Notes mail 
template into the iNotes Web Access mail template that affects only the Notes client. But you 
must use caution and only copy and paste the existing design elements using Domino 
Designer. Keep in mind that there are new fields and forms in the iNotes Web Access 
template that may have used similar names to your customized design elements.

4.2.2  Customizing the access control list
By default, the iNotes Web Access mail template has the Maximum Internet name & 
password field in the Advanced option of the access control list (ACL) set to Editor. This is not 
a sufficient access level for the user to change their own Internet Password or to enable the 
Out of Office agent.

You may customize the iNotes5.ntf template and set the ACL properly before you register a 
new person or convert existing users’ mail database templates. Refer to “Assigning Internet 
passwords for each iNotes Web Access user” on page 31.

4.2.3  Disabling the Go Offline icon
If you plan to deploy online access only to the end user, you may want to remove the Go 
Offline icon from the menu of iNotes Web Access. Even if you do not enable DOLS and do not 
configure an offline security policy, the Go Offline icon is still available but not functional. This 
may confuse the end user (Figure 4-1). 

Figure 4-1   Default menu available to iNotes Web Access users

Most of the user interface of iNotes Web Access is defined by skins. These skins are kept in a 
separate database (INOTES/forms5.nsf) in the Domino server’s data directory and are 
shared among users. Modification to this database affects all iNotes Web Access users on 
that Domino server.

To disable the Go Offline icon, perform the following steps:

1. Back up the default forms5.nsf database, or copy it to another filename. In case something 
goes wrong or when you want to enable the Go Offline icon later, you can restore this file 
back to its original version. To copy this database to another file without the Backup and 
Recovery Media Services for Domino online backup feature, you need to stop the Domino 
server before you can access this file. You may use OS/400 Copy (CPY) CL command, 
Operations Navigator, or NetServer to map a drive to the OS/400 Integrated File System 
(IFS) from a PC.

Your Copy CL command may look like the following example:

CPY OBJ('/lotus/domino/inotes01/INOTES/forms5.nsf') 
TOOBJ('/lotus/domino/inotes01/INOTES/forms5.nsf.backup') 

2. By default, you do not have enough authority to change the design of the forms5.nsf 
database. You may either FTP or copy this file to work locally or use NetServer to map a 
drive to your PC and modify the ACL of this database as if it was on Local. We show you 
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one of these methods using the Operations Navigator to drag and drop the file to work 
from a local directory.

3. Launch Operations Navigator and log on with QSECOFR or similar user.

4. Expand your iSeries server on the left pane and browse to File Systems-> Integrated 
File System-> Root-> Your iNotes Web Access Domino server data directory-> 
INOTES as shown in Figure 4-2. Then drag the forms5.nsf file and drop it to your PC 
location such as Desktop or C:\Lotus\Notes\Data directory on another Windows Explorer.

Figure 4-2   Using Operations Navigator to copy Forms5.nsf to a local directory

5. Launch the Domino Designer client, and open the forms5.nsf database you just copied.

6. Expand the database on the left pane to Resources -> Subforms, and browse for the 
ShimmerOffline_SkinComponent subform as shown in Figure 4-3.

Important: After you copy or FTP the forms5.nsf file back to the Domino server or if you 
change the ACL, the OS/400 object authority of forms5.nsf is also changed. You have 
to change the authority of this file back to be owned by the QNOTES user profile only. If 
you map a PC drive to the iSeries server and change the ACL, we recommend that you 
change it back after you finish the customization.
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Figure 4-3   Browsing for ShimmerOffline_SkinComponent subform

7. Double-click the ShimmerOffline_SkinComponent subform to open and edit this 
subform. The content of this subform looks similar to the example in Figure 4-4.

Figure 4-4   ShimmerOffline_SkinComponent subform in Forms5.nsf database

8. This form calls a JavaScript code to show the Go Offline interface of the Offline menu. You 
may delete all of its contents or put a remark on the entire file. We recommend that you 
use the remark and accompany it with some comments for reference when you or 
someone else come back and modify this later. The modified subform may look like the 
example in Figure 4-5.
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Figure 4-5   Modified ShimmerOffline_SkinComponent subform

9. Click Save and close.

10.Put the file back in the original location on the Domino server. Again, you may use FTP or 
Operations Navigator to do this. The example shown in Figure 4-6 uses Windows Explorer 
to drag and drop file into the data directory of the Domino server in Operations Navigator.
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Figure 4-6   Dragging, dropping file from Windows Explorer to Domino data directory under INOTES

11.Check the permission of the file. This file must be owned by the QNOTES user profile. You 
can use the following Change Owner (CHGOWN) CL command to change the permission:

CHGOWN OBJ('/lotus/domino/inotes01/INOTES/forms5.nsf') NEWOWN(QNOTES)

To change the owner to QNOTES using Operations Navigator, right-click the forms5.nsf 
file in Operations Navigator and select Permissions. The permissions window appears as 
shown in Figure 4-7.
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Figure 4-7   Changing file permission to QNOTES in Operations Navigator

12.Click the Owner icon and browse for user QNOTES. Click OK (Figure 4-8).

Figure 4-8   Selecting QNOTES as the new object owner

13.Restart the Domino server.

14.Log on to iNotes Web Access online again and check the new result. Notice that there is 
now no Go Offline icon in the upper right corner (Figure 4-9).
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Figure 4-9   iNotes Web Access interface with no Go Offline icon in the menu bar

4.2.4  Other iNotes Web Access customizations
There are other customization examples, such as creating your own company logo, changing 
the order of table of contents, and disabling the Welcome page in iNotes Web Access. These 
types of customizations, among others, are discussed in iNotes Web Access Deployment and 
Administration, SG24-6518.

4.3  Providing a single URL with the Web Mail Redirect tool
Normally users have to specify the URL of their mail databases to access their mail files. This 
is quite inconvenient and difficult to remember for users especially if your design includes 
having a multi-level of subdirectories to divide users by department or organization unit. Here 
are some examples of URLs that users may have to type to access their mail files:

http://inotes.mycompany.com/mail/Servers/Hardware/iSeries/Nattapong.nsf
http://inotes.mycompany.com/mail/Services/Software/Lotus/Gerardo.nsf
http://inotes.mycompany.com/mail/Executives/LouGerstner.nsf

In addition, by default, accessing a mail file by specifying only the mail database in the URL 
leads to the Welcome page. In a case where you would want to specify another interface, 
such as the first page being the Inbox for the user, it is even more difficult to remember (see 
Table 2-6 on page 45). For example, to specify the Inbox as the first interface for the user 
instead of Welcome page, you have to specify the URL:

http://inotes.mycompany.com/mail/Servers/Hardware/iSeries/Nattapong.nsf/inotes/
mail/?OpenDocument&ui=inotes

Note: After upgrading or reinstalling the Domino server code, the forms5.nsf database will 
be replaced, and your customization will be lost. Make a copy of the changed forms5.nsf 
database before you upgrade the Domino server, and copy your customized elements 
back after the upgrade/installation.
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Another benefit of using the Web Mail redirection tool is when sometimes users access their 
mail file using iNotes Web Access on Internet Explorer, while sometimes they have to use 
Netscape to access their other mail files. In this case, you can also modify the Web Mail 
redirect to detect an unsupported Web browser or redirect to the correct URL for the WebMail 
user interface instead of the iNotes Web Access user interface.

There are several examples and freewares of Web Mail redirection tools available for 
download. Some of them use an agent or a Java Servlet to redirect. From a performance 
point of view, the general recommendation is to avoid using the agent version because it 
tends to consume more resource on the server and gives worse response time than the 
servlet version.

This redbook shows you one of the most efficient yet simple Web Mail redirect tools available. 
It is based on the Notes formula language to retrieve the user information and mail directory 
from the Domino Directory and provides a single sign-on URL interface to all users. There are 
easy forms available that allow you to set your server parameters, messages, icons, company 
logo, etc.

The Web Mail Redirect tool is available for download from the Notes.net Iris Sandbox Web 
site at: http://www.notes.net/sandbox.nsf

You can use it to enable Web browser redirection to an authenticated user’s mail file. This 
database can become an option for customers who want to give end users easy access to 
their mail files without having to type a long URL.

At the time this redbook was written, the versions available for public use were v2.61 and 
v3.00 BETA 2.

4.3.1  Downloading and configuring the Web Mail Redirect database
Perform the following steps to set up the Web Mail Redirect tool:

1. Download the zipped database file, for example webmail261.zip, from the Notes.net Iris 
Sandbox Web site (http://www.notes.net/sandbox.nsf).

2. Extract the zipped file to the webmailredirect.nsf database.

3. Transfer this database to your Domino iNotes Web Access server data directory. You may 
use FTP. Or you may choose Operations Navigator, in which case you drag the file from 
Windows Explorer and drop it in the Domino server’s data directory under File Systems-> 
Integrated File System-> Root.

4. Make sure that you change the ownership of this database to the QNOTES user profile. 
Start your Lotus Notes client and open this database. The welcome page of the Web Mail 
Redirect tool appears as shown in Figure 4-10.

Important: The software is provided “AS IS”. Therefore there is no support or technical 
assistance with respect to using the software. Read the download and software 
agreements completely before you implement this software.
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Figure 4-10   Web Mail Redirect welcome page

5. Click Change Configuration.

6. A configuration panel with several tabs appears (Figure 4-11) that allows you to change 
the configuration to match your environment. Our focus is on the URL Redirection and 
Redirect Screen tabs.

Figure 4-11   Web Mail Redirect configuration display: URL Redirection tab

7. Depending on your environment, you need to select Fixed, Dynamic, or Mail Server for the 
host name to redirect to. Click the twistie Click Here for More Information for a full 
description of each option.

8. Specify whether you want to force the use of SSL when redirecting onwards. If you specify 
Yes, make sure that you also set up and enable SSL on the Domino server.
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9. Click the Redirect Screen tab.

10.Specify the time, in seconds, before the user is redirected (Figure 4-12). You can also 
change the message that the user sees on the Web browser while they are being 
redirected to their mail file.

Figure 4-12   Web Mail Redirect configuration screen: Redirect Screen tab

11.Click Save and Close.

4.3.2  Configuring Web Mail Redirect as the default home page
After you finish configuring your Web Mail Redirect database, the next step is to specify this 
database as the default home page of your Web site in the Domino Directory. Perform the 
following steps:

1. Start the Domino Administrator client and login with the Administrator ID and password.

2. Make sure that you are connected to your Domino iNotes Web Access server.

3. Click the Configuration tab.

4. Locate your Domino server, and click the Edit Server button.

5. Click the Internet Protocols tab and then HTTP tab.

6. Under Mapping, in the Home URL field, type:

/webmailredirect.nsf?Open 

See Figure 4-13.

Figure 4-13   Specifying the Web Mail Redirect database in the Domino server document

7. Click Save and Close.
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4.3.3  Testing the Web Mail Redirect tool
Perform the following the steps to test the Web Mail Redirect tool:

1. Open your Web browser.

2. Type the URL to your Domino iNotes Web Access server, without specifying any mail 
database file name, for example:

http://inotesml01.rchland.ibm.com

The Web Mail Redirect log in screen should appear.

3. Type your Domino user name and password and click the login button.

4. As shown in Figure 4-14, a message on your Web browser tells you that your request is 
being redirected. The message that appears on the Web browser depends on what you 
specified in the Web Mail Redirect database (webmaildirect.nsf).

Figure 4-14   Testing Web Mail Redirect tool

5. Notice that the URL on your Web browser changes to your mail database file name and 
you are now redirected to your iNotes Web Access.

4.4  Enabling directory and address lookup for offline users
By default, the Domino Directory is not available to iNotes for Web Access offline users. While 
a user is working offline, they have no access to the Domino Directory. Therefore, they cannot 
perform a lookup for people other than what is in their personal contacts and groups.

To enable users to take the Domino server’s Directory offline with their mail files, the 
$DOLSDirectoryCatalog parameter in the Domino server’s notes.ini file must be set to the 
name of the Domino Directory (names.nsf) or Directory Catalog database for offline usage 
(relative to the data directory). If this parameter does not exist in the notes.ini file, users will 
not have the option to take a Domino Directory or Directory Catalog offline with their mail files.
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Even though you can set up and use the Domino Directory (names.nsf) for offline users, we 
recommend that you create and use a Directory Catalog instead. In Domino R5, the Directory 
Catalog is a lighter version of the Domino Directory that contains enough information for 
name lookup. It is much smaller than the Domino Directory and can have a compression ratio 
of 255 to 1, which is very important when replicating to mobile users. The server task reads 
multiple directories, extracts essential information from each entry (such as Person 
documents), and aggregates it into a single, smaller Directory Catalog database. The result is 
that synchronization is faster for offline users.

4.4.1  Creating a Directory Catalog
A Directory Catalog consolidates the most frequently requested directory information from 
one or more Domino directories into a single, lightweight, quick-access database. To create a 
Directory Catalog database, perform the following steps:

1. Launch the Domino Administrator client and create a new database by selecting the File 
pull-down menu and selecting File-> Database-> New or pressing Ctrl-N. Type the 
Domino server name, the title of the database, and the file name, such as 
OfflineCatalog.nsf, for example.

2. Click the Template Server button, and specify the Domino server name in the pop-up 
window.

3. Select Directory Catalog from the list.

4. Make sure you select the Inherit future design changes check box (Figure 4-15).

5. Click OK to create the database.

Figure 4-15   Creating a Directory Catalog database

6. A pop-up window appears asking if you want to create a full-text index for this database. If 
you plan to use this Directory Catalog for offline only, you do not need to create a full-text 
index on the server. After this database is replicated to the client, it creates the full-text 

Important: You must enable offline users to the Domino Directory or Directory Catalog 
before a user installs the offline usage and the subscription of his iNotes Web Access mail 
database. Otherwise, that user must remove and reinstall the subscription again to have 
the offline directory.
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index on the client for faster name lookup. If you do not want to create the full-text on the 
server, click No (Figure 4-16).

Figure 4-16   Question to create full-text index

7. You are now in the blank Directory Catalog database. From the pull-down menu, select 
Create-> Configuration.

8. Some of the fields in this new document are already populated (Figure 4-17). Specify the 
names of the Directory database such as names.nsf. If you also have secondary directory 
databases, you can specify them here as well.

Figure 4-17   Directory Catalog Configuration document

9. Click Save and Close to save the document.

10.You have to enable the Directory Cataloger in the Domino server document. To do so, 
select the Configuration tab and select the All Server Documents view.

11.Locate the server document of your Domino server and double-click it or click the Edit 
Server button.

12.Select the Server Tasks tab and then the Directory Cataloger tab (Figure 4-18).
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Figure 4-18   Enabling the Directory Cataloger task

13.Type the name of your Directory Catalog database, for example OfflineCatalog.nsf.

14.Select Enabled in the Schedule field. You can change the frequency at which you want to 
run the Directory Cataloger by changing the other three fields already populated by default 
values.

15.Click Save and Close.

16.Go to your Domino server console.

17.Type the command load DIRCAT on the Domino server console command line. This 
command runs the Dircat task to initially populate the Directory Catalog database that you 
just created.

18.Verify that the Directory Catalog task is running by typing the command show tasks in the 
Domino server console command line. You see the status of the Directory Cataloger is 
Idle (Figure 4-19).

Figure 4-19   Show tasks in the Domino server console: Directory Cataloger task

 Work with Domino Console                              
                                                               Server: INOTESXX 
 Previous subcommands and messages:                                             
    Database Server      Server for Notes Administrator/Inotes on TCPIP         
    Directory Cataloger  Idle                                                   
    HTTP Web Server      Listening on port(s) 80                                
    Event Monitor        Idle                                                   
    Calendar Connector   Idle                                                   
    Schedule Manager     Idle                                                   
    Admin Process        Idle                                                   
    Agent Manager        Executive '1': Idle                                    
    Agent Manager        Idle                                                   
    Stats                Idle                                                   
    Indexer              Idle                                                   
    Router               Idle                                                   
    Replicator           Idle                                                   
                                                                                
                                                                                
 Enter a Domino subcommand.                                                     
 ===>                                                                           
 F3=Exit   F5=Refresh   F6=Print   F9=Retrieve                                  
 F17=Top   F18=Bottom   F21=Command line 
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19.Go back to your Lotus Notes client workspace. Open the Directory Catalog database and 
select User from the left navigator. You see a list of users from both the primary and 
secondary directory databases as shown in Figure 4-20.

Figure 4-20   Users view in the newly created Directory Catalog database

4.4.2  Changing notes.ini
To take your Directory Catalog offline, you need to add the keyword $DOLSDirectoryCatalog 
to the notes.ini file of your Domino server. There are several ways to edit the Domino server’s 
notes.ini file on the iSeries server:

� Transfer this file to a PC, edit it with a PC editor, and then send it back to the iSeries server
� Use the 5250 CL command Edit File (EDTF)
� Use Operations Navigator
� Use the Domino server console set configuration command 

For details on editing the Domino server’s notes.ini file on the iSeries server, refer to the 
redbook Lotus Domino for AS/400 R5: Implementation, SG24-5592.

We recommend that you use either the 5250 CL command or Operations Navigator to avoid 
incorrect file ownership and data transfer format. Besides, these options are easier to do.

Method 1: Using a 5250 CL command
We recommend that you use a 5250 emulator software that supports the 27x132 column 
display screen, such as IBM Client Access or IBM Personal Communications. The screen 
size to which the parameter should be set to is the 27x132 column. Perform the following 
steps to change the Domino server’s notes.ini file:
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1. Open a 5250 session and sign on with a proper authorized user profile such as 
QSECOFR.

2. Run the Work with Domino Servers (WRKDOMSVR) CL command. A list of all of your 
Domino servers appears as shown in Figure 4-21.

Figure 4-21   WRKDOMSVR command

3. Locate your Domino iNotes Web Access server and use option 13 to edit the notes.ini file 
of the Domino server. The content of the file appears as shown in Figure 4-22.

 Work with Domino Servers                            
                                                             System:   AS06     
 Type options, press Enter.                                                     
   1=Start server     2=Change server   5=Display console   6=End server        
   7=Submit command   8=Work console    9=Work server jobs                      
   11=Change current directory   12=Work object links   13=Edit notes.ini       
                                                                                
      Domino                            Domino                                  
 Opt  Server                Subsystem   Status                                  
      *HTTPSETUP            QDOMINOHT   *STARTED                                
      MAILDOMXX             MAILDOMXX   *ENDED                                  
      MAILDOM02             MAILDOM02   *ENDED                                  
      MAILSVR               MAILSVR     *ENDED                                  
      APPLSVR               APPLSVR     *ENDED                                  
      INOTESML01            INOTESML01  *STARTED                                
      INOTESML02            INOTESML02  *ENDED                                  
 13   INOTESXX              INOTESXX    *STARTED                                
      INOTES01              INOTES01    *STARTED                                
                                                                        More... 
 Parameters or command                                                          
 ===>                                                                           
 F3=Exit      F4=Prompt   F5=Refresh   F9=Retrieve   F11=Display path           
 F12=Cancel   F17=Top   F18=Bottom   F22=Display entire field   F24=More keys   
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Figure 4-22   Editing the notes.ini file from a 5250 screen

4. Go to the end of file using Page Down or type a b on the Control line to go to the bottom of 
the file. Insert a new line by typing an i in front of the last line and press Enter.

5. In the new line, enter:

$DOLSDirectoryCatalog=OfflineCatalog.nsf

Here OfflineCatalog.nsf is the name of your Directory Catalog file in the data directory of 
the Domino server (Figure 4-23).

Edit File: /notes/inotesxx/notes.ini                                                                         
Record :       1   of      90 by  10                      Column :    1     64 by 126                        
Control : B                                                                                                  
                                                                                                             
MD 
....+....1....+....2....+....3....+....4....+....5....+....6....+....7....+....8....+...
.9....+....0....+.
    ************Beginning of data**************                                                              
   [Notes]                                                                                                   
   Directory=/notes/inotesxx                                                                                 
   KitType=2                                                                                                 
   NPN=1                                                                                                     
   UNICODE_DISPLAY=1                                                                                         
   NSF_HOOKS=QNNDIHK                                                                                         
   CleanupScriptPath=CALL QNOTES/NSD                                                                         
   Passthru_LogLevel=0                                                                                       
   Console_LogLevel=2                                                                                        
   VIEWIMP1=Lotus 1-2-3,0,_IWKSV,,.WKS,.WK1,.WR1,.WRK,.WK3,.WK4,,4,                                          
   VIEWIMP2=Structured Text,0,_ISTR,,.LTR,.CGN,.STR,,1,                                                      
   VIEWIMP3=Tabular Text,0,_ITAB,,.PRN,.RPT,.TXT,.TAB,,1,                                                    
   VIEWEXP1=Lotus 1-2-3,0,_XWKS,,.WKS,.WK1,.WR1,.WRK,,4,                                                     
   VIEWEXP2=Structured Text,0,_XSTR,,.LTR,.CGN,.STR,,1,                                                      
   VIEWEXP3=Tabular Text,1,_XTAB,,.LTR,.RPT,.CGN,.TAB,,1,                                                    
   EDITIMP1=ASCII Text,0,_ITEXT,,.TXT,.PRN,.C,.H,.RIP,,1,                                                    
   EDITIMP2=Microsoft RTF,0,_IW4W,_IRTF,.DOC,.RTF,,2,                                                        

F2=Save  F3=Save/Exit   F12=Exit   F15=Services   F16=Repeat find   F17=Repeat change   
F19=Left   F20=Right 

Note: It is not important where you add the new configuration. Adding it at any point in 
the notes.ini file will work. However, it makes more sense and is easier to verify at a 
later time to add the extra configuration lines at the end of file.
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Figure 4-23   Adding a new keyword $DOLSDirectoryCatalog to notes.ini

6. Press F3 to save the file. You see the status message “File has changed” at the bottom of 
the screen. Press F3 again to save and exit.

7. Restart the Domino server for this change to take effect.

Method 2: Using Operations Navigator
Perform the following steps to change the Domino server’s notes.ini file using Operations 
Navigator:

1. Launch Operations Navigator and sign on with proper authorized user profile such as 
QSECOFR.

2. Expand your iSeries server on the left pane to Network-> Servers-> Domino. If a window 
pops up for the Domino Administrator ID’s password appears, enter the password here 
(Figure 4-24).

Figure 4-24   Entering the Domino server’s Administrator ID password

3. A list of your Domino servers appears on the right pane. Right-click the Domino iNotes 
Web Access server and click Properties.

 Edit File: /notes/inotesxx/notes.ini                                                                        
 Record :      80   of      91 by  10                      Column :    1     59 by 126                       
 Control :                                                                                                   
                                                                                                             
CMD 
....+....1....+....2....+....3....+....4....+....5....+....6....+....7....+....8....+...
.9....+....0....+
    TRANSLOG_UseAll=0                                                                                        
    TRANSLOG_Style=0                                                                                         
    TRANSLOG_Performance=2                                                                                   
    TRANSLOG_Status=0                                                                                        
    MTEnabled=0                                                                                              
    SCHEDULE_VERSION=3                                                                                       
    WebAdminSetup=509                                                                                        
    DominoConfigLevel=3                                                                                      
    DDETimeout=10                                                                                            
    DefaultMailTemplate=mail50.ntf                                                                           
    Log_DirCat=1                                                                                             
    $DOLSDirectoryCatalog=OfflineCatalog.nsf                                                                 
     ************End of Data********************                                                             
                                                                                                             
F2=Save  F3=Save/Exit   F12=Exit   F15=Services   F16=Repeat find   F17=Repeat change   
F19=Left   F20=Right

Note: You must have IBM Client Access and Operations Navigator installed with the 
Domino plug-in to perform the following steps.
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4. From the Properties window, click the Initialization File tab. A read-only mode of the 
notes.ini file is shown (Figure 4-25). Click Edit to go to edit mode. A warning window 
appears that asks you to confirm that you want to modify the notes.ini file. Click Yes.

Figure 4-25   Initialization File tab in Operations Navigator containing notes.ini in read-only mode

5. Page down to the end of the file, insert a new line, and enter the following line:

$DOLSDirectoryCatalog=OfflineCatalog.nsf

Here OfflineCatalog.nsf is the name of your Directory Catalog file in the data directory of 
the Domino server (Figure 4-26).

Figure 4-26   Adding the new keyword $DOLSDirectoryCatalog to notes.ini

6. Save and close this file.

ASM06
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7. Restart the Domino server for this change to take effect.

Method 3: Using the set configuration command
You can also type the following command in the Domino server console to enable the DOLS 
offline directory. To do so, run the following command in the Domino server console:

set configuration “$DOLSDirectoryCatalog=OfflineCatalog.nsf”

Here OfflineCatalog.nsf is the name of your Directory Catalog file in the data directory of the 
Domino server. This command actually creates an entry in your notes.ini file the same as the 
previous methods and the configuration takes affect immediately. However, we recommend 
that you display the notes.ini file using either of the above two methods to make sure that the 
change is permanently made to the Domino server.

4.4.3  Deleting a Lotus iNotes Sync Manager subscription
If a mail subscription was installed before you enabled the offline directory, you must reinstall 
the mail subscription at the client. To remove an existing mail subscription, perform the 
following steps:

1. On the user’s client, open the Lotus iNotes Sync Manager window, and select the 
subscription for the mail database file.

2. Click the Delete icon, as shown in Figure 4-27.

Figure 4-27   Deleting an existing mail subscription

3. You receive a confirmation window displaying the message, “Are you sure you want to 
delete all of the files for this operation?”. Click Yes.

4. Close the Lotus iNotes Sync Manager window. A confirmation window appears, as shown 
in Figure 4-28. Click Yes.

Figure 4-28   Shutting down the Lotus iNotes Sync Manager
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4.4.4  Reinstalling your subscription
After you modify the Domino server setting and restart the Domino server, you are ready to 
install/reinstall your mail subscription. This time you download both your mail file and the 
Directory Catalog file. Keep in mind this process is transparent to the end user. To learn how 
to install an offline client and subscription, see 2.5.2, “Offline clients with Lotus iNotes Sync 
Manager” on page 46.

4.4.5  Testing the offline directory
After you install the new subscription, the Directory Catalog is also replicated to local client 
and all addresses are now available for lookup even when the user is running in offline mode. 
Perform the following steps to verify that offline directory is now replicated and working 
properly on the client:

1. Open the Lotus iNotes Sync Manager. Select the mail database subscription, and click the 
Open Offline button. You may also click the mail icon similar to the one shown in 
Figure 4-29 on the user’s desktop.

Figure 4-29   Local offline mail client icon on the workstation

2. Log on with the iNotes Web Access username and password.

3. From your Web browser, click Mail-> New Message. A compose new message window 
opens.

4. Click To. From the Select Addresses window, open the pull-down list on the Search field. A 
new address book is now listed besides the Contacts and Offline Address book 
(Figure 4-30).

Figure 4-30   New offline directory and name lookup are now available when working offline

Note: By default, the replica of Directory Catalog is kept on the offline workstation in the 
same data directory as the subscription of the iNotes Web Access mail database.

New offline directory
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5. Select your new address book. This is the local replica of the Directory Catalog file.

6. Select some recipients, and click Exit. Put some text in your memo and send it.

7. Close the window.

Checking your offline Directory Catalog from a Lotus Notes client
The iNotes Web Access client does not require a Lotus Notes client. But if this workstation 
has a Lotus Notes client installed, you can check the current offline Directory Catalog that is 
being used and associated with that user’s mail subscription. To check the current Directory 
Catalog on the client, perform these steps:

1. Launch the Lotus Notes client, and open the mail file.

2. On the menu bar, select Actions-> Edit Offline Configuration document.

3. Click the Rules tab. Note that the filename specified in the $DOLSDirectoryCatalog 
keyword was added automatically to the field Directory catalog.

4.5  Enabling other applications to be used offline
Sometimes when using mail and calendar offline, users have to refer to some information 
being kept in other databases. In their mail, there may be only a DocLink or HotSpot icon that 
links to the information in another database. To gain access to those databases when working 
offline, you also have to enable DOLS for those databases.

Some applications are composed of multiple databases that have to be synchronized 
together. In this case, you should add only one subscription for that application and select 
other databases as associated files to be replicated with that subscription. See Figure 4-31.

Figure 4-31   Optional files to be replicated

You can enable application databases by importing the DOLS Resource Template (dolres.ntf) 
into the application database. Please refer to the Domino Off-Line Services help in 
dols_help.nsf for more information.

iNotes Web Access is one of the DOLS-enabled databases. When you enable Directory 
Catalog for offline access, the Directory Catalog is not set to be a separate subscription but 
included as a part of your iNotes Web Access mail subscription. Every time you synchronize 
your mail database to the Domino server, the Directory Catalog is also updated.

Restriction: There is a difference in whether you perform a name lookup in Contact list or 
Domino Directory or whether you do it in Directory Catalog. In the Contact list or Domino 
Directory, searching returns the result of only the matched entries. The Directory Catalog 
positions to the first matched entry among all entries in the Directory Catalog.

Tip: Each subscription can have a different schedule and frequency of synchronization. 
Some applications may not be required to be frequently updated. This way you can reduce 
the time and amount of data in synchronization.
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4.6  Integration with Sametime 2.5
Lotus Sametime merges Web server technology, Lotus Notes technology, T.120 
data-conferencing technology, and online awareness technology to allow Lotus Notes and 
Web browser clients to participate in live, interactive online meetings, instant messaging, and 
group chat sessions. Sametime enhances the workplace by placing powerful, real-time 
collaboration tools on the desktop of every user in a Sametime community. Now you can 
combine these technologies with the reliability and scalability of an iSeries server.

With Sametime integration, iNotes Web Access users can receive and send instant 
messages. Users launch Sametime by clicking the Chat icon on the iNotes Web Access 
Welcome page and can use community services without requiring a re-logon or a separate 
client installed. Users can create their own buddy list, add names by either looking up through 
the name picker or simply type them in from the Domino Directory, or divide their buddy list 
into groups. See the Domino/Notes 5.0.9 Release Notes for details on configuring Sametime 
with iNotes Web Access.

For iSeries, you may install the Sametime server on a separate server or on the same server 
as iNotes Web Access. Installing on the same iSeries server gives you better benefit in 
integration, ease of management, and total cost of ownership.

When running a Sametime server on other platforms, Sametime Version 2.0 or above is 
required for integration with iNotes Web Access. However, on iSeries, Sametime Version 2.5 
or above is required.

This section explains how to configure the iNotes Web Access integration with Sametime 2.5 
on the iSeries server. Configuring Sametime on a separate iSeries server is also similar to 
this. We assume that you have already configured the basic Domino iNotes Web Access 
server and it is up and running. At the time of writing this redbook, Sametime 2.5 was just 
made available on the iSeries. Therefore, we also provide details for installing Sametime on 
the iSeries server in this section. For additional information about setting up the Sametime 
server on iSeries for services other than iNotes Web Access integration, please refer to 
product documentation on the Sametime installation CD.

The overview procedure for configuring Sametime for integration with iNotes Web Access is 
summarized here:

1. Prepare and plan: Hardware, software, and capacity planning for additional workload.
2. Install the Sametime license.
3. Prepare a Domino server for Sametime to run on.
4. Add a Sametime server to a Domino server.
5. Configure Sametime and iNotes Web Access servers.

4.6.1  Additional server requirements for Sametime
Integration with the Sametime server requires additional hardware and software, in addition to 
the iSeries hardware and software requirements for iNotes Web Access as described in 2.3, 
“iSeries server requirements” on page 19. You must also plan for extra system capacity 
required by the Sametime server.

Note: You may use the public beta release of Sametime Version 1.5 on iSeries for 
integration with iNotes Web Access. But, keep in mind that it is not officially supported by 
IBM or Lotus.
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The additional iSeries hardware and software requirements are:

� Minimum 256 MB (512 MB is recommended)
� Minimum available disk space 500 MB
� IBM Developer Kit for Java 5769-JV1 or 5722-JV1 with JDK 1.1.x option

� Lotus Sametime for iSeries (5733-LST) with the same language version as the Domino 
iNotes Web Access server (For more information about how to install additional language 
files, see the documentation in Sametime language pack CD.)

� (optional) OS/400 Option 12, Host Servers – for easier management of Domino and 
iSeries in a graphical interface using Operations Navigator with the Domino plug-in 
installed

� (optional) Client Access Express for Windows – for easier management of Domino and 
iSeries in a graphical interface using Operations Navigator with the Domino plug-in 
installed

� Lotus QuickPlace is not required by Sametime. But if you plan to run QuickPlace 2.0.8 in 
the same partition with Sametime 2.5, Domino 5.0.8.01 and upgrading to QuickPlace 
2.0.8.01 are required.

� PTFs:

– For more information on the latest PTFs, see the following Web sites:

http://www.ibm.com/eserver/iseries/domino/support
http://www.ibm.com/eserver/iseries/service

– If you plan to install Sametime on one of the iSeries Dedicated Server for Domino 
(DSD) models, you must use V5R1 with the DSD Enhanced Support for Java installed 
(available in September 2001). PTF RE01200 is an identifier that indicates whether 
your system already has the necessary version of the iSeries Licensed Internal Code 
(level RSC) installed. On any OS/400 command line, type the following command and 
press Enter to determine whether PTF RE01200 is already on your system: 

DSPPTF LICPGM(5722999) SELECT(RE01200)

If PTF RE01200 is not on your system, you do not have the RSC level installed and 
should consult the following Web site for more information: 
http://www.ibm.com/eserver/iseries/domino/dsdjava.html

4.6.2  Installing Lotus Sametime 2.5 on iSeries
Before you configure the Sametime server, make sure that you configure the TCP/IP 
configuration, set up the IP address for the Sametime server, update the hostname with its IP 
address in OS/40O TCP/IP host table, and add this server in the DNS server.

If you have not installed the Sametime license code in the iSeries, follow these steps:

1. Sign on to your iSeries server with a user profile that has at least *ALLOBJ and *SECADM 
authorities.

2. Insert the Sametime for iSeries CD into your iSeries CD-ROM drive.

Important: Sametime 2.5 does not support JDK 1.2 or JDK 1.3. By default, OS/400 
V5R1 comes with JDK 1.2 or JDK 1.3. To use Sametime, you need to also install 
5722-JV1 Option 4 JDK1.1.8.

Note: Although V4R5 is supported, in order to save the content of the Whiteboard in 
Sametime or to use Sametime 2.5 on the DSD model, OS/400 V5R1 is required.
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3. Type LODRUN on the OS/400 command line and press F4 to prompt the command.

4. On the LODRUN display (Figure 4-32), type *OPT in the Device field and press Enter.

5. Type /OS400 in the Directory field.

Figure 4-32   LODRUN command to install SameTime

6. Press Enter.

7. You see the Sametime option display. Type option 1 next to the Sametime product option 
and press Enter to begin installation. You see status messages as the system installs the 
software. Wait until Sametime installation is complete. 

4.6.3  Adding Sametime to an existing Domino server
For general Sametime server deployment, unlike Sametime on Windows which supports 
“Web-only standalone” and “merged configuration”, Sametime on iSeries installation supports 
only “merged configuration”. This means you have to run Sametime as an add-on Domino 
application on top of a Domino server.

It is easier to configure Sametime Community Services (chat) to work properly with iNotes 
Web Access if you configure the Sametime server in the same Domino Domain as your 
Domino iNotes Web Access servers because Sametime uses the Domino Directory for user 
management and also serves the integration.

It is possible to run Sametime and iNotes Web Access in the same Domino partitioned server, 
in the production environment. However, we recommend that you configure Sametime in a 
separate Domino partitioned server which may reside in the same physical iSeries server or 
LPAR as the other Domino servers for better performance, ease-of-management, and 
security. This is due to the fact that a Sametime server supports multiple services, and the 
services are served through Domino tasks. Sharing server tasks between Sametime and 
iNotes Web Access may result in longer response time to the users.

Adding Sametime to a Domino server can be done by either using a 5250 CL command or 
Operations Navigator.

Preparing a Domino server for Sametime
You can use the OS/400 Configure Domino Server (CFGDOMSVR) CL command or 
GUI-based configuration using a Web browser or Operations Navigator to configure a new 
additional Domino server in your Domino Domain. Make sure that you enable the HTTP 
service and configure it as a partitioned server if you are running multiple Domino servers on 
a single iSeries server or LPAR. For more information about installation and configuring 
Domino servers, refer to Lotus Domino for AS/400 R5: Implementation, SG24-5592.

 Load and Run (LODRUN)                             
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Device . . . . . . . . . . . . . > *OPT          Name, *TAP, *DKT, *OPT        
 Directory  . . . . . . . . . . .   /OS400 

Note: Even though you can have multiple Domino servers on an iSeries server, only one 
Sametime server can be up and running at the same time on an iSeries server or a logical 
partition (LPAR).
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In order for Sametime to display the timestamp while chatting properly, verify that the system 
values for date (QDATE), time (QTIME), and offset from Greenwich Meantime 
(QUTCOFFSET) are set to match the time zone and current daylight savings times of the 
Domino server where you plan to install Sametime. 

To change the time zone offset, you may use the 5250 CL command Work with System 
Values (WRKSYSVAL QUTCOFFSET) and option 2 to change to the appropriate value for 
your time zone. Or you can use Operations Navigator, by selecting Configuration and 
Service -> Date and Time as shown in Figure 4-33.

Figure 4-33   Changing the date, time, and universal time zone using Operations Navigator

Before you add the Sametime server, make sure the Domino server that Sametime will run on 
is ended.

Adding Sametime using a 5250 CL command
Perform the following steps to use a 5250 session to configure the Sametime server on a 
Domino server:

1. Sign on to the iSeries server with a user profile enabled with *ALLOBJ, *SECADM, 
*IOSYSCFG, and *JOBCTL authorities such as QSECOFR.

2. Run the command Work with Domino Servers (WRKDOMSVR) and use option 6 to end 
the Domino server on which Sametime will run. Press PF5 and wait until the Domino 
server status becomes *ENDED.

3. Run the Add Sametime to Domino (ADDLSTDOM) command (Figure 4-34):

ADDLSTDOM SERVER(SAMETIME) OPTION(*ALL)

Important: If you change the system values, you must stop and restart the Domino server 
so it will reflect the change.
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Figure 4-34   ADDLSTDOM command

4. Wait until the setup is complete. A screen similar to the example in Figure 4-35 appears.

Figure 4-35   Adding Sametime completion screen

5. Press Enter to finish the setup.

6. Start the Domino Sametime server.

Adding Sametime using Operations Navigator
Perform the following steps to add the Sametime server to an existing Domino server with 
Operations Navigator:

1. Open Operations Navigator. Sign on with a user profile enabled with *ALLOBJ, *SECADM, 
*IOSYSCFG, and *JOBCTL authorities such as QSECOFR.

2. Expand the left navigation pane to Network-> Servers-> Domino. You may be prompted 
for a Domino server’s Administrator ID password.

3. In the right pane, right-click the Domino server *HTTPSETUP and click Start.

4. Right-click the Domino server to be used for Sametime and select Add Sametime 
(Figure 4-36).

If you already added Sametime to this server, you will not see this option (in that case, the 
Remove Sametime option appears instead).

                       Add Sametime to Domino (ADDLSTDOM)                       
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Domino server name . . . . . . . > SAMETIME                                    
                                                                                
                                                                                
                                                                                
 Option . . . . . . . . . . . . . > *ALL          *BASE, *MULTIMEDIA, *ALL      
 Directory type . . . . . . . . .   *DOMINO       *DOMINO, *LDAP 

   Switching to the server identity...                                          
    10%  ...                                                                    
   Setting up authentication system...                                          
    30%  ...                                                                    
   Setup of the authentication system completed.                                
    55%  ...                                                                    
   Sametime Server setup completed successfully.                                
    100%  ...                                                                   
   Press ENTER to end terminal session.                                         
                                                                                
===>                                                                           
F3=Exit F4=End of File F6=Print F9=Retrieve F17=Top                            
 F18=Bottom  F19=Left   F20=Right F21=User Window 
Chapter 4. Enhancing iNotes Web Access 141



Figure 4-36   Adding Sametime with Operations Navigator

5. A Sametime server set up on the Web browser window appears as shown in Figure 4-37. 
Specify an OS/400 user profile and password enabled with *ALLOBJ, *SECADM, 
*IOSYSCFG, and *JOBCTL authorities such as QSECOFR. Then click Next.

Figure 4-37   Sametime setup window

6. Verify the Domino server name. If you want to start this Sametime server right after setup 
is complete, select Yes and click Next (Figure 4-38).
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Figure 4-38   Verifying the Domino server on which Sametime server will run

7. If you do not plan to deploy multimedia services, such as voice and video, you only need 
the base option. In this release, Sametime with iNotes Web Access integration client does 
not support multimedia services. But if you plan to use this server for other Sametime 
clients on this server, you may want to enable Sametime with multimedia (Figure 4-39).

Figure 4-39   Choosing the Sametime services to be deployed 

8. Select the directory that you want to use. In most cases for iNotes Web Access, we use 
and share Notes user IDs and passwords among Sametime and other Domino servers in 
the domain. To simplify the setup, we use the Domino Directory here (Figure 4-40).
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Sametime supports two types of directory access, LDAP and Domino Directory. You can 
use multiple directories but you have to exclusively select which type of access you plan to 
use. If you select LDAP here and also want to use another directory from the Domino 
Directory, you have to configure LDAP on that Domino server and configure Sametime to 
access that Domino Directory using LDAP. For more information, please refer to Sametime 
2.5 installation guide on iSeries.

Figure 4-40   Selecting the type of directory to be used by Sametime 

9. If you have other Sametime servers running in the same Domino domain, you may want to 
copy the configuration from another Sametime server. If this is the first Sametime server, 
click No and then click Next (Figure 4-41).

Figure 4-41   Selecting to copy a configuration from another existing Sametime server
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10.A window appears showing a status of the files that are now being copied and Sametime 
is being configured. Wait until the configuration finishes. This step may take up to 2 to 3 
minutes (Figure 4-42).

Figure 4-42   Progress of copying and configuring Sametime

11.A window appears similar to the example in Figure 4-43 showing that the configuration is 
now finished. Click the Finish button to quit.

Figure 4-43   Adding Sametime is now finished

12.Return to the Operations Navigator window. Right-click the Domino Sametime server and 
select Start to start the Domino Sametime server.
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After you add the Sametime server to the Domino server, you may want to verify whether 
Sametime is configured and working properly. Sametime uses the Staddin2 task. It is added 
to the Domino server’s notes.ini file during the adding of Sametime to the Domino process. 
For iNotes for Web Access integration, Sametime uses the HTTP task to serve the Java 
applets to the iNotes Web Access client. To check if the Sametime and HTTP tasks are up 
and running, go to the Domino server console and run the show tasks command 
(Figure 4-44).

Figure 4-44   Work with Domino server console: show tasks command

Editing the Domino server document
On the iSeries server, most of the necessary configurations are automatically set when the 
Sametime server is added. However, you may want to specify other parameters, such as a 
default home page, or you may want to make sure that all parameters are set properly. 
Perform the following steps to review the Sametime parameters:

1. Start the Domino Administrator client. Make sure that you are working on the correct 
Domino server that is running Sametime.

2. Go to the Domino server document for this Domino Sametime server. Click the Edit 
button. Verify the parameter values of the Sametime server listed in Table 4-1.

Table 4-1   Parameter values for the Sametime server in the Domino server document

                          Work with Domino Console                              
                                                                   Server:   INOTESML02   
 Previous subcommands and messages:                                             
                                                                                
    Sametime Server      Running                                                
    HTTP Web Server      Listening on port(s) 80, 443                           
    Event Monitor        Idle                                                   
    Calendar Connector   Idle                                                   
    Schedule Manager     Idle                                                   
    Admin Process        Idle                                                   
    Agent Manager        Executive '1': Idle                                    
    Agent Manager        Idle                                                   
    Stats                Idle                                                   
    Indexer              Idle                                                   
    Router               Idle                                                   
    Replicator           Idle                                                   

 Enter a Domino subcommand.                                                     
 ===>                                                                           
F3=Exit   F5=Refresh   F6=Print   F9=Retrieve                                  
 F17=Top   F18=Bottom   F21=Command line                                        
                                                                                

Tab Field Setting value

Basics Is this the Sametime server Yes*

Fully qualified Internet host 
name

Your Sametime server with domain, for 
example: sametime.mycompany.com

Note: Although it is not required by 
Sametime, we recommend you set it 
because it is required by some settings 
such as session authentication.
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3. Click Save and Close.

4. If you changed anything in the previous step, you must restart the Domino server before 
the changes become effective.

Verifying the Sametime installation
Perform the following steps to verify the installation of your Sametime server:

1. Start your Web browser and go to your Sametime server URL, for example:

http://sametime.itso.ibm.com

You should see a screen similar to the example in Figure 4-45.

Security Run unrestricted 
LotusScript/Java agents

Sametime Development/Lotus Notes 
Companion Products*

Ports -> Notes 
Network Ports

Ports TCPIP*

Note: This must be specified exactly as 
shown.

Internet Protocols -> 
HTTP

Home URL stcenter.nsf?Open

Note: This is the default Sametime home 
page that we use to verify installation in the 
next section. You can specify another URL 
here.

Host Name The TCP/IP hostname of your Sametime 
server.

Bind to hostname Enabled

Note: This is required if you are running 
multiple Domino partitioned servers 
(including iNotes and Sametime) in the 
same logical partition of the iSeries server.

Note: Fields with (*) are automatically set after you add Sametime server to a Domino server

Tab Field Setting value
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Figure 4-45   Sametime server home page

2. Click Launch Sametime Connect. Log on with an existing Domino user and specify their 
Internet password. You should then see a panel similar to the example in Figure 4-46.

Figure 4-46   Testing the Sametime Connect Web client
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The client you are using right now is called the Sametime Connect Web client. You can use 
chat as well as multimedia services, whiteboard meeting, or application sharing with the 
Sametime Connect Windows client or Sametime Connect Web client.

4.6.4  Configuring Sametime and iNotes Web Access servers
Perform the following steps to configure the Domino iNotes Web Access and Domino 
Sametime servers in preparation for iNotes Web Access integration with Sametime:

1. Start Operations Navigator and sign on with your iSeries user ID and password.

2. Browse for your iSeries server under My Connections. Go to File systems-> Integrated 
File system-> Root and browse for the directory:

<Domino data directory>/domino/html/SametimeApplet

See Figure 4-47. The following files should be in this directory: 

– Commres.cab
– CommRes.jar
– PeopleOnline20.cab
– PeopleOnline20.jar
– STComm20.cab
– STComm20.jar

These files are the applets used by iNotes Web Access when you click the Chat icon on 
the Welcome page.

Since we are deploying iNotes Web Access and Sametime on the same iSeries server 
and sharing the same Domino server code, these files should already exist. (These files 
come with Domino R5.0.8 or later.) If the files do not exist, you need to copy them from the 
Domino iNotes Web Access server and change the files’ owner to the QNOTES user 
profile.

Note: Notice there are SametimeApplet and SametimeApplets directories. On the 
iSeries platform, these directory names are not case-sensitive. 
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Figure 4-47   Check for SametimeApplet directory 

3. Start the Domino Administrator client and open the Domino Directory (names.nsf) 
database of your Domino iNotes Web Access server.

4. Under the Server -> Servers folder, highlight your Domino iNotes Web Access server and 
click the Edit Server button.

5. Under the Security tab, add your Domino Administrator name in the Create Replica 
databases field (Figure 4-48). For example, add Notes Administrator/iNotes. Then click 
Save and Close. By default, no one can create a new replica on the Domino server.

Figure 4-48   Security tab in the Domino server document: Create replica databases field

6. From the Domino Administrator client, select your Domino Domain on the bookmark at the 
left-most side on your window. Then select All Servers-> Your Domino Sametime 
server. Click the Administration window and go to the Files tab of your Sametime 
server.
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7. In addition to Domino password security features, the Sametime server implements a 
security policy to ensure that Sametime clients that establish a connection are 
authenticated. The security policy uses a Token database (stautht.nsf) and Secrets 
database (stauths.nsf). Chatting in iNotes Web Access uses “Login by token”, which 
prevents users from logging in again after entering Domino iNotes Web Access server. If 
you are deploying a Sametime server on a different Domino server than Domino iNotes 
Web Access server, these databases need to be replicated to the Domino iNotes Web 
Access server.

Locate and highlight the databases named Sametime AuthT Template (filename 
stautht.nsf) and Sametime AuthS Template (filename stauths.nsf). Then right-click and 
select New-> Replica(s) as shown in Figure 4-49.

Figure 4-49   Creating new replicas for stautht.nsf and stauths.nsf databases

8. Select your Domino iNotes Web Access server for the target server where the new replica 
databases will be created and click OK.

9. A pop-up window appears that shows that the new replicas are created. Click OK to close.

10.You have to create a Connection document that replicates the Domino Directory, 
Sametime AuthS, and Sametime AuthT databases so that iNotes Web Access users are 
also authenticated to Sametime. Go back to the Domino Directory of your Domino iNotes 
Web Access server. Under the Server ->Connections folder, click the Add Connection 
button to create a Connection document to replicate the Domino Directory between your 
Domino iNotes Web Access server and the Domino Sametime server (Figure 4-50). Enter 
the parameters shown in Table 4-2.

Note: These databases may not appear when you browse to open the databases. In 
such case, you have to explicitly type in the filenames.
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Figure 4-50   Server Connection document

Table 4-2   Server Connection document parameters 

11.Click Save and Close to close the window

Adding the Sametime server to the Person document
You completed setting up the Domino iNotes Web Access server to connect with the Domino 
Sametime server. Now you have to configure the users to specify which Sametime server to 
use. You can set up multiple Sametime servers in a domain to support more workload or to 
separate groups of users.

To specify which Sametime server each user is going to use, specify the Sametime server 
field in that user’s Person document. Perform the following steps:

1. In the Domino Directory of Domino iNotes Web Access server, click the People & Groups 
tab, and in the left pane, select People view.

2. On the right pane, edit a Person document by highlighting a user. Click Edit Person.

3. Go to the Administration tab, and enter your Domino Sametime server name, such as 
Sametime/iNotes, in the Sametime Server field.

Tab Field Value

Basics Connection type Local Area Network

Source server Your iNotes Web Access server

Destination server Your Sametime server

Use the ports TCPIP

Replication/Routing Replication task Enabled

Replication type Pull Push

Files/Directories to replicate names.nsf, stauths.nsf, 
stautht.nsf

Routing task -None-

Schedule Schedule ENABLED

Connection at times 12:00 AM - 11:59 PM

Repeat interval of Specify a interval such as 15 
minutes

Note: Leave all other fields at their default values.
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4. Click Save and close to exit.

4.6.5  Exploring iNotes Web Access with Sametime integration
Perform the following steps to verify the Sametime integration and explore Sametime with 
iNotes Web Access integration features.

Exploring the new option in the menu bar
Before you installed Sametime, the menu options available in your iNotes Web Access client 
(located on the upper-right corner of the page) are shown in Figure 4-51.

Figure 4-51   Options available in the Welcome page by default of iNotes Web Access

Once you set up Sametime, perform the following steps to see the Chat option in the iNotes 
Web Access menu options of the Welcome page:

1. Open your Web browser and log on to your iNotes Web Access mail database, for 
example:

http://inotes.itso.ibm.com/mail/HPotter.nsf

Then logon and check whether the Chat option is now available in the menu bar on the 
upper-right corner of the screen.

2. After you set up and integrate the Sametime server with iNotes Web Access, a new menu 
option appears in the default Welcome page or Portal user interface of iNotes Web Access 
appears as shown in Figure 4-52 and Figure 4-53 respectively.

Figure 4-52   New Chat option available in menu bar of Welcome page

Important: Make sure you enter the hierarchical name of the Sametime server in this 
field with the canonical format such as CN=Domino Sametime/OU=OrgUnit/O=iNotes or 
Domino Sametime/OrgUnit/iNotes.
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Figure 4-53   New Chat option available in menu bar in Portal user interface

Creating a buddy list and group
Perform the following steps to create a buddy list and group:

1. From your iNotes Web Access client, click the Chat button, and a Sametime Chat applet 
window appears (Figure 4-54). This client is different from the Sametime Connect Web 
client that you used to test in the previous section. The Sametime service available here is 
Chat only.

Figure 4-54   Sametime awareness in iNotes Web Access

2. Add or find a person to contact by clicking Browse and then search the Domino Directory 
for a user. Click Add User and click Exit to return to the previous Sametime window.

3. You can also group the buddy list by clicking the New Group button. The groups and the 
list of persons you are creating is not relevant to Group and Person documents in the 
Domino Directory. They are kept exclusively from each user and cannot be seen by other 
users.

You can chat with other iNotes Web Access users or with other Sametime Connect clients.

4. Figure 4-55 shows a comparison of the Sametime iNotes client and the Sametime 
Connect Web client. In front of each buddy name, there is a tiny icon representing the 
online status of that user. There are four different states of a user:

Note: This Chat icon appears after you replicate the stauths.nsf and stautht.nsf files from 
the Domino Sametime server to your Domino iNotes Web Access server.

Note: The buddy list and group for each user are kept by each Sametime user in a 
binary format in the database file, vpuserinfo.nsf, on Sametime Domino server. 
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– Active: Green square button
– Away from the computer: Red round button
– Do not disturb: A transparent circle with diagonal line
– Offline: No icon displayed

Figure 4-55   Sametime iNotes client and Sametime Connect Web client

5. In the Sametime Chat window, double-click someone in your buddy list or right-click and 
select Message to request to chat.

6. Try to send and receive messages between you and your buddy.

In the Sametime iNotes Web Access applet client, the client connects to the Sametime 
server using TCP/IP port 80 (HTTP) or port 443 (HTTPS) to download the Java applets. 
After that, by default, the client uses port 1533 to connect to the server. Sametime has its 
own encryption so the session is secured even though you do not use SSL on the 
Sametime server (Figure 4-56).

For network security or firewall planning on Sametime, see Lotus Sametime 2.0 
Deployment Guide, SG24-6206.

Figure 4-56   Sametime Chat window

7. You can change your online status by clicking the area I Am Active at the bottom the 
Sametime iNotes chat window (Figure 4-57). Try to change the status to I Am Away and 
Do Not Disturb Me. Notice that the status changes on your buddy’s Sametime client.

secure session
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Figure 4-57   Changing your Sametime status

8. Click the Close button to end the conversation

4.6.6  Limitations
Sametime server version 2.5 supports the following services:

� Domino/Web application services
� Community Services or all presence (Chat)
� Meeting services
� Broadcast Services
� Audio/Video Services

However, the current release of the Sametime iNotes Web Access client supports only 
Community Services (Chat). You can communicate with other persons using Sametime 
iNotes Web Access clients as well as other Sametime Connect Windows or Web browser 
clients. However, you cannot participate in other services requested by other types of 
Sametime clients.
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Chapter 5. Troubleshooting

This chapter contains some frequently found problems in deploying iNotes Web Access on 
the iSeries server and some possible solutions. Actually most of the problems are not specific 
to iSeries platform and are known limitations in the current releases of iNotes Web Access 
(with Domino R5.0.8 or R5.0.9). We also compiled some problem determination and 
troubleshooting from other whitepapers, Redbooks, and sources from the Internet and 
included them here.

This chapter covers the following topics:

� Sources for additional information
� Common problems
� OS/400 HTTP server tips

5
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5.1  Sources for additional information
iNotes Web Access is rich in functionality and is continually updated with new enhancements 
in each new release of Domino. There are sources of additional information available that list 
supported and unsupported features. We recommend that you check for information from the 
following sources:

� Current Release notes: Domino/Notes 

Located in the HELP/readme.nsf of the Domino server and Lotus Notes client. The 
database contains supported and unsupported features, new enhancements, and 
limitations in that particular release.

� Domino Off-Line Services

Located in HELP/dols_help.nsf of the Domino server and Lotus Notes client. Describes 
how to set up and configure offline services including Lotus iNotes Sync Manager for 
offline usage.

� Notes.net Web site: http://www.notes.net/r5fixlist.nsf

On the Notes.net Web site, there is a fix-list database that contains all implemented, 
planned, and upcoming fixes.

� Lotus Support Services from IBM: http://www-3.ibm.com/software/lotus/support/

This site is supported by IBM Software Support and was previously known as the Lotus 
Knowledge Base. It contains the latest information on bugs and problems with iNotes Web 
Access.

5.2  Common problems
Some of the common problems that you may encounter with iNotes Web Access are listed in 
Table 5-1.

Table 5-1   Common problems with iNotes Web Access

Problem/error message Problem determination

Problems related to accessing the Domino 
HTTP server.

� Check if there is any error message on the 
Domino server console or in the following 
databases:

– log.nsf
– domlog.nsf (HTTP logging must be 

enabled, see 2.8.4, “Domino server tuning” 
on page 63)

� Enable session tracking from the Domino 
server console. Issue the following 
commands:

– set CONFIG DEBUG_THREADID=1

Dumps the thread id for each session to 
the Domino server console.

– set CONIFG DISABLE_IOCP=1

Forces a session to use a single thread 
rather than thread pooling.

Problems using the ActiveX support. Check with the network administrator to see if 
there is any restriction in the firewall.
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DOLS does not load when the Domino HTTP 
server starts.

Check if the name of the DSAPI filter is spelled 
correctly in the Domino server document. 

Make sure the DOLS DSAPI is listed first if you 
have multiple filters. By default, the CHGDOMSVR 
command appends it to the end of the field.

When you open the mail file from the Web 
browser, you still see the WebMail template.

Verify that the template is updated to iNotes5.ntf. 
To do this, look at the database property of the mail 
file, or opening the database catalog.

When you set the owner of the mail file (from the 
Preferences button), you see the “Server not 
responding” error message.

Check the network address in the Domino server 
document, under the Ports - Notes Network Ports 
tab.

When you set up DOLS, you see an error 
message indicating the Web browser is unable 
to request the offline configuration data.

The Offline Subscription Configuration profile 
document is missing or you may have a 
connection error. Open your local LOG.NSF to see 
the corresponding server error message.

Check in the dolsadmin.nsf database for any typo 
in any fields. For example, “names.nsf” may be 
spelled incorrectly.

Note: To open your local LOG.NSF, use your Web 
browser and type: http://127.0.0.1:89/LOG.NSF

Error message: This application is not 
configured properly to go offline.

An error occurred during download. Open your 
local LOG.NSF to see the corresponding server 
error message.

Error message: Unable to download fileset 
component information for this application.

This is an HTTP request error and involves an 
access restriction. Open your local LOG.NSF to 
see the corresponding server error message.

When a user is trying to install offline, the HTTP 
error 404 appears.

Verify that the Offline Subscription Configuration 
profile document is available.

When the user is installing a DOLS 
subscription, after the Lotus iNotes Sync 
Manager starts, a Web browser opens pointing 
to the local mail database with the HTTP error 
404 message. At this point, the Lotus iNotes 
Sync Manager stops.

DOLS does not support Multi-server 
authentication. Verify if Multi-server is specified in 
the Session authentication field of the Domino 
server document. If yes, change it to Single server. 
This may affect the other applications.

From the Lotus iNotes Sync Manager, the user 
clicks the Open Offline icon and sees the HTTP 
500 Internal server error message on the Web 
browser.

Find out if the local mail database is encrypted 
AND the user changed the Internet password. 
Make sure that the Synchronization password is 
the same as the Notes password (the password 
that comes with ID file). The Internet password can 
be different from the Synchronization/Notes 
password.

From the Lotus iNotes Sync Manager, the user 
is unable to synchronize mail.

If clients are outside the firewall, the IP address 
cannot be resolved. If you partitioned multiple 
Domino servers and specified a 
TCPIP_TCPIPAddress, this is used for DOLS in 
the Optional Network Address of Dolnames.nsf. 
Add a new notes.ini setting called 
$DOLS_TCPIPAddress=<hostname>:<port>

Problem/error message Problem determination
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5.3  OS/400 HTTP server tips
Table 5-2 shows problems you may experience when you use the OS/400 HTTP server to 
serve iNotes Web Access instead of the Domino HTTP server.

Table 5-2   Common troubleshooting tips with OS/400 HTTP server

The user changed their Internet password, 
which caused an Error 500 when accessing 
offline.

You will not be able to open your offline mail if you 
selected to encrypt offline mail and your password 
has changed. This is because your Notes and 
Internet passwords must be the same when the 
offline mail file is encrypted locally. A Notes 
password is required to access the Notes ID to 
decrypt the mail file. However, only the Internet 
password is available in the (offline) HTTP server. 
Make sure that you turn off encryption on your 
local mail file if you plan to change your Internet 
password. See Release Notes for 5.0.9 for more 
information.

When the user is trying to start Sametime by 
clicking the Chat button from iNotes Web 
Access, they see the error message “Unable to 
verify logon. Please try again later.”

Check the Sametime.log file on your Domino 
Sametime server. Verify if there is an indication 
that one or more of the Sametime tasks are not 
running. If so, stop the Sametime tasks by issuing 
the tell staddin2 quit command on the 
command line. When Sametime is completely 
shutdown, start it again using the load staddin2 
command.

Problem/error message Problem determination

Problem/error message Problem Determination

There are problems related to the Admin Server 
not being able to configure a server instance, or 
not starting or not running once it is started. 

The Admin server uses the Java Toolbox that 
must connect to a host server. The toolbox uses 
the localhost (*LOOPBACK) address to contact a 
local host server. Make sure this is started on 
your system. There is a log file for the Admin 
server: /QIBM/UserData/HTTPA/Admin/logs/
HTTPAdmin.log that can give you some hints 
about what is failing. 

The OS/400 HTTP server instance starts, runs 
for a few seconds, and then ends. 

Use the OS/400 very verbose trace on your HTTP 
server. Specify -vv on the “Instance startup 
values” on the STRTCPSVR command.
Check the spooled file for user QTMHHTP 
associated with your HTTP server job. 

If the Domino server ended with the *IMMED 
option or via a crash and the OS/400 HTTP 
server was not ended, you see the following 
errors in the console: “This database is currently 
being used by someone else. In order to share a 
Notes database, all users must use a Domino 
server instead of a File server.”

You must completely end the associated OS/400 
HTTP server before you restart the Domino 
server. Once this is done, start the Domino server 
and then the associated OS/400 HTTP server.
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Appendix A. iNotes Web Access features 
comparison

This appendix contains a feature comparison among the different clients for Lotus Domino R5 
server including WebMail, iNotes Web Access, and the Lotus Notes client. It also compares 
the features between Lotus iNotes Web Access and Microsoft Outlook Web Access.

A
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A.1  WebMail, iNotes Web Access, and the Lotus Notes client
The tables in the following sections are based on Domino R5.0.9. For newer releases of 
Domino or more update to date information, go to the Web site at: 
http://www.notes.net/inoteswebaccesswelcome.nsf

Then click the Feature comparison information link. Or go directly to: 
http://notes.net/inoteswebaccesswelcome.nsf/9ef083dbcc1d1c5c8525695b0050c564/
c90f95eaeee7d5738525697e00605a76?OpenDocument

The product feature areas that are compared are:

� Mail
� To Do list
� Calendar and scheduling
� Personal contacts
� Attachments
� Miscellaneous/other features

A.1.1  Mail
Table A-1 compares the mail features between the WebMail, iNotes Web Access, and Lotus 
Notes clients.

Table A-1   Mail features comparison

Feature WebMail iNotes Web Access Lotus Notes

Views and folders

In-box view Yes Yes Yes

Drafts view Yes Yes Yes

All documents view Yes Yes Yes

Discussion thread view Yes No Yes

Folders Yes Yes Yes

Nested folders Yes Yes Yes

Create/delete folders Yes Yes Yes

Drag & drop messages 
into folders

No No Yes

Copy & move to folder Yes Yes Yes

From the action bar, 
open mail into specific 
view (for example, 
Inbox, Sent, Drafts, 
etc.)

No Yes No

Message creation and addressing

Create new memo Yes Yes Yes

Type-ahead 
addressing

No No, but there is similar 
name look up and 
automatic name 
resolution in R5.0.9.

Yes
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Support file 
attachments

Yes (limit to 2) Yes Yes

View file attachments 
from within messages

No No Yes

Spell-checking No Yes Yes

Alternate name 
support when sending 
mail

No Yes, new feature in 
R5.0.9

Yes

Sametime integration No Yes Yes

Perform Name & 
Address book lookup

Yes Yes Yes

Display contacts 
sorted by Organization 
Unit

Yes Yes Yes

Perform integrated 
address book lookup 
when sending a 
message

No No Yes

Personal Contacts 
Address Book

Yes Yes, in R5.0.9, creating 
and managing a 
personal group is also 
supported.

Yes

Delivery options 
(Importance, Delivery 
priority, Delivery 
report)

Yes Yes Yes

Forward message Yes Yes Yes

Save message draft Yes Yes Yes

Create a serial route 
memo

No No Yes

Forward Web pages 
and documents from 
any Notes application

No No Yes

Forward document as 
bookmark link 
message

No No Yes

“Copy Into” - convert 
item to Task, Calendar 
Entry or New memo

Yes No Yes

Return receipt Yes Yes Yes

Prevent copying No No Yes

Apply mood stamps to 
messages

No No Yes

Create/use stationery No No Yes

Feature WebMail iNotes Web Access Lotus Notes
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Choose a letterhead No No Yes

Create a message 
containing a signature 
file

Yes Yes Yes

Type-ahead within 
“Move to Folder” dialog

No No Yes

Specify outbound 
message with a “reply 
by” date

No No Yes

Internet message 
format

Yes Yes Yes

Viewing and responding to message items

Support for 
read/unread marks

No Yes Yes

Navigate to next 
document without 
returning to view

Yes No Yes

Perform mail file 
delegation

Yes Yes Yes

Reply with history Yes Yes Yes

Reply to memo Yes Yes Yes

Reply to all Yes Yes Yes

Detach attachments Yes Yes Yes

View rich text within a 
message

Yes Yes Yes

Support for doc links, 
view links and 
database

Yes, on the same 
server only.

Yes, on the same 
server only.

Yes

View tables within 
messages

Yes Yes Yes

Create tables within 
messages

No No Yes

Resend documents 
from within a delivery 
failure

Yes Yes Yes

View sections Yes Yes Yes

Action bar Yes Yes Yes

Add sender of 
message to Personal 
Contacts list

Yes Yes Yes

Modify/view of the file’s 
ACL from client

No No Yes

Feature WebMail iNotes Web Access Lotus Notes
164 iNotes Web Access on iSeries Server



Display of 
importance/type icons 
in views

Yes Yes Yes

Read encrypted mail 
and verify signature of 
signed mail

No No Yes

Preference setting for 
new mail on 
top/bottom

No Yes No, but you can easily 
customize the view to 
have this sorting 
feature.

Automatically checking 
for new messages

No Yes Yes

Advanced editing features in rich text field

Left, right and center, 
indent, outdent text 
justification

Yes Yes Yes

Tables No No Yes

Sections No No Yes

Support for embedded 
OLE objects

No No Yes

Java Applet support No No Yes

Page break No No Yes

Horizontal line No No Yes

Hotspots No No Yes

Insert image resources No Yes Yes

Create sections No No Yes

Ability to switch 
language dictionaries 
for spell-checking

No Yes No

Support for both 
bullets and number 
lists

Yes Yes Yes

Undo No No Yes

User preferences

New mail notification No Yes Yes

Default mail send/save 
setting

No Yes Yes

Ability to archive mail 
and calendar 
documents

No Yes Yes

Lookup across multiple 
address books

Yes Yes Yes

Feature WebMail iNotes Web Access Lotus Notes
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Automatically create a 
reply message by 
clicking the From field

No Yes No

Security

Send signed or 
encrypted mail

No No Yes

Field, form, view, 
document, section 
level security

No No Yes

User roles No No Yes

Local encryption of 
mail database

No Yes, in 5.0.9; allowing 
users to encrypt offline 
mail with simple, 
medium, and strong 
encryption

Yes

Other features

Control of database 
properties/design 
(refresh, replace, etc)

No No Yes

Support for alternate 
editors for mail 
messages

No No Yes

Built-in news reader, 
POP mail, IMAP mail

No No Yes

Support for Domino 
database 
subscriptions

No No Yes

Extended (within 
databases, 
attachments, 
messages, etc.) 
control of search - 
refinement of search 
with form, etc.

No No Yes

Drag and drop 
documents between 
frames

No No Yes

User can change their 
own password from a 
client

No Yes Yes

Feature WebMail iNotes Web Access Lotus Notes
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A.1.2  To Do
Table A-2 compares the To Do features between the WebMail, iNotes Web Access, and Lotus 
Notes clients.

Table A-2   To Do features comparison

A.1.3  Calendaring and scheduling
Table A-3 compares the calendaring and scheduling features between the WebMail, iNotes 
Web Access, and Lotus Notes clients.

Table A-3   Calendaring and scheduling features comparison

Feature WebMail iNotes Web Access Lotus Notes

Option to have To Dos 
follow day-to-day in 
calendar view

No Yes Yes

Display To Do in 
calendar view

Yes Yes Yes

Delegate a To Do to 
another person

Yes No Yes

Create To Dos (with 
start and end dates)

Yes Yes Yes

Categorize new To Do 
entries

Yes Yes Yes

Alarm notification on 
To Dos

No Yes Yes

Mark To Dos complete 
or uncompleted

Yes Yes Yes

Create To Dos Yes No Yes

Ability to setup time on 
To Dos

No No Yes

Display To Dos in 
Gantt chart format

No Yes No

Priorities for To Dos 
(high, medium and 
low)

Yes Yes Yes

Create personal To 
Dos

Yes Yes Yes

Owner and participant 
actions

Yes No Yes

Feature WebMail iNotes Web Access Lotus Notes

From the action bar, 
open Calendar into a 
specific view (for 
example, 1-day, 1 
week, 1-month, etc.)

No Yes No
Appendix A. iNotes Web Access features comparison 167



Calendar Views 1 day
2 day
1 week
2 week
1 month
1 year

1 day
2 day
5 day
1 week
2 week
1 month
1 year

1 day
2 day
5 day
1 week
2 week
1 month

Meeting view Yes No Yes

Calendar print preview No Yes No

Work/non-work hour 
differentiation

No Yes No

Ability for chairperson 
to see status of 
invitees from the view 
label

No No Yes

Calendar entries and group scheduling

Double-click within the 
calendar view to create 
an entry

No Yes Yes

Create appointment Yes Yes Yes

Create all day event Yes Yes Yes

Create reminder Yes Yes Yes

Create anniversary Yes Yes Yes

Create meeting 
invitation

Yes Yes Yes

Create rich text in 
detailed description 
field

No Yes Yes

Automatic date 
(calendar picture) and 
time selector controls

No Yes Yes

Centrally managed 
rooms and resources

Yes Yes Yes

Create repeating 
entries

Yes Yes Yes

Add alarms to entries No Yes Yes

Attach a file to 
invitation forms

No Yes Yes

Pencil in a 
meeting/tentatively 
schedule

Yes No Yes

Mark an entry private, 
“Not for public viewing”

Yes Yes Yes

Feature WebMail iNotes Web Access Lotus Notes
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Delivery options on 
calendar entries

Yes No Yes

Address lookup for 
inviting people

Yes Yes Yes

Check free time 
availability for invitees

Yes Yes Yes

Free time search in 
counter-proposal

No No Yes

Respond with 
comments within a 
counter-proposal

No No Yes

Edit calendar entries Yes Yes Yes

Send a reschedule 
notice

Yes Yes Yes

Add additional invitees 
after invitation is sent

Yes Yes Yes

Send “broadcast” 
invitation (no 
RSVP/response)

Yes Yes Yes

Send meeting 
confirmation

Yes Yes Yes

Accept invitation Yes Yes Yes

Decline invitation Yes Yes Yes

Counter propose an 
alternative time

Yes Yes Yes

Accept/decline with 
comments

No Yes Yes

Delegate an invitation Yes No Yes

Check calendar from 
invitation page

No Yes Yes

Create and maintain 
group calendar

No Yes Yes

Create meeting 
invitation from group 
calendar view 
populating group 
members in invitation

No Yes No

Accept counter 
proposal

Yes Yes Yes

Feature WebMail iNotes Web Access Lotus Notes
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A.1.4  Personal contacts
Table A-4 compares the personal contacts features between the WebMail, iNotes Web 
Access, and Lotus Notes clients.

Table A-4   Personal contacts features comparison

Users in different time 
zones can share the 
same server and still 
see meeting times with 
respect to their own 
zone

No Yes Yes

User preferences

Set global default 
appointment duration

Yes Yes Yes

Set global default 
calendar entry type

No Yes Yes

Option to make free 
time available to only 
certain users

Yes Yes Yes

Options to set 
allowable free time

Yes Yes Yes

Enable conflict 
checking for calendar 
entries

No Yes Yes

Allow another user to 
manage calendar 
without allowing 
access to e-mail

Yes Yes Yes

Mark default calendar 
entry as “Not for public 
viewing”

No Yes Yes

Auto processing of calendar information

Option to remove 
invitations from Inbox 
after processing

Yes Yes Yes

Ability to auto process 
invitations

Yes Yes Yes

Feature WebMail iNotes Web Access Lotus Notes

Feature WebMail iNotes Web Access Lotus Notes

Sort contacts by last 
name, company, 
e-mail, address, etc.

Yes Yes Yes

Add users in Domino 
Directory to Personal 
Contacts list

Yes No Yes
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A.1.5  Attachments
Table A-5 compares the attachments features between the WebMail, iNotes Web Access, 
and Lotus Notes clients.

Table A-5   Attachments features comparison

A.1.6  Miscellaneous
Table A-6 compares some miscellaneous features between the WebMail, iNotes Web 
Access, and Lotus Notes clients.

Table A-6   Miscellaneous features comparison

Select multiple 
contacts and send 
message

No Yes Yes

Select multiple 
contacts and schedule 
a meeting

No Yes Yes

Business card 
summary view

No Yes Yes

Categorization of 
contacts

Yes Yes Yes

Automatically add 
e-mail sender to 
Personal Contacts list

Yes No Yes

Feature WebMail iNotes Web Access Lotus Notes

Feature WebMail iNotes Web Access Lotus Notes

Unlimited attachments No (maximum is 2) Yes Yes

Drag and drop 
attachments from 
desktop/file system

No Yes Yes

Feature WebMail iNotes Web Access Lotus Notes

Browser support Internet Explorer 4.x
Internet Explorer 5.x
Netscape Navigator 
4.x

Internet Explorer 5.x n/a

Advanced search 
(contextual by text, 
author, or date)

No Yes Yes

Journal integrated in 
mail file

No Yes No

Contacts integrated in 
the mail file

Yes Yes No

Ability to snooze 
alarms across multiple 
sessions/logins

No Yes No
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A.2  iNotes Web Access and Microsoft Outlook Web Access
The tables in this section show product feature comparisons between Lotus iNotes Web 
Access and Microsoft Outlook Web Access. Lotus iNotes Web Access is based on Domino 
server R5.0.9, while Microsoft Outlook Web Access is based on Microsoft Exchange 2000.

A.2.1  Overview
Table A-7 compares an overview of the features between the Lotus iNotes Web Access and 
Microsoft Outlook Web Access clients.

Table A-7   Overview of features comparison between iNotes Web Access and Outlook Web Access

Context-sensitive help No Yes Yes

Offline support for 
Messaging, PIM, and 
Collaborative 
Applications

Mail only Messaging, PIM Yes

Welcome page 
support

No Yes Yes

Mail view filter for 
unread messages

No Yes No

Mail view filter for high 
priority messages

No Yes No

Mail view filter for last 
10 messages

No Yes No

Feature WebMail iNotes Web Access Lotus Notes

At a glance iNotes Web Access Outlook Web Access

Deployment Requires a Lotus Domino R5 
server and will run on a range of 
operating systems and 
hardware platforms. Very few 
dependencies.   

Requires Windows 2000, Active 
Directory and IIS 5.0, and 
Exchange 2000. Frontend and 
Backend servers are required 
for incremental scalability. 

Offline access Yes 
Users can take mail offline for 
disconnected use or where 
bandwidth is limited.

No 
Microsoft indicated at the 
Exchange 2000 Conference in 
Dallas that there are no plans to 
make the Outlook Web Access 
client available to offline users. 
Offline Access is provided 
through Microsoft's thick client 
architecture - Office and 
Outlook.

Mail Yes Yes

Calendar Yes Yes

Group scheduling Yes No
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To Dos Yes No, does not provide a To Dos 
facility. This is confusing to 
users of Microsoft Outlook 
where To Dos are supported.

Contacts Yes Yes

Printing Yes
Printing of content provided 
through Web client print 
functions. Printing of calendar 
is available in the following 
styles: 
Daily 
Weekly 
Monthly 
Calendar List 
Todo List 
Trifold 

Yes

Spell-checking Yes No

Ease of use Provides high functionality. 
User interface is consistent. 
Consistent experience for users 
familiar with full-functioned mail 
clients 

Misses important features such 
as integrated tasking, address 
lookup lists, resource lookup 
lists, attachment insertion 
complicated and slow, no spell 
checker, and no Welcome 
page. Inconsistent operation for 
users of full-functioned mail 
clients

Performance Good in LAN, WAN, dial-up, 
and disconnected states. 
Offline capability ensures high 
performance in low bandwidth 
environments.

Good, if connected in a LAN 
environment. Performance is 
very poor over dial-up 
connections.

Overall functionality High, offers similar functionality 
found in Lotus Notes R5 
messaging client today. First to 
market from any vendor with 
robust mail and PIM features 
with the inclusion of offline 
access.

Low, has a similar look and feel 
to Microsoft Outlook in some 
areas, with only a small 
percentage of the features. 
Microsoft recommend Outlook 
Web Access as an augmented 
solution to existing Outlook 
users.

Support unread marks Yes Yes

At a glance iNotes Web Access Outlook Web Access
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A.2.2  General client
Table A-8 compares the general client features between the Lotus iNotes Web Access and 
Microsoft Outlook Web Access clients.

Table A-8   General client features comparison

A.2.3  Mail
Table A-9 compares the mail features in Lotus iNotes Web Access and Microsoft Outlook 
Web Access clients.

Table A-9   Mail features comparison

Client - General iNotes Web Access Outlook Web Access

Client specification Internet Explorer 5.01 on Win32 
clients.
Note: Plan to provide support 
more clients in Rnext.

Internet Explorer 4.0*, 5.0 
Netscape Navigator 4.0*
Note: IE4 and Netscape are 
supported with limited features.

Kiosk Yes Yes

ISP/ASP Yes Yes

Home Yes No

Offline Yes
Offline support is a simple 3 
step process initiated by user. 
Other Web-based applications 
can also be used offline.

No
Offline support is not provided. 
Users must be connected to the 
server at all time.

Full-text searching Yes
Full-text indexing is provided 
both online and offline.

No

Drag and drop attachments Yes No

Support for unread marks Yes Yes

Time zone support Yes Yes

Mail iNotes Web Access Outlook Web Access

Overview

Easy access to mail via a 
Welcome page

Yes No
No, Welcome page is provided.

Ability to view most recent 
messages on Welcome page

Yes No

Automatically check for new 
messages

Yes No

Spell checker Yes No

Rich text editor when creating 
mail messages

Yes Yes

Folder support Yes Yes

Drag and drop messages into 
folder

No. Will be provided in 
subsequent release.

Yes
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Drag and drop attachments Yes No

Double click to launch 
attachment in message

Yes No

Language support Yes, currently support 24 
languages.

Yes, currently support 9 
languages. 

Views and folders

Provide Inbox view Yes Yes

Provide Drafts folder Yes Yes

Provide All Documents view Yes No

Provide Discussion Thread 
view

Yes No

Access to all views in the mail 
file (including expand and 
collapse)

Yes Yes

Display folders Yes Yes

Create nested folders Yes Yes

View nested folders Yes Yes

Create and delete new folders Yes Yes

Copy and move to a specific 
folder 

Yes Yes

Message creation and addressing

Create new memo Yes Yes

Send message Yes Yes

Creation of rich text Yes Yes

Attach unlimited number of 
attachments to message

Yes Yes

Integrated real-time 
collaboration, “Who is Online” 
functionality

Yes No

Perform Name & Address Book 
lookup via selection list

Yes No
No address lookup selection list 
is provided. Users must perform 
a search or type in a name.

Perform integrated Address 
Book lookup when sending a 
message

Yes No

Personal Address Book Yes Yes

Delivery options (importance, 
delivery priority, delivery report)

Yes Yes

Mail iNotes Web Access Outlook Web Access
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Create tasks (with start and end 
dates)

Yes No

Forward message Yes Yes

Save message in the Drafts 
folder

Yes Yes

Create a temp export certificate No No

“Copy Into” - convert item to 
task or calendar entry 

No No

Return receipt Yes Yes

Create/use stationery No No

Choose a letterhead No No

Create a message containing a 
signature file

Yes No

Type-ahead within “Move to 
Folder” dialog

No No

Specify outbound message 
with a “reply by” date

No No

Specify message expiration 
date

No No

Viewing message items

Navigate to next document 
without returning to view

Yes, but not in first release No

Perform mail file delegation Yes No

Upload file attachments Yes Yes

Download attachments Yes Yes

Reply with history Yes Yes 

Reply to memo Yes Yes

Reply to all Yes Yes

Assign tasks to others Yes No

Give a task a priority (high, 
medium, low)

Yes No

Mark task as completed Yes No

Allows the viewing of rich text 
within a message

Yes Yes

Includes support for doc links, 
view links and database links

Yes n/a

Tables within messages are 
viewable

Yes No

Mail iNotes Web Access Outlook Web Access
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Ability to resend documents 
from within a delivery failure

Yes No

Left, right, and center text 
justification

Yes Yes

Bold, italic, underline, and color 
mapping of text

Yes Yes

Support for collapsible sections Yes n/a

Action car Yes Yes

Support for both bullets and 
number lists

Yes Yes

Spell-checking natively 
available 

Yes No

Add Sender of message to 
Personal Address Book

Yes No

Display task in calendar view Yes No

Sort by column by clicking on a 
view column header

Yes Yes

Ability to archive documents Yes, currently on server only. No

Display of importance/type 
icons in views

Yes Yes

Inbound encrypted messages 
can be displayed (requires 
access to Public key on server)

No No

Automatically checks for new 
message

Yes No

User preferences

Define mail file owner Yes No

Default mail save setting Yes No

Lookup across multiple 
Address Books

Yes No

Sign sent mail No No

Encrypt sent mail No No

Encrypt saved mail No No

New mail notification Yes No

Out of office agents can be 
enabled

Yes Yes

Other features

User can change their own 
password

Yes Yes

Mail iNotes Web Access Outlook Web Access
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A.2.4  Calendar and scheduling
Table A-10 compares the calendar and scheduling features between the Lotus iNotes Web 
Access and Microsoft Outlook Web Access clients.

Table A-10   Calendar and scheduling features comparison

Enable/disable scheduled 
agents

Out of office only Out of office only

Mail iNotes Web Access Outlook Web Access

Calendaring and Scheduling iNotes Web Access Outlook Web Access

Views

One day view Yes Yes

Two day view Yes No

Five day view Yes No

Weekly view Yes Yes

Two week view Yes No

Monthly view Yes Yes

Yearly view Yes No

Calendar entries and group scheduling

Double-click within calendar 
view to create entry

Yes No

Create appointment Yes Yes

Create event Yes No

Create reminder Yes No

Create anniversary Yes No

Create meeting invitation Yes No

Create rich text Yes No

Automatic date (calendar 
picture) and time (drag 
indicator) controls

Yes Yes

When opening existing entry, 
put into edit mode automatically

Yes Yes

Invite resources or rooms Yes Yes. No resource lookup list is 
available. Users must know the 
name of resource before 
booking can be made.

Create repeating entries Yes Yes

Add alarms to entries Yes No

Attach files by drag and drop Yes No Individual selection of files 
by time consuming dialog box.
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Pencil in a meeting - tentatively 
schedule

Yes No

Mark an entry “not for public 
viewing”

'Yes No

Delivery options on calendar 
entries

No No

Address lookup for inviting 
people

Yes Yes

Check free time availability for 
invitees

Yes Yes

Free time search within a 
counterproposal

Yes No

Respond with comments within 
a counterproposal

Yes No

Edit calendar entries Yes Yes

Send a reschedule notice Yes Yes

Add additional invitees after 
invitation is sent

Yes Yes

Remove invitee from list Yes Yes

Send “broadcast” invitation (no 
RSVP)

Yes No

Send meeting confirmation Yes Yes

Display invitee responses in 
invitation

Yes No

Accept invitation Yes Yes

Decline invitation Yes Yes

Propose an alternative time Yes No

Accept/decline with comments Yes Yes

Delegate an invitation Yes No

Categorize calendar entries Yes No

Check calendar from invitation 
page

Yes No

Create and maintain group 
calendar

Yes No

Import corporate holidays from 
server

No No

Accept counter proposal RSVP Yes No

Calendaring and Scheduling iNotes Web Access Outlook Web Access
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A.2.5  To Do
Table A-11 compares the To Do features between the Lotus iNotes Web Access and 
Microsoft Outlook Web Access clients.

Table A-11   To Do features comparison

User preferences

Set default appointment 
duration

Yes No

Set default calendar entry type Yes No

Set default calendar grid type 
(two day, weekly, two week, or 
monthly)

No No

Mark default calendar entry as 
“not for public viewing”

Yes No

Option to remove invitations 
from Inbox after processing

Yes No

Option to make free time 
available to only certain users

Yes No

Options to set allowable free 
time

Yes No

Ability to auto process 
invitations

Yes No

Calendaring and Scheduling iNotes Web Access Outlook Web Access

To Dos iNotes Web Access Outlook Web Access

Note: Outlook Web Access 
does not support To Dos

Integrated tasking Yes No

Task chart view Yes No

Delegate a task to yet another 
person

Yes No

Categorize new To Do entries Yes No

Dates and time automatically 
appear in To Do entry form

Yes No

Alarm notification Yes No

Mark To Dos complete or 
uncompleted 

Yes
Time appears if an alarm is set.

No

Owner and participant actions No No
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A.2.6  Address book
Table A-12 compares the address book features between the Lotus iNotes Web Access and 
Microsoft Outlook Web Access clients.

Table A-12   Address book features comparison

A.2.7  Notebook
Table A-13 compares the notebook features between the Lotus iNotes Web Access and 
Microsoft Outlook Web Access clients.

Table A-13   Notebook feature comparison

A.2.8  Printing
Table A-14 compares the printing features between the Lotus iNotes Web Access and 
Microsoft Outlook Web Access clients.

Table A-14   Printing features comparison

Address book iNotes Web Access Outlook Web Access

Can add users from Domino 
Directory to Personal address 
book

No No

Select multiple contacts and 
send message

No No

Select multiple contacts and 
schedule a meeting

No No

Categorization of contacts Yes 
Category field is provided on 
Contact form

No

Name display selection Yes 
Last name, company name, 
e-mail address

Yes

Notebook iNotes Web Access Outlook Web Access

Notebook facility Yes Yes

Printing  iNotes Web Access Outlook Web Access

Print preview Yes, calendar only No

Print multiple calendar 
formats: 
Daily
Weekly
Monthly
Calendar List
Todo List
Trifold

Yes No
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Appendix B. New features, enhancements, 
and fixes

This appendix describes the improvements to iNotes Web Access provided in Domino 
Release 5.0.9. It discusses problems that were fixed from the previous release, functionality 
that was added, and existing features that were enhanced in the product.

This appendix covers:

� iNotes Web Access new features and enhancements
� Domino Off-Line Services new features and enhancements
� iNotes Web Access fix list
� Domino Off-Line Services fix list

B
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B.1  iNotes Web Access new features and enhancements
This section covers the enhancements and new features specific to iNotes Web Access in 
Domino R5.0.9.

B.1.1  Full alternative name support
iNotes Web Access has been enhanced to fully support alternative names, just as 
Notes/Domino provides ability to set an alternate name for Notes users in Notes/Domino R5. 
This ability enables users to use alternate representation as their user names in their native 
language other than the ordinary Domino primary user name to display user names. 
Notes/Domino R5 provides the ability to turn on or turn off the alternate name display and 
also provides capability to display the alternate name in many places.

B.1.2  Name resolution when sending mail
This allows an iNotes Web Access user to check the names of recipients of an e-mail for 
accuracy before sending, with the click of a button. It prevents mail from being misdirected or 
not received because the recipient’s name was misspelled. This provides a similar type of 
functionality that Notes users have with the type-ahead feature in memo addressing. Lotus 
has opted not to enable type-ahead addressing in iNotes Web Access because of 
performance considerations. However, users can now, with a single click of button, resolve 
incorrectly spelled names in an address field from a pop-up list of alternatives when no match 
is found.

B.1.3  Rollback to HTML file control if ActiveX controls are not permitted
Some companies restrict the use of ActiveX controls by users for security purposes. iNotes 
Web Access leverages an ActiveX control for the file upload/download control. This new 
feature allows for the “rollback” to a non-ActiveX control that still provides users the ability to 
upload or download file attachments. Although it does not provide some of the drag-and-drop 
capabilities that the ActiveX control does, the basic feature is now available to users who 
can’t use ActiveX controls.

B.1.4  Support for personal group names 
iNotes Web Access has added the ability for users to create and manage personal groups, 
similar to the personal groups in the Notes client Personal address book. These personal 
groups are stored in the user's mail file and can be used for all mail and calendar and 
features.

B.2  Domino Off-Line Services new features and enhancements
This section covers the enhancements and new features specific to Domino Off-Line Services 
(DOLS) in Domino R5.0.9.

B.2.1  DOLS compact and full text search configuration settings
DOLS compact and full-text search configuration setting allows administrators to turn on and 
turn off the database compaction and full-text search indexing process of their users from 
within the DOLS configuration form. The default setting remains “On” since this was the past 
behavior. These processes currently occur during the DOLS synchronization process.
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B.2.2  DOLS local encryption support
Local encryption of databases within downloaded subscriptions to a DOLS client is now 
supported through new settings within the DOLS configuration document.

B.2.3  Offline Directory Catalog support
Offline Directory Catalogs can be used for DOLS-enabled applications for directory lookups, 
addressing, etc. The feature is available through a new settings within the DOLS configuration 
document.

B.2.4  Overriding the TCP/IP address in notes.ini
You can add a notes.ini setting called $DOLS_TCPIPAddress=<hostnames> or <ip 
address>:<port>. This overrides the TCPIPAddress setting. This value populates the 
Optional Network Address field in the Connection document in the Dolnames.nsf database. If 
the $DOLS_TCPIPAddress is not present, TCPIPAddress will be used.

B.3  iNotes Web Access fix list
Table B-1 shows the list of fixes in Domino R5.0.9 specific to iNotes Web Access.

Table B-1   iNotes Web Access fix list in Domino R5.0.9

SPR number Fix description

FZHG4TG5YM When forwarding a document in which an image is inserted, if the image is 
deleted from the body field, but it is still stored in the document as an 
attachment.

JCIK4YCGAG Preferences Save & Close fails if port number in TCPIP_TCPIPAddress is 
anything other than 1352.

MWHN4XCW4P Removed the option to add or remove a checkmark once a To Do is saved, 
from within the Set Repeat box.

JLJE4TSKRZ A To Do entry with a Completed status is displayed as Uncompleted in the All 
Documents view. 

KZHG4WMBZP Fixed a problem where an invalid script in the body of a mail message causes 
page content confusion and iNotes warning messages

MEZO4X8HAA Fixed a problem where extra “\n”s were intermittently visible from within the 
view source of a mail message

CDUT4XPRRR Fixed a problem causing response data to be sent with a 304 (not modified) 
response.

BDAS4Y2SCB Provided a fix for PDF generation for international locales that use a comma 
as a decimal point.

TIWI4X3KYU Prevent corruption of repeating appointments that contain rich text fields, 
attachments, or doc links when they are edited by an iNotes client.

CFAR4WKRX4 Fixed a problem with meeting cancellation working incorrectly for users added 
to a repeating meeting invitation after the original invitation was sent. The 
meeting was not removed from the user's calendar even if they accepted.
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ASUH4ZVTF4 Fixed the incorrect layout of all-day events and anniversaries occurring on the 
same day when printing the daily calendar when Print first line only is 
selected.

TIWI4YQ4KL System administrators are allowed to prevent the end user from modifying the 
Welcome page.

BZHO4VTJ8L Fixed a problem where a Web page is not printed, when the page is included 
in the body section of a mail message

VSEN4V8MK7 Improved the performance of both the HTTP server and iNotes Web Access 
by changing the method Domino uses to handle certain types of data.

AHOD52VR23 Fixed a problem that caused the server to crash when rescheduling a 
calendar entry. This problem happened when the user clicked 
Action->Reschedule->Client reschedule.

JLJE4TGL28 Fixed repeating calendar entries that span Daylight Savings Time in different 
time zones. Repeating calendar entries may be off by one hour in an 
environment where servers and clients follow different DST rules. Please note 
that you must also have the R5.0.9 version of forms5.nsf for this change to 
work properly.

JLJE52KQSB Fixed the lines of text in messages from Outlook or GroupWise that is plain 
text and MIME encapsulated so that they now wrap properly.

WBLD4ZPEPS Temporary directories and files that are created when a user opens an 
attachment are now deleted when the user clicks Logout.

CLYH52BJDC Fixed the iNotes Web Access documentation to state explicitly that Sametime 
installed on the same server as Domino with iNotes Web Access does not 
work. For Sametime to work with iNotes Web Access, Sametime must be 
installed on a dedicated server. Please see the iNotes Web Access 
Deployment Guide available on notes.net.

ASUH4ZTP6B PDF printing is disabled for DBCS.

PZHN4Z7AEV The Preference field, Check for time conflicts, on calendar entries works. 
Users now receive an warning when two meetings are scheduled for the 
same time.

DLIU4YW69U The problem of receiving a failure when removing an invitee and adding or 
removing a room/resource at the same time has been fixed.

FZHG4ZE3LK The problem that caused the server to crash when a delegate sent a meeting 
invitation using Calendar Author or Editor access is now fixed.

YXUE4YWBJ4 An iNotes Web Access invitee can now counterpropose one instance of a 
repeating meeting, and the chair using WebMail can now accept that meeting 
counter.

YSUU4YS4RW Help now includes information on how to change your access control level in 
order to use the Out of Office feature.

TIWI4ZFETC A potential problem of Sametime not working properly even when configured 
properly has been fixed.

DLIU4XFDA5 Fixed a problem with resetting alarms. Prior to this fix, the alarm was still on 
after turning it off.

SPR number Fix description
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FAR4ZALGK The problem of creating an appointment and not setting an alarm, and then 
editing the appointment and setting the alarm, is now fixed. Previously, the 
alarm did not signal.

SBAM524NN3 The wording in the fields in the server configuration document related to 
encryption of offline mail files has been changed to allow encryption to be 
configurable by users.

SLIN4XE8LJ Creating a meeting invitation from a Notes client, and then adding a resource 
using the iNotes Web Access client to the same meeting, no longer produces 
a warning message.

DLIU4YG5RV A decline notice is now sent to the chair if an invitee declines an invitation right 
after they propose a counter invitation.

SLIN4ZZ8Z6 Previously, when a delegate wrote a message and sent it, the receiver of the 
message knew that it was from the original author, not the delegate. But when 
that message was forwarded, it appeared as though the delegate was the 
author of the message. This problem has been fixed to include the correct 
author of the message.

JCIK52CGGS The problem of opening some mail documents that generated needless 
iNotes warnings has been fixed. Another similar fix will be done for some 
DBCS languages in a future Maintenance release.

MOSI4ZSRRL ACLs are now working properly when looking up users with the search user 
interface in the address dialog box.

SBED4ZDR99 Saving preferences on a Solaris server now works correctly.

DDAS4XXTTD The full-text search that worked only on subject lines in messages has been 
fixed so that all fields of a message are now full-text indexed.

ELED4ZFPLZ Fixed context-sensitive help link for Preferences so that the same topic 
appears when a user clicks Preferences (and clicks help) or comes to the Mail 
tab in Preferences from another tab (and clicks help).

DLIU4X36MZ Prevent workflow from stopping when an invitee accepts an invitation, 
proposes a counter-invitation, and then accepts the decline of the 
counter-invitation. This problem did not exist if the original invitation was for a 
repeating meeting.

SBAM4ZTN2T iNotes Web Access now presents the correct user interface to an Internet 
Explorer user when using an IBM WebSphere portal server after using 
Netscape which presents a WebMail user interface.

EMYS4XHKWU Fixed a potential security issue.

DGUY4X3JMA iNotes folders and nested folders now mimic the look and feel of Notes 
folders.

SPR number Fix description
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B.4  Domino Off-Line Services fix list
Table B-2 shows the list of fixes in Domino R5.0.9 specific to Domino Off-Line Services.

Table B-2   Domino Off-Line Services fix list in Domino R5.0.9

SPR Number Fix description

JIMN4YYJ5M When the Service Manager's Master Password is set, the new password is 
not being used in the Extension Manager. This password is needed to open 
a configuration database and was failing because the Extension Manager did 
not have the new password. 

CLYH4YGM8Y Fixed a problem introduced in R5.0.8 that prevented the iNotes Sync 
Manager from loading on Win95B.

GGEB4ZGU48 Fixed Notes authentication for DOLS so that the client's ID file can be 
upgraded with re-issued certificates.

LSHR4WJMQ3 Offline subscription now accepts the user’s correct Internet password when 
launched offline in a browser. Previously, sometimes the offline browser 
would accept the user's Notes password instead of the Internet Password, if 
those Passwords were different online.
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Related publications

The publications listed in this section are considered particularly suitable for a more detailed 
discussion of the topics covered in this redbook.

IBM Redbooks
For information on ordering these publications, see “How to get IBM Redbooks” on page 190.

� iNotes Web Access Deployment and Administration, SG24-6518

� Exchange Migration and iNotes Implementation on the IBM ~ iSeries Server, 
SG24-6230

� Lotus Domino for AS/400 R5: Implementation, SG24-5592

� Lotus Domino for AS/400: Problem Determination Guide, SG24-6051

� Lotus Domino for iSeries: Sizing and Performance Tuning, SG24-5162

� IBM ~ iSeries Wired Network Security: OS/400 V5R1 DCM and Cryptographic 
Enhancements, SG24-6168

� Lotus Sametime 2.0 Deployment Guide, SG24-6206

Other resources
These publications are also relevant as further information sources:

� Domino R5 Administration Help database (help5_admin.nsf

� iNotes Web Access Deployment Guide for Domino 5.0.9

This is a Lotus Whitepaper containing deployment planning, administration, security, and 
performance considerations about iNotes Web Access based on the R5.0.9 version. The 
white paper can be downloaded from Notes.net on the Web at: http://notes.net

Search under the Doc Library link, or you can download the paper directly from: 
http://doc.notes.net/uafiles.nsf/docs/iNotes509/$File/
IWA_Deployment_Guide_509.pdf

Referenced Web sites
These Web sites are also relevant as further information sources:

� You can access fixes, Notes-related documentation and example code downloads, known 
problems, questions and answers, as well as submit questions about Domino products to: 
http://www.notes.net

� This redbook lists the fixes relevant to iNotes Web Access in release 5.0.9. But, you can 
find the complete fix list for all versions at: 
http://www.notes.net/r5fixlist.nsf/SPRViewTemplate?OpenForm

� This redbook lists the enhancements and new features found in R5.0.9 of Domino, relative 
to iNotes Web Access. You can find the complete list in the Release notes, available in the 
original CD-ROM product or online in the Notes.net Web site at: 
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http://www.notes.net/notesua.nsf/ddaf2e7f76d2cfbf8525674b00508d2b/
d8d55710a35e83f785256b10005eec59?OpenDocument

� IBM/Lotus Software Support site, previously known as Knowledge Base, is now an 
integrated site at: http://www-3.ibm.com/software/lotus/support/

� For system sizing and capacity planning, there is an online iSeries sizing tool called the 
IBM iSeries Workload Estimator. This tool keeps the most recent update of software and 
system models, not only for iNotes Web Access but other software solutions running on 
the iSeries server such as WebSphere, Domino mail and applications, Java, WebSphere 
Commerce Suite, traditional 5250 workloads, OS/400 HTTP server, and batch and client 
server workloads. You can find this Web site at: 
http://www.ibm.com/eserver/iseries/support/estimator

� iNotes Web Access Performance Analysis white paper at: 
http://www.notes.net/today.nsf/lookup/iNotes_performance

� Domino for iSeries updated news, related products, case studies, and online education is 
provided at: http://www.ibm.com/servers/eserver/iseries/domino/

� You can access OS/400 and Domino PTF requirements for each OS/400 version and 
Domino release, online PTFs, MRs, and MUs from: 
http://www.ibm.com/servers/eserver/iseries/domino/support

How to get IBM Redbooks
You can order hardcopy Redbooks, as well as view, download, or search for Redbooks at the 
following Web site:

ibm.com/redbooks

You can also download additional materials (code samples or diskette/CD-ROM images) 
from that site.

IBM Redbooks collections
Redbooks are also available on CD-ROMs. Click the CD-ROMs button on the Redbooks Web 
site for information about all the CD-ROMs offered, as well as updates and formats.
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